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Preface

TIBCO ActiveMatrix Adapter for PeopleSoft is a bi-directional gateway between the 

PeopleSoft application and applications configured for the TIBCO environment. It is 

assumed that you are familiar with the basic concepts of the TIBCO environment and 

PeopleSoft technology.

Topics

• Changes from the Previous Release of This Guide, page xvi

• Related Documentation, page xviii

• Typographical Conventions, page xx

• Terminology and Acronyms, page xxiii

• Connecting with TIBCO Resources, page xxv
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Changes from the Previous Release of This Guide

This section itemizes the major changes from the previous release of this guide. 

Support for Compiling PeopleSoft Component Interface Java APIs by Using TIBCO 

Configuration Tool

You can run TIBCO Configuration Tool to compile the APIs. This tool replaces the 

BuildCI.bat installed on Microsoft Windows platforms and BuildCI.sh on UNIX platforms 

during the adapter installation. See Preparing PeopleSoft Component Interfaces on 

page 18.

Support for the SSL Protocol

This release supports the use of SSL when using PeopleSoft Application Message as the 

integration approach. Enabling SSL on the PeopleSoft Server on page 57 introduces the 

specific configurations when using SSL.

Support for Customizing Runtime Input

This release supports customizing runtime input as a service-level option. The feature is 

available for all the services using Component Interface. See the Schema Tab section of CI 

Publication Service on page 96, CI Subscription Service on page 108, and 

Request-Response Service on page 117.

Support for Number of Threads as Global Variable

This release supports thread number as a global variable in adapter instance configuration. 

This document introduces this variable as well as the other pre-defined global variables 

that are specific to the adapter. See Using Global Variables on page 144

Support for JMS Message Compression

JMS message compression is a service-level option that ensures messages will occupy less 

memory in storage and be handled faster by the TIBCO Enterprise Message Service 

server. See Compressing JMS Messages on page 161 for more information.

Dynamic Thread Configuration

This release supports dynamically updating the number of connetions to the PeopleSoft 

application server by using Hawk. See setThreadNumber() on page 196.
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Preparing PeopleSoft

Chapter 1, Preparing PeopleSoft, on page 1 is updated as follows:

• "Loading the Adapter PeopleSoft Project" was a chapter in the Installation guide of 

previous releases. The chapter describes how to load a pre-built PeopleSoft project 

into PeopleTools 8.4x before using TIBCO ActiveMatrix Adapter for PeopleSoft. In 

this release, this chapter is merged with Chapter 1, Preparing PeopleSoft. See Loading 

the Adapter PeopleSoft Project on page 4.

• Loading TIBCO Libraries on page 16 is a new section that explains the libraries you 

need to load to the PeopleSoft application server.

• The whole chapter is updated to include more detailed information about the 

configuration procedures. The screenshots are all up-to-date and taken with 

PeopleTools 8.51.
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Related Documentation

This section lists documentation resources you may find useful. 

TIBCO ActiveMatrix Adapter for PeopleSoft Documentation

The following documents form the TIBCO ActiveMatrix Adapter for PeopleSoft 

documentation set:

• TIBCO ActiveMatrix Adapter for PeopleSoft Concepts Read this manual to gain an 

understanding of the product that you can apply to the various tasks you may 

undertake.

• TIBCO ActiveMatrix Adapter for PeopleSoft Installation Read this manual for 

instructions on site preparation and installation.

• TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment Read 

this manual for instructions on how to create, configure, and deploy adapter projects. 

• TIBCO ActiveMatrix Adapter for PeopleSoft Examples Read this manual to work 

through the examples provided with the adapter. 

• TIBCO ActiveMatrix Adapter for PeopleSoft Release Notes Read the release notes for 

a list of new and changed features. This document also contains lists of known issues 

and closed issues for this release.

Other TIBCO Product Documentation

You may find it useful to read the documentation for the following TIBCO products:

• TIBCO ActiveMatrix BusinessWorks™

• TIBCO ActiveMatrix BusinessWorks™ Service Engine

• TIBCO ActiveMatrix® Service Bus

• TIBCO ActiveMatrix® Service Grid

• TIBCO Adapter® SDK

• TIBCO Administrator™ 

• TIBCO Business Studio™

• TIBCO Designer™ 

• TIBCO Enterprise Message Service™ 

• TIBCO Hawk® 
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• TIBCO Rendezvous® 

• TIBCO Runtime Agent™ 

Third-Party Documentation

You may also find it useful to read the following documentation:

• "Integration Tools: PeopleSoft Component Interfaces" in PeopleTools PeopleBook. 

Topics include an explanation of Component Interfaces, how to create them, how to 

test them using PeopleTools, and how to validate that a Component Interface is 

compatible with the underlying component.

• "PeopleSoft Integration Broker" in PeopleTools PeopleBook. Topics include an 

explanation of Integration Broker, the components involved, and how to use the 

components in Application Messaging.

• "PeopleSoft Platforms", a link from the PeopleSoft Customer Connection web site 

(see http://www.peoplesoft.com), for the versions of the databases supported by 

PeopleSoft.

• "PeopleSoft Internet Architecture Administrating", a link from the Peoplebook- 

PeopleTools-Administration Tools web site (see http://www.peoplesoft.com), for 

information on configuring a JOLT Listener port.

http://www.peoplesoft.com
http://www.peoplesoft.com
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Typographical Conventions

The following typographical conventions are used in this manual.

Table 1   General Typographical Conventions

Convention Use

ENV_NAME

TIBCO_HOME

TIBCO products are installed into an installation environment. A product installed into 

an installation environment does not access components in other installation 

environments. Incompatible products and multiple instances of the same product must be 

installed into different installation environments.

An installation environment consists of the following properties:

• Name Identifies the installation environment. This name is referenced in 

documentation as ENV_NAME. On Microsoft Windows, the name is appended to the 

name of Windows services created by the installer and is a component of the path to 

the product shortcut in the Windows Start > All Programs menu. 

• Path The folder into which the product is installed. This folder is referenced in 

documentation as TIBCO_HOME. 

TIB_ADPSFT8_H

OME

TIBCO ActiveMatrix Adapter for PeopleSoft installs into a directory within a 

TIBCO_HOME. This directory is referenced in documentation as TIB_ADPSFT8_HOME. 

The default value of TIB_ADPSFT8_HOME depends on the operating system. For example 

on Windows systems, the default value is C:\tibco\adapter\adpsft8\6.1.

TIB_EMS_HOME TIBCO Enterprise Message Service installs into a directory within TIBCO_HOME. This 

directory is referenced in documentation as TIB_EMS_HOME. The value of 

TIB_EMS_HOME depends on the operating system. For example on Windows systems, 

the default value is C:\tibco\ems\6.3.

PS_HOME PS_HOME is the directory where the PeopleSoft Application server is installed. For 

example, if the PeopleSoft Application server is installed at C:\PT8.49 on a Windows 

system, the value of PS_HOME is C:\PT8.49.

code font Code font identifies commands, code examples, filenames, pathnames, and output 

displayed in a command window. For example:

Use MyCommand to start the foo process.
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bold code font Bold code font is used in the following ways:

• In procedures, to indicate what a user types. For example: Type admin. 

• In large code samples, to indicate the parts of the sample that are of particular 

interest.

• In command syntax, to indicate the default parameter for a command. For example, 

if no parameter is specified, MyCommand is enabled: 

MyCommand [enable | disable]

italic font Italic font is used in the following ways: 

• To indicate a document title. For example: See TIBCO ActiveMatrix BusinessWorks 

Concepts.

• To introduce new terms For example: A portal page may contain several portlets. 

Portlets are mini-applications that run in a portal.

• To indicate a variable in a command or code syntax that you must replace. For 

example: MyCommand PathName

Key 

combinations

Key name separated by a plus sign indicate keys pressed simultaneously. For example: 

Ctrl+C.

Key names separated by a comma and space indicate keys pressed one after the other. 

For example: Esc, Ctrl+Q.

The note icon indicates information that is of special interest or importance, for example, 

an additional action required only in certain circumstances.

The tip icon indicates an idea that could be useful, for example, a way to apply the 

information provided in the current section to achieve a specific result.

The warning icon indicates the potential for a damaging situation, for example, data loss 

or corruption if certain steps are taken or not taken.

Table 1   General Typographical Conventions (Cont’d)

Convention Use
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Table 2   Syntax Typographical Conventions

Convention Use

[ ] An optional item in a command or code syntax.

For example: 

MyCommand [optional_parameter] required_parameter

| A logical OR that separates multiple items of which only one may be chosen.

For example, you can select only one of the following parameters: 

MyCommand param1 | param2 | param3

{ } A logical group of items in a command. Other syntax notations may appear within each 

logical group.

For example, the following command requires two parameters, which can be either the 

pair param1 and param2, or the pair param3 and param4.

MyCommand {param1 param2} | {param3 param4}

In the next example, the command requires two parameters. The first parameter can be 

either param1 or param2 and the second can be either param3 or param4:

MyCommand {param1 | param2} {param3 | param4}

In the next example, the command can accept either two or three parameters. The first 

parameter must be param1. You can optionally include param2 as the second parameter. And 

the last parameter is either param3 or param4.

MyCommand param1 [param2] {param3 | param4}
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Terminology and Acronyms

The following acronyms are used in this manual:

Table 3    Terminology and Acronyms

Acronym Meaning

API Application Programming Interface

QOS TIBCO Rendezvous quality of service

GUI Graphical User Interface

RV Refers to TIBCO Rendezvous reliable message quality of service, as opposed to 

certified message.

RVCM Refers to TIBCO Rendezvous certified message quality of service.

RVDQ Refers to TIBCO Rendezvous distributed queue.

RPC Remote Procedural Call

TRA TIBCO Runtime Agent

JMS Java Message Service

Component Interface (CI) A Component Interface is a PeopleTools object that you create in PeopleSoft 

Application Designer. It exposes a PeopleSoft component for synchronous access from 

another application. External applications need not be concerned with the details of page 

structures and component definitions in order to access the underlying data and business 

logic through Component Interfaces.

TIB Work Page This page is bundled with the TIB_PS8_ADAPTER project. It implements the logic for 

capturing desired fields for publication at runtime. The page must be attached to the 

component from which data is captured.

Inbound Events coming into the adapter. It refers to the inflow of data into the PeopleSoft 

application. It is applicable to Subscription and Request-Response services.

Outbound Events going out from the adapter. It refers to data being captured from the PeopleSoft 

application and being sent out. It is applicable to the Publication Service.

PIA PeopleSoft Pure Internet Architecture
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Integration Broker (IB) An Integration Broker facilitates exposing PeopleSoft business logic as services and 

consuming external web services for PeopleSoft applications to invoke. PeopleSoft 

Integration Broker also supports synchronous and asynchronous messaging and uses a 

variety of communication protocols, while managing message structure, message 

content, and transport disparities.

VPD Vital Product Database

Table 3    Terminology and Acronyms (Cont’d)

Acronym Meaning
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Connecting with TIBCO Resources

How to Join TIBCOmmunity

TIBCOmmunity is an online destination for TIBCO customers, partners, and resident 

experts. It is a place to share and access the collective experience of the TIBCO 

community. TIBCOmmunity offers forums, blogs, and access to a variety of resources. To 

register, go to http://www.tibcommunity.com.

How to Access TIBCO Documentation

You can access TIBCO documentation here: 

http://docs.tibco.com

How to Contact TIBCO Support

For comments or problems with this manual or the software it addresses, contact TIBCO 

Support as follows:

• For an overview of TIBCO Support, and information about getting started with 

TIBCO Support, visit this site:

http://www.tibco.com/services/support

• If you already have a valid maintenance or support contract, visit this site:

https://support.tibco.com

Entry to this site requires a user name and password. If you do not have a user name, 

you can request one.

http://www.tibco.com/services/support
https://support.tibco.com
http://docs.tibco.com
http://www.tibcommunity.com
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Chapter 1 Preparing PeopleSoft

This chapter explains how to prepare PeopleSoft Component Interfaces and messages in 

your PeopleSoft system, and also how to prepare PeopleSoft components for publishing 

through the adapter. Information is also provided that you should have ready before 

starting adapter configuration.

Topics

• PeopleSoft Integration Technology Overview, page 2

• Loading the Adapter PeopleSoft Project, page 4

• Loading TIBCO Libraries, page 16

• Preparing PeopleSoft Component Interfaces, page 18

• Preparing PeopleSoft Application Messages, page 27

The explanations in this manual are based on PeopleTools 8.51. If you use a PeopleTools 

product other than PeopleTools 8.51 in a project, some of the explanations provided in this 

documentation may not work. 
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PeopleSoft Integration Technology Overview

PeopleSoft is a leading provider of ERP software solutions that meet the changing 

business needs of enterprises worldwide. It offers a complete suite of enterprise solutions 

for accounting, material management, distribution, manufacturing, and human resources.

PeopleSoft Integration Technologies

The internet architecture introduced with PeopleSoft supports powerful functionality for 

internet access, integration of external applications with PeopleSoft applications, and the 

integration of both into the enterprise.

Component Interface

One aspect of PeopleSoft integration technology, which PeopleSoft internet architecture 

makes use of, is Component Interfaces. These are object-oriented software devices that 

allow external applications to invoke PeopleSoft business logic. Component Interfaces are 

ideal for use in PeopleSoft environments that require tightly coupled integration, where 

data must be transmitted in real time. 

See also: 

• "PeopleSoft Component Interfaces" in TIBCO ActiveMatrix Adapter for PeopleSoft 

Concepts.

• Integration Tools: PeopleSoft Component Interface in PeopleSoft (Enterprise 

PeopleTools) Documentation Library

Integration Broker

Another robust part of the PeopleSoft internet architecture is the Integration Broker that 

uses the Application Messaging technology to integrate with third-party applications. 

See also: 

• "PeopleSoft Integration Broker" in TIBCO ActiveMatrix Adapter for PeopleSoft 

Concepts.

• Integration Tools: PeopleSoft Integration Broker in PeopleSoft (Enterprise 

PeopleTools) Documentation Library

Configuring PeopleSoft

Before you use TIBCO ActiveMatrix Adapter for PeopleSoft, do the following 

preparation with PeopleSoft:
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1. Load the TIBCO resources:

— Loading the Adapter PeopleSoft Project, page 4

Finish this step to load a pre-built PeopleSoft project into PeopleTools.

— Loading TIBCO Libraries, page 16

2. Prepare the PeopleSoft integration technology you use:

— Preparing PeopleSoft Component Interfaces, page 18

— Preparing PeopleSoft Application Messages, page 27
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Loading the Adapter PeopleSoft Project

The adapter software includes a pre-built PeopleSoft project (TIB_PS8_ADAPTER) that 

contains the server side adapter code, to be used in PeopleTools 8.4x and above. The 

project also contains Component Interfaces, components, fields, menus, pages, and 

records. For detailed project information, see Adapter PeopleSoft Project on page 4

You must set up the project in your PeopleSoft database before using the adapter. The 

TIB_PS8_ADAPTER project to be imported into PeopleTools is located in the 

TIB_ADPSFT8_HOME\data\TIB_PS8_ADAPTER_PT84x folder. Follow Loading the 

TIB_PS8_ADAPTER Project on page 9 to load the project.

Adapter PeopleSoft Project

The following table describes all the items in the TIB_PS8_ADAPTER project.

Table 4   Description of the Adapter’s PeopleSoft Project (Sheet 1 of 6)

Type of Item Name Description

Component Interface TIB_CI_COMPINTFC Used by the design-time adapter to retrieve 

the list of Component Interfaces in the 

database.

TIB_MQUEUE_DATA_CI Used by the Publication Service to retrieve 

queue records.

TIB_MQUEUE_SRCH_CI Used by the Publication Service to retrieve 

queue records.

TIB_PUB_COMPINTFC Used by the design-time adapter to store 

data back into PeopleSoft. Applicable only 

to integration scenarios using the 

Publication Service.

TIB_MSGVER_CI Used by the design-time adapter to retrieve 

names and versions of messages.

TIB_MSGREC_CI Used by the design-time adapter to retrieve 

the details of a particular message.

TIB_MSGDET_CI Used by the design-time adapter to retrieve 

the details of a particular message.

Component TIB_CI_GROUP Used by TIB_CI_COMPINTFC.

TIB_MQUEUE_DATA_COMP Used by TIB_MQUEUE_DATA_CI.
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TIB_MQUEUE_SRCH_COMP Used by TIB_MQUEUE_SRCH_CI.

TIB_PUB_COMP Used by TIB_PUB_COMPINTFC.

TIB_MSGVER_COMP Used by TIB_MSGVER_CI.

TIB_MSGREC_COMP Used by TIB_MSGREC_CI.

TIB_MSGDET_COMP Used by TIB_MSGDET_CI.

Field TIB_ATTRIBUTE_NAME Name of the field.

TIB_BCITEMPARENT Name of the parent field.

TIB_BCNAME Name of the Business Event.

TIB_DESCRIPTION Description of the field.

TIB_EVENT_NAME Stores name of the event.

TIB_FIELDNAME Name of the field.

TIB_FIELDTYPE Type of the field.

TIB_GUID Stores GUID - Unique identifier for the 

message.

TIB_IS_MSG_TRIGGER Stores TRUE or FALSE. Purpose is to 

determine whether to trigger the publisher 

if this field changes.

TIB_ISKEY Key field.

TIB_ISKEY_FLAG Stores TRUE or FALSE. Key field.

TIB_LENGTH Length of the field.

TIB_LEVELNUM

TIB_MENUACTION

Table 4   Description of the Adapter’s PeopleSoft Project (Sheet 2 of 6)

Type of Item Name Description
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TIB_MODE TIB_MODE has the following values:

A - Add.

U - Update.

L - Update All.

C - Correction.

TIB_MSG_DATA Content of this field.

TIB_MSG_FIELDID

TIB_MSG_ORIGIN

TIB_MSG_TIMESTAMP Stores Timestamp corresponding to the 

message.

TIB_MSG_TYPE

TIB_OBJECT_NAME

TIB_OPERATION

TIB_PARENT_RECNAME Field Parent Record Name.

TIB_PARENTRECNAME Field Parent Record Name.

TIB_PNLGRPNAME

TIB_RECNAME

TIB_SEQUENCE_NO Stores Sequence number of message.

TIB_SERIALIZEDATA

TIB_STATUS TIB_STATUS can have any of the 

following values:

N - Not processed.

I - Intermediate stage.

P - Processed successfully.

E-Error.

TIB_MSGNAME Name of the Application Messaging 

component.

TIB_APMSGVER Version of Application Messaging.

Table 4   Description of the Adapter’s PeopleSoft Project (Sheet 3 of 6)

Type of Item Name Description
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TIB_RECDNAME Name of the Record.

TIB_FLDNAME Name of the Field.

TIB_FLDTYPE Type of the Field.

TIB_PRNTRECNAME Name of the parent record name.

TIB_RECALIAS Name of the record alias name.

TIB_FLDALIAS Name of the field alias.

Menu TIBCO_MAINT_MENU

Page TIB_CI_ADAPTER_WRK Page that has all the PeopleCode used to 

capture data from PeopleSoft and store it in 

the MQUEUE table.

TIB_CI_MQUEUE_PGE

TIB_CI_PUBLISHER

TIB_COMP_INTERFACE

TIB_MQUE_DATA_PGE

TIB_MQUE_SRCH_PGE

TIB_MSGVER_PG 

TIB_MSGREC_PG

TIB_MSGDET_PG

Record TIB_BCITEM_VW

TIB_CI_BUS_DTL Stores the details of the component to be 

captured.

TIB_CI_BUS_HDR Stores the events to be published and in 

what mode.

TIB_CI_DTLWRK

TIB_CI_GET_VW

TIB_CI_MQUEUE Stores the data to be published.

Table 4   Description of the Adapter’s PeopleSoft Project (Sheet 4 of 6)

Type of Item Name Description
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TIB_CI_MSG_VW

TIB_CI_PARNT_VW

TIB_CI_SEQUENCE Stores the sequence number of the 

published event.

TIB_CI_TIDLOG Has the PeopleCode required for capturing 

data to be published.

TIB_MQUEUE_SRCH

TIB_PUB_WRK

TIB_MSGVER_VW

TIB_MSGREC_VW

TIB_MSG_VW_TBL

SQL TIB_BCITEM_VW

TIB_CI_GET_VW Captures the GETKEYS for a particular 

Component Interface.

TIB_CI_MSG_VW Captures the details of the fields and 

records to be published.

TIB_CI_PARNT_VW Captures the parent-child relationship for 

Component Interfaces.

TIB_MQUEUE_SRCH Captures the range of sequence numbers 

for TIB Events and groups them by the 

status (processed/ unprocessed).

TIB_MSGVER_VW

TIB_MSGREC_VW

Table 4   Description of the Adapter’s PeopleSoft Project (Sheet 5 of 6)

Type of Item Name Description
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Loading the TIB_PS8_ADAPTER Project

To load the project to the PeopleSoft server, you need to finish these tasks in sequence:

TIB_MSG_VW_TBL

PeopleCode TIB_CI_TIDLOG.RowInit This event is fired for all the records the 

first time a row of data is encountered. 

This is usually used to set the initial state 

of a component or a page. The adapter uses 

this particular record's RowInit event to host 

the PeopleCode to perform the following:

Check if the panel is invoked online.

Call a function to get the data to be 

captured from the TIB tables, only if the 

panel is invoked online and not via the 

Component Interface.

TIB_CI_TIDLOG.SavePreChange This event is fired just before the data is 

updated in the database by the PeopleSoft 

component processor. It gives you one last 

chance to manipulate the data before it is 

saved to the database. The adapter uses this 

particular record's SavePreChange event to 

host the PeopleCode to perform the 

following:

Set the various global variables.

Calls a function to start the processing of 

an event.

Calls a function to write the message to the 

MQUEUE table after an event has been 

processed.

TIB_CI_TIDLOG.FieldFormula This event is fired in more than one context 

but primarily it is used to declare and store 

functions to be used to by PeopleCode of 

other events. Hence the adapter uses this 

particular record's FieldFormula event to host 

the PeopleCode defining various functions, 

which do the processing required to 

capture and write the data to the MQUEUE 

table.

Table 4   Description of the Adapter’s PeopleSoft Project (Sheet 6 of 6)

Type of Item Name Description
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• Task A, Back Up and Delete the Existing TIB_PS8_ADAPTER Project in the 

PeopleSoft Database, page 10

• Task B, Copy the TIB_PS8_ADAPTER Project, page 12

• Task C, Oracle Only: Create a Tablespace for Adapter Records, page 13

• Task D, Build the TIB_PS8_ADAPTER Project, page 13

• Task E, Grant Permissions for Working with CI and IB, page 14

For more information on PeopleSoft configuration, see PeopleSoft (Enterprise 

PeopleTools) Documentation Library.

Task A Back Up and Delete the Existing TIB_PS8_ADAPTER Project in the 

PeopleSoft Database

Before loading the TIB_PS8_ADAPTER project, you need to check whether the project is 

already in the PeopleSoft database. If there is an existing TIB_PS8_ADAPTER project in the 

database, you must delete it and load the project from the adapter with the version you 

want to use.

To check whether the TIB_PS8_ADAPTER project is already in PeopleSoft Database:

1. Open PeopleTools Application Designer and log in to the server where you want to 

add the project.

2. Verify that there is no existing TIB_PS8_ADAPTER project already in the database:

a. From the menu, select File > Open.

b. In the Open Definition dialog, open the TIB_PS8_ADAPTER project.

3. Check the listed projects:

— If there is no existing TIB_PS8_ADAPTER project, skip to Task B, Copy the 

TIB_PS8_ADAPTER Project, on page 12.

— If there is an existing TIB_PS8_ADAPTER project, continue to step 4.

4. Back up any contents of the TIB_CI_MQUEUE table associated with the project.
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5. Delete the existing TIB_PS8_ADAPTER project:

From the menu, select File > Delete. In the Delete Definition dialog, delete all of the 

items in the TIB_PS8_ADAPTER project in the following order:

a. Menus

b. Component Interfaces

c. Components

d. Pages

e. Records

f. Fields

6. Delete the TIB_PS8_ADAPTER project itself and close the Delete Definition dialog.

7. If necessary, also delete the cache.

8. Exit PeopleTools Application Designer.
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Task B Copy the TIB_PS8_ADAPTER Project

To load the project:

1. Open PeopleTools Application Designer and log in to the server where you want to 

add the project.

2. From the menu, select Tools > Copy Project > From File.

3. In the displayed dialog, browse to the following directory: 

TIB_ADPSFT8_HOME\data\TIB_PS8_ADAPTER_PT84x. 

4. Select the TIB_PS8_ADAPTER project from the displayed list and click Select.

5. In the Copy From File dialog, select all the Definition Types, then click Copy.

6. Save the project and exit PeopleTools Application Designer.

The following sample screen shows the structural view of the TIB_PS8_ADAPTER project in 

the PeopleTools 8.4x Application Designer.

Figure 1   View of the Adapter’s PeopleSoft Project in the 8.4x Application Designer
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Task C Oracle Only: Create a Tablespace for Adapter Records

If you are using an Oracle database, you need to create a separate tablespace for the 

following adapter records:

• TIB_CI_BUS_DTL

• TIB_CI_BUS_HDR

• TIB_CI_MQUEUE

• TIB_CI_SEQUENCE

• TIB_CI_TIDLOG

To create a tablespace and assign records:

1. Create a tablespace in the Oracle database exclusively for adapter records. The 

recommended size for the tablespace is 50MB. If you want to increase the tablespace 

size, contact your database administrator.

2. Open PeopleTools Application Designer and log in to the target server where you 

added the project.

3. Open a record(s) to be allocated to the new tablespace.

4. From the menu, select Tools > Data Administration > Set Tablespace.

5. Select Oracle from the Platform drop-down list.

6. Select the created tablespace from Available Space Name-DB Name drop-down list. 

Change the original setting if required.

7. Click OK.

8. Save the record(s). A new tablespace is added to the record(s).

9. Repeat step 3 to step 8 to add the tablespace to the five records.

10. Save the project and exit PeopleTools Application Designer.

Task D Build the TIB_PS8_ADAPTER Project

To build the project:

1. Open PeopleTools Application Designer and log in to the target server where you 

added the project.

2. Open the TIB_PS8_ADAPTER project using PeopleTools Application Designer.

3. From the menu, select Build > Project.
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4. In the Build dialog, configure the following settings and options.

a. Click the Settings button and in the displayed Build Settings dialog, select all the 

options that will regenerate tables, views, and indexes, and click OK.

b. In the Build Options group box, check the Create Tables checkbox and the 

Create Views checkbox. 

c. In the Build Execute Options group box, select Execute And Build Script radio 

button. 

5. Click Build to build the project.

6. Save the project and exit PeopleTools Application Designer.

Task E Grant Permissions for Working with CI and IB

To grant permissions for an adapter working with CI and IB:

1. Restart the PeopleSoft application server where you added the project.

2. Log in to PIA and navigate to PeopleTools > Security > Permissions & Roles > 

Permission Lists.

3. Find the permission list with a description containing "all pages" and open it. The 

name of the permission list is different for varied PeopleSoft applications. For 

example, find HCCPCSSA1000 CS Administration - All Pages in the Permission 

List, as shown in Figure 2.

Figure 2   Find the All Pages Permission List

4. Click to open the page and set the permissions:

a. Click the Pages tab, add or find the TIBCO_MAINT_MENU menu and grant all 

permissions to the related components. Then save the change.
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b. Click the Component Interfaces tab, grant Full Access permissions for the 

following Component Interfaces. If they do not exist, insert them into the 

Component Interfaces list first.

- TIB_CI_COMPINTFC

- TIB_MQUEUE_DATA_CI

- TIB_MQUEUE_SRCH_CI

- TIB_MSGDET_CI

- TIB_MSGREC_CI

- TIB_MSGVER_CI

- TIB_PUB_COMPINTFC

5. Save all the changes.

6. Restart the PeopleSoft application server.
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Loading TIBCO Libraries

This section provides the steps for loading necessary library files to the PeopleSoft server:

• Integration Broker Only: Loading TIBCO Target Connector Library, page 16

• Loading TIBCO Enterprise Message Service Libraries, page 16

Integration Broker Only: Loading TIBCO Target Connector Library

After installing the adapter, you need to load TIBCO Target Connector class files to a 

PeopleSoft server.

1. Copy the TibcoTargetConnector.jar file in TIB_ADPSFT8_HOME\data to the following 

location in the PeopleSoft server:

PS_HOME\webserv\peoplesoft\applications\peoplesoft\PSIGW\WEB-INF\classes\

2. Use an unzip utility, such as Winzip or WinRAR, to extract the TibcoTargetConnector.jar 

file in the same directory. The destination path of the extracted *.class files is:

extracted_path\com\peoplesoft\pt\integrationgateway\targetconnector

Loading TIBCO Enterprise Message Service Libraries

To load the TIBCO EMS libraries:

1. Install the TIBCO EMS release, which automatically includes the library files in the 

TIB_EMS_HOME/lib subdirectory.

2. Copy the following JAR file from the TIB_EMS_HOME/lib directory to 

PS_HOME\webserv\peoplesoft\applications\peoplesoft\PSIGW\WEB-INF\lib or add the full 

pathnames for the JAR file to your CLASSPATH:

— tibjms.jar

The JRE version used by the tibjms.jar file must be equal or lower than the JRE version 

used by PeopleSoft. Otherwise, a PeopleSoft application cannot send to or receive 

messages from an EMS queue or topic.

3. Integration Broker only: If you use an SSL connection to connect to the EMS server, 

copy the following JAR file from the TIB_EMS_HOME/lib directory to 

PS_HOME\webserv\peoplesoft\applications\peoplesoft\PSIGW\WEB-INF\lib or add the full pathname 

for the JAR file to your CLASSPATH:

— tibcrypt.jar
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You also need to copy the following JAR files to 

PS_HOME\webserv\peoplesoft\applications\peoplesoft\PSIGW\WEB-INF\lib or add the full pathname 

for the JAR files to your CLASSPATH:

— slf4j-api-1.5.2.jar

— slf4j-simple-1.5.2.jar

For more information, see TIBCO Enterprise Message Service User’s Guide.
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Preparing PeopleSoft Component Interfaces

TIBCO ActiveMatrix Adapter for PeopleSoft uses PeopleSoft component interfaces as 

schemas and as APIs for formatting and processing data between a PeopleSoft application 

and the TIBCO environment. You must prepare PeopleSoft component interfaces so the 

design-time adapter can download them to the adapter’s configuration tool, TIBCO 

Designer.

Procedure on page 18 lists the general setup tasks with PeopleTools for using Component 

Interface.

Configuration Procedure for Adapter Services on page 22 lists the specific configuration 

details for each type of adapter service.

Procedure

Before configuring the adapter, complete the following tasks in your PeopleSoft system:

• Task A, Develop Component Interfaces, page 18

• Task B, Build PeopleSoft Component Interface Java APIs, page 19

• Task C, Compile the Built PeopleSoft Component Interface Java APIs, page 20

• Task D, Grant Permissions for the Required Component Interfaces, page 22

Task A Develop Component Interfaces

To develop the required component interfaces, you need to create or change the required 

component interfaces by using PeopleTools Application Designer. Make sure the 

component interfaces have all the records and fields you need for the type of data the 

adapter will be processing.

• Use the Test Component Interface tool in PeopleTools Application Designer to 

determine which fields are required and what values are valid for sending into 

PeopleSoft.

• Eliminate any unnecessary records and fields from a component interface. The 

simpler the component interface, the easier it is to set up and test the adapter. 

Component interfaces containing fields from derived records are likely to cause 

errors.

• The preparation steps given under Procedure on page 18 assume you know PeopleSoft 

procedures. For complete information about creating component interfaces and 

making them available, see Integration Tools: PeopleSoft Component Interfaces in 

PeopleSoft (Enterprise PeopleTools) Documentation Library.
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Task B Build PeopleSoft Component Interface Java APIs

To build PeopleSoft Java APIs:

1. Open the component interface you want to use from PeopleSoft Application Designer.

2. From the menu, select Build > PeopleSoft APIs.

3. In the Build PeopleSoft API Bindings dialog:

a. Uncheck the Build checkbox for COM Type Library.

b. Uncheck the Build checkbox for C Header Files. 

c. Check the Build checkbox for Java Classes. Navigate to open your Target 

Directory and select the following from the PeopleSoft APIs to Build list:

- PeopleSoft.*

- CompIntfc.CompIntfc*

- APIs for required component interfaces: For example, for the COUNTRY 

component interface, select CompIntfc.COUNTRY and CompIntfc.COUNTRYCollection.

Figure 3   Build PeopleSoft API Bindings

4. Click OK in the Build PeopleSoft API Bindings dialog to build the APIs.
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Task C Compile the Built PeopleSoft Component Interface Java APIs

To compile the APIs for TIBCO ActiveMatrix Adapter for PeopleSoft, you can use 

TIBCO Configuration Tool. You install this tool as a post-installation task. For 

configuration details, see Compile the Component Interface APIs Using TIBCO 

Configuration Tool on page 20.

TIBCO Configuration Tool does not support HPUX PA-RISC platforms. This is because 

the release of TIBCO Configuration Tool used with the adapter requires Eclipse 3.7 to run 

and Eclipse 3.7 does not support HPUX PA-RISC platforms. To compile the APIs on these 

platforms, see Compile the Component Interface APIs Using Other Command Utilities on 

page 21.

Compile the Component Interface APIs Using TIBCO Configuration Tool

TIBCO Configuration Tool is installed to TIBCO_HOME/tct when you complete the 

post-installation tasks. 

Follow these steps to compile the PeopleSoft Component Interface Java APIs:

1. Make preparation for the following items:

— PeopleTools version: Contact your PeopleSoft administrator for this.

— Access to psjoa.jar: must be from a PeopleTools version compatible with your server. 

Contact your PeopleSoft administrator to locate this library.

— Component Interface Java APIs: store the APIs you built in Task B, Build 

PeopleSoft Component Interface Java APIs to a location that TIBCO 

Configuration Tool can access.

2. Run TIBCO Configuration Tool to compile the APIs.

You can run TIBCO Configuration Tool in GUI mode, console mode, silent mode, or 

script mode. For detailed information on how to use the tool in each mode, see the 

TIBCO Configuration Tool documentation set.

— If you run the tool in GUI mode or in console mode, you are prompted for opening 

the TIBCO ActiveMatrix Adapter for PeopleSoft Configuration Wizard. By using 

the wizard, specify the settings as listed in Table 5, TIBCO Configuration Tool 

Settings and complete the configuration.

Table 5   TIBCO Configuration Tool Settings

Setting Description

JDK_HOME Location of the installed JDK.

Java Compiler Arguments Java compiler arguments.

PeopleTools Version The version of PeopleTools.
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— If you run the tool in silent mode, you should run the tool in GUI mode to generate 

a configuration file (build.properties) in the following directory:

CONFIG_HOME/tct/peoplesoft/date-time/scripts

Table 6, TIBCO Configuration Tool Properties in build.properties lists some of the 

properties that you might change in the properties file.

3. Verify that the built Java classes are available in the following directory:

TIB_ADPSFT8_HOME/lib/ext 

Compile the Component Interface APIs Using Other Command Utilities

For the platforms which TTIBCO Configuration Tool does not support, you can compile 

the Component Interface APIs by using one of the following alternative approaches:

• Recommended: Run BuildCI command utility under the TIB_ADPSFT8_HOME/bin 

directory.

PSJOA Jar File Location of psjoa.jar.

CI Java Source Directory Location of PeopleSoft Component Interface Java source files.

Compiled CI Java Classes Directory Location of the CLASS files after configuration.

Table 5   TIBCO Configuration Tool Settings

Setting Description

Table 6   TIBCO Configuration Tool Properties in build.properties

Property Description

TIBCO_HOME TIBCO ActiveMatrix Adapter for PeopleSoft installation location

plugin.dir TIBCO Configuration Tool installation location

adapter.dir TIB_ADPSFT8_HOME

compile.parameter Java compiler arguments.

src Component Interface Java source directory.

dest Compiled Component Interface Java classes directory.

jar.path Location of psjoa.jar.

java.home JDK_HOME
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• Run an ANT task under the 

TIBCO_HOME/tct/tct_version_number/plugins/com.tibco.tct.peoplesoft_plugin_version_number/res 

directory.

Task D Grant Permissions for the Required Component Interfaces

To grant permissions for the component interfaces:

1. Log in to PIA and navigate to PeopleTools > Security > Permissions & Roles > 

Permission Lists.

2. Find the permission list which includes the required component interfaces and open it.

3. Click the Component Interfaces tab and find the desired component interfaces. For 

example, if you want to work with the Country component interface, make sure it is in 

the list.

4. Edit each component interface and grant Full Access permissions to all its methods, as 

shown in Figure 4.

Figure 4   Set Permissions for a Component Interface

Configuration Procedure for Adapter Services

The general tasks listed in Procedure on page 18 are the same for all adapter services that 

use Component Interface. This section introduces the specific configuration details for 

each adapter service as follows:

• CI Publication Service, page 23

• CI Subscription Service and Request-Response Service, page 25
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CI Publication Service

Every PeopleSoft component to be processed by a CI Publication Service of the adapter 

must have a shadow page (formerly “panel”) embedded in the component. Embedding is 

done in the PeopleTools Application Designer after you have configured the adapter in 

TIBCO Designer but before starting the adapter.

The shadow work page, TIB_CI_ADAPTER_WRK, is shipped with the adapter. It contains 

configuration-driven PeopleCode that extracts data from the component based on the 

adapter configuration settings. 

To embed the shadow work page into a component, you need to finish:

• Task A, Insert the TIB_CI_ADAPTER_WRK Page into Components, page 23

• Task B, Grant Component Permissions for the TIB_CI_ADAPTER_WRK page, 

page 24

Task A Insert the TIB_CI_ADAPTER_WRK Page into Components

To insert the page into the required components:

1. Log in to PeopleTools Application Designer.

2. From the menu, select File > Open. Use the Open Definition dialog to open the 

required components. For example, open the components that satisfy the COUNTRY 

selection criteria as shown in Figure 5.
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Figure 5   Open Definition Dialog

3. From the menu, select Insert > Page Into Component. Use the Insert Page dialog to 

insert TIB_CI_ADAPTER_WRK page of the TIB_PS8_ADAPTER into the component.

4. From the menu, select File > Save to save the component.

Task B Grant Component Permissions for the TIB_CI_ADAPTER_WRK page

To grant the permissions for the TIB_CI_ADAPTER_WRK page you just add to the required 

component.

1. Log in to PIA and navigate to PeopleTools > Security > Permissions & Roles > 

Permission Lists.

2. Navigate to PeopleTools > Security > Permissions & Roles > Permission Lists.

3. Select a suitable permission list and find the component which was inserted with 

TIB_CI_ADAPTER_WRK page. 

4. Click Edit Pages and then check the Authorized checkbox for the Tib Ci Adapter 

Wrk page. For example, grant permissions for the Country_Table.GBL as shown in 

Figure 6:
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Figure 6   Grant Permission for the TIB_CI_ADAPTER_WRK Page

5. Click OK.

6. Save the changes.

CI Subscription Service and Request-Response Service

If you are applying a PeopleSoft component interface to a Subscription Service or a 

Request-Response Service in the adapter, set up the fields in the CREATEKEYS, 

GETKEYS, and FINDKEYS folders in every component interface as shown in the 

following table. Remember, PeopleSoft component interfaces become schemas in the 

adapter.

To insert data into the PeopleSoft system, make sure that both the CREATEKEYS and 

GETKEYS fields are filled in, regardless of whether they are new or recently updated. For 

more information on the CREATEKEYS, GETKEYS, and FINDKEYS, see 

Implementation of Keys in the TIBCO Adapter for PeopleSoft on page 158.

PeopleSoft Mode CREATEKEYS Fields GETKEYS Fields

Add Must fill in Fill-in optional

Correction Fill-in optional Must fill in

The maximum number of records returned by the adapter's Request-Response Service is 

limited to 300. This is due to a limitation built into PeopleSoft which restricts the number 

of records resulting from a FIND query on a component interface.
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The adapter provides the FINDKEYS functionality of PeopleSoft Component Interface 

technology as a feature which can be used with the adapter's Request-Response Service. 

The adapter fetches the schema for a particular component interface at design time. In 

addition to the CREATEKEYS and GETKEYS schemas, the adapter now fetches the 

FINDKEYS schema as well. Hence, at runtime, if the FINDKEYS values are specified in 

the incoming request, they take precedence over any GETKEYS or CREATEKEYS 

values specified. The adapter's Request-Response Service uses the same FINDKEYS 

values to query PeopleSoft and returns, as a reply, a sequence of FINDKEY values, which 

satisfy the query criterion.
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Preparing PeopleSoft Application Messages

TIBCO ActiveMatrix Adapter for PeopleSoft uses PeopleSoft application messages as 

schemas for formatting and processing data between a PeopleSoft application and the 

TIBCO environment. PeopleSoft application messages must be prepared so the 

design-time adapter can download them to the adapter’s configuration tool, TIBCO 

Designer. 

Procedure on page 27 lists the general setup tasks with PeopleTools if you want to use 

Integration Broker.

Configuration Procedure for Adapter Services on page 44 lists the specific configuration 

details for each type of adapter service.

If you use an SSL connection, you also need to read Enabling SSL on the PeopleSoft 

Server on page 57.

Procedure

The following steps are involved in setting up the Integration Broker using PeopleTools. 

All the steps require you to log in to the PeopleSoft Pure Internet Architecture.

To Define Integration Gateways and Load Connectors

• Task A, Configure Gateway URL and Activate Domain, page 28

• Task B, Load Gateway Connectors, page 29

To Configure Integration Gateway Properties

• Task C, Configure Integration Gateway Properties, page 32

The following list will help you set up the PeopleSoft environment.

• Check the Message definition in PIA to determine the required fields and valid values 

to be sent to PeopleSoft.

• Eliminate any unnecessary records and fields from the message. The simpler the 

message, the easier it is to set up and test the adapter.

• The preparation steps given under Procedure on page 27 assume you know PeopleSoft 

procedures. For complete information about creating messages and making them 

available, see Integration Tools: PeopleSoft Integration Broker in PeopleSoft 

(Enterprise PeopleTools) Documentation Library.
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To Set Up Integration

• Task D, Define Nodes, page 33

• Task E, Define Messages, page 35

• Task F, Define Message Queues, page 38

• Task G, Define Services, page 38

• Task H, Define Service Operations, page 40

• Task I, Define Routings, page 42

Before you start with configuration, make sure you finish loading TIBCO libraries on the 

PeopleSoft server and restart the server. See Loading TIBCO Libraries on page 16 for 

more information.

Task A Configure Gateway URL and Activate Domain

To configure gateway URL and activate domain:

1. Navigate to PeopleTools > Integration Broker > Configuration > Quick 

Configuration.

2. Keep the default Gateway URL as is or enter the one you want to use. See Figure 7 for 

an example.

Figure 7   Integration Broker Quick Configuration Pane
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3. Click the Ping Gateway button. Make sure a message that shows the gateway is 

active is displayed. See Figure 8 as an example.

Figure 8   PeopleSoft Integration Gateway Status Message

4. To process asynchronous messages, one application server domain must be active. In 

the Integration Broker Domains pane, activate the appropriate domain you want to 

use. See Figure 7 for an example.

5. Click Save.

Task B Load Gateway Connectors

The Integration Broker allows you to define and customize target connectors. The steps to 

define a connector are the same for all adapter services. However, based on the adapter 

service selected, you need to select the appropriate target connector from the following 

three types of connectors:

• HTTPTARGET connector: for IB Publication Service, IB Subscription Service and 

Request-Response Invocation service.

• JMSTARGET connector: for IB Publication and Subscription Service.

• TIBCOTARGET connector: for IB Publication and Request-Response Invocation 

Service.

TIBCOTARGET connector is a connector defined by TIBCO that is installed on the 

Integration Gateway. TIBCOTARGET Connector facilitates the exchange of JMS 

messages between PeopleSoft and the adapter.

See Configuration Procedure for Adapter Services on page 44 for detailed setup 

procedures for each service.

To load and define gateway connectors:

1. Navigate to PeopleTools > Integration Broker > Configuration > Gateways.

2. Search the existing gateways. If no gateway satisfies your search criteria, click the 

Add A New Value link. In the Integration Gateway ID field, enter TIB_LOCAL, and 

click Add. 
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Figure 9   The Gateways Pane

3. Fill in the information for the TIB_LOCAL gateway, as shown in Figure 10.

a. Check the Local Gateway checkbox.

b. In the URL field, enter the gateway URL you configured in step 2 of Task A, 

Configure Gateway URL and Activate Domain, on page 28.

Figure 10   Gateway Information
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4. Click the Load Gateway Connectors button. All loaded Gateway Connectors are 

shown in the Connectors area, as shown in Figure 11. 

Figure 11   Default Gateway Connectors

5. Add an entry with the following details, and then click Save.

— Connector ID: TIBCOTARGET

— Connector Class Name: TibcoTargetConnector

6. Click the Properties link for the TIBCOTARGET connector.

7. Add the properties listed in Table 7 for the connector.

Table 7   TIBCOTARGET Connector Properties

Property ID Property Name Value

HEADER sendUncompressed Y

TIBCOTARGET JMSQueue queue_name

For example, IBPUB.QUEUE

TIBCOTARGET JMSTopic topic_name

For example, IBPUB.TOPIC

TIBCOTARGET JMSUrl tcp://TIBCO_EMS_server_name:port 

For example, tcp://192.168.70.86:7222

TIBCOTARGET JMSUserName TIBCO_EMS_server_username

For example, admin

TIBCOTARGET JMSPassword Encrypted TIBCO_EMS_server_password

For example, "{V1.1}ZuI38CaBQOM=" for password "admin"

TIBCOTARGET ServiceType Either of the following values: 

• RPCCLIENT

• PUBLISHER
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8. Click OK to save the properties.

9. Click Save to save the gateway information.

Task C Configure Integration Gateway Properties

After you define the default local integration gateway, specify the integration gateway 

URL and load the delivered connectors, you must configure the integration gateway 

properties file. To establish settings for the integration gateway and its delivered 

connectors, you use the integrationGateway.properties file under 

PS_HOME\webserv\peoplesoft\applications\peoplesoft\PSIGW\WEB-INF.

When the gateway server boots, it reads and applies the properties in the 

integrationGateway.properties configuration file. Changes that you make to the file while the 

server is running have no immediate effect. 

If you want to make changes to the integrationGateway.properties file while the server is running, 

you can log in to PIA and change the properties online. PeopleSoft Integration Broker 

reapplies the configuration settings—including the changes—without rebooting.

To Access the Properties File using PIA

1. Navigate to PeopleTools > Integration Broker > Configuration > Gateways.

2. Search the gateway you defined in Task B, Load Gateway Connectors, on page 29

3. Open the gateway and click the Gateways Setup Properties link next to the 

integration gateway URL field.

4. In the displayed Gateway Properties Sign-in page, enter the User ID and Password. 

Click OK.

5. In the displayed PeopleSoft Node Configuration page, click the Advanced Properties 

Page link.

6. Configure gateway properties in the displayed editor.

7. Click OK to save the properties.

8. Click Save to save the integration gateway configuration.

To Configure Integration Gateway Properties

You need to configure the following integration gateway properties:

• Delivered Connector Configuration

ig.isc.serverURL=PeopleSoft_server_name:port
ig.isc.userid=username
ig.isc.password=password
ig.isc.toolsRel=PeopleTools_version
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Use the supplied Password Encryption Utility to generate an encrypted password for 

ig.isc.password.

• JMS Configuration Section

— If you want to use the JMS transport type in Queue mode, add the following 

properties for the queue. Replace # with the queue number. For example, if this is 

the third queue you specify, replace # with 3.

# Enter the number of Queue listeners to instantiate

ig.jms.Queues=#

ig.jms.Queue#=queue_name
ig.jms.Queue#.Provider=Tibco

ig.jms.Queue#.JMSFactory=QueueConnectionFactory

ig.jms.Queue#.MessageSelector=

ig.jms.Queue#.Url=tcp://TIBCO_EMS_server_name:port
ig.jms.Queue#.User=TIBCO_EMS_server_username
ig.jms.Queue#.Password=TIBCO_EMS_server_password

Use the supplied Password Encryption Utility to generate an encrypted password for 

ig.jms.Queue1.Password.

— If you want to use the JMS transport type in Topic mode, add the following 

properties for the topic. Replace # with the topic number. For example, if this is the 

third topic you specify, replace # with 3.

# Enter the number of Topic listeners to instantiate

ig.jms.Topics=#

ig.jms.Topic#=topic_name
ig.jms.Topic#.Provider=Tibco

ig.jms.Topic#.JMSFactory=TopicConnectionFactory

ig.jms.Topic#.MessageSelector=

ig.jms.Topic#.Url=tcp://TIBCO_EMS_server_name:port
ig.jms.Topic#.User=TIBCO_EMS_server_username
ig.jms.Topic#.Password=TIBCO_EMS_server_password

Use the supplied Password Encryption Utility to generate an encrypted password for 

ig.jms.Topic1.Password.

Task D Define Nodes

Nodes represent any organization, application or system that will play a part in 

integrations. For example, nodes can represent customers, business units, suppliers, other 

trading partners, external or third-party software systems, and so on. Node definitions 

define the locations to or from which messages can be routed. Because an application can 

send messages to itself, a default local node definition that represents the application is 

delivered as part of the integration engine. Each PeopleSoft installation must have one, 

and only one, default local node.

To define a node, follow these steps:
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1. Navigate to PeopleTools > Integration Broker > Integration Setup > Nodes.

2. Search the existing nodes. If no node satisfies your search criteria, click the Add A 

New Value link. Enter Node Name, and click Add.

3. Click the Node Definitions tab to define the node, as shown in Figure 12.

a. Enter Description.

b. Select PIA from the Node Type drop-down list.

c. Enter Default User ID.

d. Check the Active Node checkbox.

Figure 12   Node Definitions
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4. Click the Connectors tab and define the connectors. 

a. Specify Gateway ID or click the  button to look up the Gateway ID you 

defined in Task B, Load Gateway Connectors, on page 29.

b. Specify Connector ID or click the  button to look up the Connector ID you 

defined in Task B, Load Gateway Connectors, on page 29.

The connector properties are loaded as shown in Figure 13:

Figure 13   Node Connector Properties

c. Click Ping Node. Make sure the result is success. 

You must start your EMS server before you ping the node.

d. Click Return.

5. Click Save. The specified node is created.

Task E Define Messages

Message definitions provide the physical description of the data that is being sent, 

including fields, field types, and field lengths.
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To define a message:

1. Navigate to PeopleTools > Integration Broker > Integration Setup > Messages.

2. Search the existing messages. If no message satisfies your search criteria, click the 

Add A New Value link.

3. Do the following steps to add a new message.

a. Select Rowset from the Type drop-down list.

b. Enter Message Name.

c. Enter Message Version.

d. Click Add.

See Figure 14 as an example:

Figure 14   Add a New Message
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4. Click the Message Definition tab and define the message.

a. Enter Description

b. Select Enterprise Components from the Owner ID drop-down list.

c. Click the Add Record To Root link to add a level 0 record to the root node.

d. Click the record link, you can also add more records to the level 0 record or its 

child records.

See Figure 15 as an example. The COUNTRY_SYNC message has COUNTRY_TBL as its 

level 0 record and EO_ADDR_FMT_TBL as the child level 1 record.

Figure 15   Message Definition

5. Click Save. The specified message is created.
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Task F Define Message Queues

A message queue isolates different groups of service operations from each other. It needs 

to be created exclusively to handle messages meant for the adapter. You can also choose 

an existing message queue. If a message does not exist for a record from which data is to 

be exported, it needs to be created. Modifications to the existing messages might be 

required. 

Task G Define Services

PeopleSoft Integration Broker enables you to take an existing component interface and 

create a service which can be used to invoke the component interface.

To define a service:

1. Navigate to PeopleTools > Integration Broker > Integration Setup > Services.

2. Search the existing services. If no service satisfies your search criteria, click the Add 

A New Value link.

3. Enter the service name, and then click the Add button. 
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4. Fill in the service information:

a. Enter Description.

b. Select Enterprise Components from the Object Owner ID drop-down list.

See Figure 16 as an example. 

Figure 16   Service Information

5. Define a service operation in the Service Operations area:

a. Enter Service Operation.

b. Select an Operation Type from the drop-down list.

c. Click Add.

d. Follow step 3 to step 8 in Task H, Define Service Operations, on page 40 to define 

the service operation.

6. Click Save. The specified service is created.
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Task H Define Service Operations

A service operation definition consists of general information about an operation, such as 

its name, description, and so on. It also specifies an operation type, which determines how 

the operation is to be processed, synchronously or asynchronously. In addition, it contains 

routings which determine the direction, inbound or outbound, of the service operation. A 

service operation has one or more handlers, which contain and run the programming logic 

for sending or receiving the message, manipulating message content, and other functions.

The Integration Broker allows you to define and customize service operations. The steps 

to define a service operation are the same for all adapter services. However, based on the 

adapter service selected, you need to select the appropriate operation type from the 

following two choices:

• Asynchronous - One Way: for Message Subscription Service and Message 

Publication Service.

• Synchronous: for Message Request Response Invocation Service.

To define a service operation:

1. Navigate to PeopleTools > Integration Broker > Integration Setup > Service 

Operations.

2. Search the existing service operations. If no service operation satisfies your search 

criteria, click the Add A New Value link.

3. Fill in the information in the Add New Service Operation pane:

a. Specify Service or click the  button to look up the service you defined in 

Task G, Define Services, on page 38.

b. Specify the Service Operation name.

c. Select the appropriate Operation Type from the drop-down list.

d. Click Add.

4. Click the General tab and fill in the information:

a. Enter Operation Definition.

b. Select Enterprise Components from the Object Owner ID drop-down list.

c. Enter Version.

d. Check the Active checkbox.

e. Specify Message.Version or click the  button to look up the message you 

defined in Task E, Define Messages, on page 35.

f. Specify Queue Name or click the  button to look up the message queue you 

defined in Task F, Define Message Queues, on page 38.

See Figure 17 as an example.
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Figure 17   Service Operation Information

5. Click the Routings tab. Enter the Routing Name and click Add.

6. Follow step 4 to step 6 in Task I, Define Routings, on page 42 to define the routing.
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7. Check the Selected checkbox of the routing you defined and want to use. Then click 

Activate Selected Routings. Make sure the selected routing is active. See Figure 18 

as an example.

Figure 18   Activate A Selected Routing

8. Click Save. The specified service operation is created.

Task I Define Routings

Routing definitions determine the sender and receiver of an integration. Routing 

definitions allow you to specify inbound and outbound transformations that enable you to 

transform data structures into those that the sending or receiving systems can understand.

The Integration Broker allows you to define and customize routings. The steps to define a 

routing are the same for all adapter services. However, based on the adapter service 

selected, you need to select the appropriate sender node and receiver node. See 

Configuration Procedure for Adapter Services on page 44 for the specific configuration 

details for each type of adapter service.

To define a routing:

1. Navigate to PeopleTools > Integration Broker > Integration Setup > Routings.

2. Search the existing routings. If no routing satisfies your search criteria, click the Add 

A New Value link.

3. Enter Routing Name, and click Add. 
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4. Click the Routing Definitions tab and define the routing: 

a. Specify Service Operation or click the  button to look up the service you 

defined in Task H, Define Service Operations, on page 40.

b. Enter Version.

c. Enter Description.

d. Specify Sender Node or click the  button to look up the node you defined in 

Task D, Define Nodes, on page 33.

e. Specify Receiver Node or click the  button to look up the node you defined 

in Task D, Define Nodes, on page 33.

f. Select PeopleTools from the Object Owner ID drop-down list.

See Figure 19 as an example.

Figure 19   Routing Definitions

5. Click the Connector Properties tab and fill in the information:

a. Specify Gateway ID or click the  button to look up the gateway you defined 

in Task A, Configure Gateway URL and Activate Domain, on page 28.

b. Specify Connector ID or click the  button to look up the connector you 

defined in Task B, Load Gateway Connectors, on page 29.

6. Click Save. The specified routing is created.
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Configuration Procedure for Adapter Services

The general tasks listed in Procedure on page 27 are the same for all adapter services, but 

the values assigned to certain parameters will differ based on the adapter services 

configured. This section introduces the detailed information for each adapter service as 

follows:

• Message Publication Service, page 44

• Message Subscription Service, page 50

• Request-Response Invocation Service, page 54

You may select one of the following transport types for each adapter service.

• HTTP transport

• JMS transport

Message Publication Service

To Configure Integration Broker by Using PeopleTools

Select a transport type and follow these steps:

1. Load gateway connectors. See Load Gateway Connectors on page 29 for detailed 

information. 

a. If you want to use the HTTP transport type, you may use the default gateway 

TIB_LOCAL, and then add a connector entry HTTPTARGET to it. Click the Properties 

link for HTTPTARGET connector to open the Connector Properties pane and add 

the properties listed in Table 8 for the connector. 

b. If you want to use the JMS transport type, you may use the default gateway 

TIB_LOCAL and the default JMSTARGET connector, or add a connector entry 

TIBCOTARGET to it. Click Properties of the TIBCOTARGET connector to open 

Table 8   HTTPTARGET Connector Properties for Message Publication Service

Property ID Property Name Value

HEADER sendUncompressed Y

HEADER version VERSION_1

HTTPPROPERTY Method POST

PRIMARYURL URL HTTP_server_name:port

For example, http://127.0.0.1:2002
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the Connector Properties pane and add the properties listed in Table 7 for the 

connector. 

2. Configure the integration properties. See Task C, Configure Integration Gateway 

Properties, on page 32 for more information.

If you want to use the JMS transport type, configure the following properties:

ig.jms.Queue#: Use this property only if you want to use Queue as the JMS 

Connection Factory for the adapter. This value should match the Subscriber 

Subject under the SubscriberOptions tab in TIBCO Designer.

ig.jms.Topic#: Use this property only if you want to use Topic as the JMS Connection 

Factory for the adapter. This value should match the Subscriber Subject under the 

SubscriberOptions tab in TIBCO Designer.

See SubscriberOptions Tab on page 105 for more details about configuring a 

connection factory in TIBCO Designer.

3. To define a node, enter the following Connection Properties. See Define Nodes on 

page 33 for more information.

a. If you want to use the HTTP transport type, modify the following properties:

HTTPPROPERTY: Specify the method as POST.

PRIMARYURL: Specify the URL for the HTTP Listening Connector of the 

adapter. For example, http://127.0.0.1:2002

b. If you want to use the JMS transport type, and define the TIBCOTARGET 

connector in step 1, modify the following properties for the connector:

JMSQueue: Use this property only if you want to use Queue as the JMS 

Connection Factory for the adapter. The value of JMSQueue in PIA should match 

the Subscriber Subject under the SubscriberOptions tab in TIBCO Designer.

JMSTopic: Use this property only if you want to use Topic as the JMS Connection 

Factory. The value of JMSTopic in PIA should match the Subscriber Subject under 

the SubscriberOptions tab in TIBCO Designer.

See SubscriberOptions Tab on page 105 for more details about configuring a 

connection factory in TIBCO Designer.

JMSUrl: Enter the URL for the TIBCO Enterprise Message Server (EMS). For 

example, tcp://192.168.66.145:7222

The value of the Queue or Topic should already exist in the TIBCO Enterprise Message 

Service server.
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ServiceType: PUBLISHER

4. To define a message, see Define Messages on page 35. You can define a new message 

or just use the pre-defined messages.

5. To define a service, see Define Services on page 38. You can define a new service for 

the message you defined in step 4 or just use the related service that PeopleSoft 

delivered.

6. To define a service operation, see Define Service Operations on page 40. You can 

define a new service operation for the service you defined in step 5. 

Select Asynchronous - One Way from the Operation Type drop-down list. 

7. To define a routing, see Define Routings on page 42. To configure routings, you need 

to correctly set the sender node and the receiver node. 

— Sender node: must be a local node in the PeopleSoft server, for example, PSFT_HR.

— Receiver node: must be a node you defined in step 3.

To Configure PeopleCode by Using PeopleTools Application Designer

To configure the PeopleCode of your desired component:

1. Open PeopleTools Application Designer and log in to the PeopleSoft server.

2. Select File > Open to open the Open Definition dialog, and then select Component 

from the Definition drop-down list. Type the component name, such as 

COUNTRY_TABLE in the Name field and then click Open.

3. With the component definition opened, select View > View PeopleCode.
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4. In the displayed PeopleCode Editor, leave the component name as is in the left hand 

side drop-down list and select the SavePostChange event from the right hand side 

drop-down list. See Figure 20.

Figure 20   SavePostChange PeopleCode in Application Designer

5. In the PeopleCode Editor, paste the following PeopleCode. If there are any existing 

lines of PeopleCode, you should comment them out first and then append the code 

given. 

Replace the %message_name% with the corresponding message name without any 

quotes.

This PeopleCode will go into the SavePostChange event for the required component.

Local Message &MSG;

Local Rowset &RS0, &RS01, &RS11;

Local Row &R1;

PanelGroup string &PubNodeName;

Function MessageFilled(&MSG As Message) Returns boolean;

/** Assumption: All Key Fields are Published **/
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/** &MSG -- Inbound Message Object **/

/** &MSG_FILLED -- Boolean Return Value **/

/** True - Message Filled **/

/** False - Message Not Filled **/

/****************************************************************/

/** BEGIN: Check If Message Is Filled -- Check L0 Record Keys **/

/****************************************************************/

&ZERO = 0;

&MSG_FILLED = False; /** Set Message Filled Indicator to False **/

&MSG_RS = &MSG.GetRowset(); /** Set Rowset Pointer Level 0 Message Rowset **/

For &NBR_TRANSACTIONS = 1 To &MSG_RS.RowCount; /** Navigate to A Message Transaction **/

&TRANSACTION = &MSG_RS.GetRow(&NBR_TRANSACTIONS);

For &NBR_RECORDS = 1 To &TRANSACTION.RecordCount /** Navigate to A Level 0 Record **/

&REC = &TRANSACTION.GetRecord(&NBR_RECORDS);

&NBR_KEYS = 0; /** Number of Record Keys Counter **/

&NBR_POPULATED_KEYS = 0; /** Number of Populated Record Keys **/

If &REC.Name <> "PSCAMA" Then /** Check Record Keys only if Message Record is not PSCAMA **/

For &NBR_FIELDS = 1 To &REC.FieldCount /** Navigate to Level 0 Record Fields **/

&FIELD = &REC.GetField(&NBR_FIELDS);

&IS_KEY = &FIELD.IsKey;

/** Count Number of Keys and Number of Populated Keys **/

If &IS_KEY Then

&FIELD_VALUE = &FIELD.Value;

If All(&FIELD_VALUE) Or &FIELD_VALUE = &ZERO Then

&NBR_POPULATED_KEYS = &NBR_POPULATED_KEYS + 1;

End-If;

&NBR_KEYS = &NBR_KEYS + 1;

Else

&NBR_FIELDS = &REC.FieldCount

End-If;

End-For; /** For &NBR_FIELDS = 1 To &REC.FieldCount **/

/** Number of Key Flags = Number of Key Flags Populated ==> All Keys Populated ==> Message Populated **/

If &NBR_KEYS = &NBR_POPULATED_KEYS Then

&MSG_FILLED = True;

End-If;

End-If; /** If &REC.Name <> "PSCAMA" Then **/

End-For; /** For &NBR_RECORDS = 1 To &TRANSACTION.RecordCount **/

End-For; /** For &NBR_TRANSACTIONS = 1 To &RS.RowCount; **/

/**************************************************************/
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/** END: Check If Message Is Filled -- Check L0 Record Keys **/

/**************************************************************/

Return &MSG_FILLED;

End-Function;

If ActiveRowCount() = CurrentRowNumber() Then

&MSG = CreateMessage(Message.%message_name%);

If All(&PubNodeName) Then

&MSG.DoNotPubToNodeName = &PubNodeName;

End-If;

If &MSG.IsActive Then

&MSG.CopyRowsetDelta(GetLevel0());

If MessageFilled(&MSG) Then

&MSG.Publish();

End-If;

End-If;

End-If;

6. Save the component definition.
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Message Subscription Service

To Configure Integration Broker by Using PeopleTools

Select a transport type and follow these steps:

1. Load Gateway connectors. See Load Gateway Connectors on page 29 for detailed 

information. 

a. If you want to use the HTTP transport type, you may use the default gateway 

TIB_LOCAL, and then add a connector entry HTTPTARGET to it. Click the Properties 

link for HTTPTARGET connector to open the Connector Properties pane and add 

the properties listed in Table 9 for the connector.

b. If you want to use the JMS transport type, you may use the default gateway 

TIB_LOCAL, and then add a connector entry JMSTARGET to it. Click Properties of 

the JMSTARGET connector to open the Connector Properties pane and configure 

the properties listed in Table 10 for the connector. The JMSQueue name 

IBSUB.QUEUE should differ with the queue name of the Message Subscription 

Service in TIBCO Designer.

Table 9   HTTPTARGET Connector Properties for Message Subscription Service 

Property ID Property Name Value

HEADER sendUncompressed Y

HEADER version VERSION_1

HTTPPROPERTY Method GET

PRIMARYURL URL HTTP_server_name:port 

For example, http://127.0.0.1:2002

Table 10   JMSTARGET Connector Properties for Message Subscription Service

Property ID Property Name Value

HEADER sendUncompressed Y

JMSTARGET JMSAcknowledgement AUTO_ACKNOWLEDGE

JMSTARGET JMSDeliveryMode NON_PERSISTENT

JMSTARGET JMSFactory QueueConnectionFactory

JMSTARGET JMSMessageTimeToLive 0

JMSTARGET JMSMessageType Text

JMSTARGET JMSPriority 0

JMSTARGET JMSProvider TIBCO

JMSTARGET JMSQueue queue_name

JMSTARGET JMSReplyTo FALSE
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2. Configure the integration properties. See Task C, Configure Integration Gateway 

Properties, on page 32 for more information.

If you want to use the JMS transport type, configure the following properties:

ig.jms.Queue#: Use this property only if you want to use Queue as the JMS 

Connection Factory for the adapter. This value should match the IB Subscriber 

Subject under the SubscriberOptions tab in TIBCO Designer.

ig.jms.Topic#: Use this property only if you want to use Topic as the JMS Connection 

Factory for the adapter. This value should match the IB Subscriber Subject under 

the SubscriberOptions tab in TIBCO Designer.

See SubscriberOptions Tab on page 114 for more details about configuring a 

connection factory for Message Subscription Service in TIBCO Designer.

3. To define a node, for example TIB_NODE, enter the following Connection Properties. 

See Define Nodes on page 33.

a. If you want to use the HTTP transport type, modify the following properties:

HTTPPROPERTY: Specify the method as GET.

PrimaryURL: Specify the URL for the HTTP listening connector of the adapter. 

For example, http://127.0.0.1:2002

b. If you want to use the JMS transport type, modify the following properties:

JMSFactory: QueueConnectionFactory or TopicConnectionFactory depending on 

the Connection Factory type that you want to use.

See SubscriberOptions Tab on page 114 for more details about configuring a 

connection factory for Message Subscription Service in TIBCO Designer.

JMSProvider: TIBCO

JMSUrl: Enter the URL of the TIBCO Enterprise Message Server (EMS) server. 

For example, tcp://192.168.66.145:7222

JMSTARGET JMSUrl tcp://TIBCO_EMS_server_name:port

For example, tcp://192.168.66.145:7222

Table 10   JMSTARGET Connector Properties for Message Subscription Service (Cont’d)

Property ID Property Name Value

The value of the Queue or Topic should already exist in the TIBCO Enterprise Message 

Service server.



TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

52 | Chapter 1  Preparing PeopleSoft

4. To define a message, see Define Messages on page 35. You can define a new message 

or just use the pre-defined messages.

5. To define a service, see Define Services on page 38. You can define a new service for 

the message you defined in step 4 or just use the related service that PeopleSoft 

delivered.

6. To define a service operation, see Define Service Operations on page 40. You can 

define a new service operation for the service you defined in step 5. 

Select Asynchronous - One Way from the Operation Type drop-down list.

7. To define a routing, see Define Routings on page 42. To configure routings, you need 

to correctly set the sender node and the receiver node. 

— Sender node: must be a node you defined in step 3.

— Receiver node: must be a local node in the PeopleSoft server, for example, PSFT_HR.

To Configure PeopleCode by Using PeopleTools Application Designer

To configure the PeopleCode of your desired component:

1. Open PeopleTools Application Designer and log in to the PeopleSoft server.

2. Select File > Open to open the Open Definition dialog, and then select Message from 

the Definition drop-down list. Type the message name, such as CURRENCY_SYNC in the 

Name field and then click Open to open the Message Definition pane. 

3. Click the appropriate node under the Message Subscriptions node and then select 

View > View PeopleCode. 

4. When the PeopleCode Editor appears, leave the message name as is in the left hand 

side drop-down list and select the Subscription event from the right hand side 

drop-down list.

5. In the PeopleCode Editor, paste the following PeopleCode. If there are any existing 

lines of PeopleCode, you should comment them out first and then append the code 

given.

This PeopleCode will go into the Subscription event of the PeopleCode for the 

required Component.

Replace the record_name with the corresponding message name without any quotes.

Your service operation name has to be the same as your message name. For example, if 

your message name is CURRENCY_SYNC, your service operation name must also be 

CURRENCY_SYNC. 

Click the Handlers tab and make sure that only one handler is active.
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Local Message &MSG;

Local Rowset &LEVEL0;

Local Record &rLocation, &REC;

&MSG = GetMessage();

&rLocation = CreateRecord(Record.record_name);
&LEVEL0 = &MSG.GetRowset();

/* Multiple level 0 rows may exist in AE batch programs,

      but not with online panel processing... */

&REC = &LEVEL0(1).record_name;
&MSG.ExecuteEdits();

If &MSG.IsEditError Then

/*Specific error will be visible in App Msg Monitor */

MessageBox(0, "", 2, 0, "message is edited error");

Exit (1);

Else

   &AUDIT_ACTN = &MSG.GetRowset()(1).PSCAMA.AUDIT_ACTN.Value;

Evaluate &AUDIT_ACTN

   When = "U"

      /* Data from publishing node was changed */

      &REC.CopyFieldsTo(&rLocation);

      &RES = &rLocation.Update();

      /* If update failed, it is probably because the data in

         the two databases hasn't been synchronized.

         Try insert action as a last resort. */

      If &RES = False Then

         &rLocation.Insert();

      End-If;

      Break;

   When = "A"

      /* New high order key inserted in publishing node */

      &REC.CopyFieldsTo(&rLocation);

      &rLocation.Insert();

      Break;

   When = "D"

      /* High order key was deleted in publishing node */

      &REC.CopyFieldsTo(&rLocation);

      &rLocation.Delete();

      Break;

   End-Evaluate;

End-If;

6. Save the component definition. 

To Configure PeopleSoft Web Server

1. Modify the web.xml file located in PS_HOME\webserv\peoplesoft\applications\peoplesoft\PSIGW

\WEB-INF as following:
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<servlet>

<servlet-name>JMSListeningConnectorAdministrator</servlet-name>

<servlet-class>com.peoplesoft.pt.integrationgateway.listeningconnector.JMSListeningConnectorAdministrat

or </servlet-class>

</servlet>

<servlet-mapping>

<servlet-name>JMSListeningConnectorAdministrator</servlet-name>

<url-pattern>/JMSListeningConnectorAdministrator/*</url-pattern>

</servlet-mapping>

2. Restart PIA.

3. Stop/Start listening or subscribing the event from the JMS Queue or Topic, open your 

web browser and input the following URLs:

— To start listening or subscribing to events:

http://peoplesoft_server_name/PSIGW/JMSListeningConnectorAdministrator?Activity=START

— To stop listening or subscribing events:

http://peoplesoft_server_name/PSIGW/JMSListeningConnectorAdministrator?Activity=STOP

Request-Response Invocation Service

To Configure Integration Broker by Using PeopleTools

Select a transport type and follow these steps:

1. Load gateway connectors. See Load Gateway Connectors on page 29 for detailed 

information. 

a. If you want to use the HTTP transport type, you may use the default gateway 

TIB_LOCAL, and then add a connector entry HTTPTARGET to it. Click the Properties 

link for HTTPTARGET connector to open the Connector Properties pane and add 

the properties listed in Table 8 for the connector.

b. If you want to use the JMS transport type, you may use the default gateway 

TIB_LOCAL and then add a connector entry TIBCOTARGET to it. Click Properties of 

the TIBCOTARGET connector to open the Connector Properties pane and add the 

properties listed in Table 7 for the connector.

2. Configure the integration properties. See Task C, Configure Integration Gateway 

Properties, on page 32 for more information.
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If you want to use the JMS transport type, configure the following properties:

ig.jms.Queue#: Use this property only if you want to use Queue as the JMS 

Connection Factory for the adapter. This value should match the Subscriber 

Subject under the SubscriberOptions tab in TIBCO Designer.

ig.jms.Topic#: Use this property only if you want to use Topic as the JMS Connection 

Factory for the adapter. This value should match the Subscriber Subject under the 

SubscriberOptions tab in TIBCO Designer.

See SubscriberOptions Tab on page 124 for more details about configuring a 

connection factory for Request-Response Invocation Service in TIBCO Designer.

3. To define a node, enter the following Connection Properties. See Define Nodes on 

page 33 for more information.

a. If you want to use the HTTP transport type, modify the following properties:

HTTPPROPERTY: Specify the method as POST.

PRIMARYURL: Specify the URL for the HTTP Listening Connector of the 

adapter. For example, http://127.0.0.1:2002

b. If you want to use the JMS transport type, and define the TIBCOTARGET 

connector in step 1, modify the following properties for the connector:

JMSQueue: Use this property only if you want to use Queue as the JMS 

Connection Factory for the adapter. The value of JMSQueue in PIA should match 

the Subscriber Subject under the SubscriberOptions tab in TIBCO Designer.

JMSTopic: Use this property only if you want to use Topic as the JMS Connection 

Factory. The value of JMSTopic in PIA should match the Subscriber Subject under 

the SubscriberOptions tab in TIBCO Designer.

See SubscriberOptions Tab on page 124 for more details about configuring a 

connection factory for Request-Response Invocation Service in TIBCO Designer.

JMSUrl: Enter the URL for the TIBCO Enterprise Message Server (EMS). For 

example, tcp://192.168.66.145:7222

ServiceType: RPCCLIENT

4. To define a message, see Define Messages on page 35. You can define a new message 

or just use the pre-defined messages.

5. To define a service, see Define Services on page 38. You can define a new service for 

the message you defined in step 4 or just use the related service that PeopleSoft 

delivered.

The value of the Queue or Topic should already exist in the TIBCO Enterprise Message 

Service server.
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6. To define a service operation, see Define Service Operations on page 40. You can 

define a new service operation for the service you defined in step 5. 

Select Synchronous from the Operation Type drop-down list. Configure the handler 

of the service operation in the Handlers tab. 

7. To define a routing, see Define Routings on page 42. To configure routings, you need 

to correctly set the sender node and the receiver node. 

— Sender node: must be a local node in the PeopleSoft server, for example, PSFT_HR.

— Receiver node: must be a node you defined in step 3.

To Configure PeopleCode by Using PeopleTools Application Designer

To configure the PeopleCode of your desired component:

1. Open PeopleTools Application Designer and log in to the PeopleSoft server.

2. Select File > Open to open the Open Definition dialog, and then select Component 

from the Definition drop-down list. Type the component name, such as 

COUNTRY_TABLE in the Name field and then click Open.

3. With the component definition opened, select View > View PeopleCode.

4. In the displayed PeopleCode Editor, leave the component name as is in the left hand 

side drop-down list and select the SavePostChange event from the right hand side 

drop-down list. See Figure 20.

5. In the PeopleCode Editor, paste the following PeopleCode. If there are any existing 

lines of PeopleCode, you should comment them out first and then append the code 

given. 

Replace the service_operation_name with the corresponding message name without any 

quotes.

This PeopleCode will go into the SavePostChange event for the required component.

Local Message &msg;

Local Message &msg1;

Local Rowset &rowSet;

Local XmlDoc &xmlDoc;

Local string &xmlString;

Local XmlNode &rootNode;

Local XmlNode &actionNode;

&rowSet = GetLevel0();

&msg = CreateMessage(Operation.service_operation_name);
&msg1 = CreateMessage(Operation.service_operation_name);
&msg.CopyRowset(&rowSet);

&xmlString = &msg.GenXMLString();

&xmlDoc = CreateXmlDoc(&xmlString);

&rootNode = &xmlDoc.DocumentElement;
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&actionNode = &rootNode.FindNode("MsgData/Transaction/PSCAMA/AUDIT_ACTN");

&actionNode.NodeValue = %Mode;

&xmlString = &xmlDoc.GenXmlString();

&msg1.LoadXMLString(&xmlString);

MessageBox(0, "", 2, 0, &xmlString);

&response = %IntBroker.SyncRequest(&msg1);

If (&response.ResponseStatus = 0) Then

&XML_STRING = &response.GenXMLString();

&SUCCESS_FILE = GetFile("c:\temp\sync0.txt", "w", "a", %FilePath_Absolute);

&SUCCESS_FILE.WriteLine(&XML_STRING);

&SUCCESS_FILE.Close();

MessageBox(0, "", 2, 0, "success");

Else

MessageBox(0, "", 2, 0, "error");

End-If

6. Save the component definition.

Enabling SSL on the PeopleSoft Server

If you want to use SSL connection, you need to make the following configurations in 

addition to Procedure on page 27.

• Task A, Configuring TIBCOTARGET Connector, page 58

• Task B, Configure Integration Gateway Properties, page 59

• Task C, Define Node for SSL Connection, page 59

Before you make these configurations, you need to prepare TIBCO EMS Server and load 

the necessary library files to PeopleTools. See also: 

• "Chapter 18, Using the SSL Protocol" in TIBCO Enterprise Message Service User’s 

Guide

• Loading TIBCO Enterprise Message Service Libraries on page 16

If Request-Response Invocation Service succeeds, the text file will be generated and the 

response message appears in the file under the following directory specified in the above 

PeopleCode: c:\temp\sync0.txt. 
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Task A Configuring TIBCOTARGET Connector

Besides the connector properties in Table 7, TIBCOTARGET Connector Properties, on 

page 31, you need to add the properties in Table 11, TIBCOTARGET Connector SSL 

Properties to the TIBCOTARGET connector. The table refers to the EMS server as 

"server" and the PeopleSoft server as "client".

For more details, see "Configuring SSL in EMS Clients" in TIBCO Enterprise Message 

Service User’s Guide.

Table 11   TIBCOTARGET Connector SSL Properties

Property ID Property Name Value

TIBCOTARGET JMSUrl ssl://TIBCO_EMS_server_name:SSL_port 

For example, ssl://192.168.70.86:7243

TIBCOTARGET ssl_ciphers The cipher suites that the client uses.

For example, "+RC4-MD5:+RC4-SHA"

TIBCOTARGET ssl_expected_

hostname
The name the client expects in the CN field of the server’s certificate. For 

example, "server". If this parameter is not set, the expected name is the 

hostname of the server.

The value of this parameter is used when the ssl_verify_hostname parameter is 

enabled.

TIBCOTARGET ssl_identity The client’s digital certificate.

For example, "certs/client_identity.p12".

TIBCOTARGET ssl_issuer Issuer’s certificate chain for the client’s certificate.

For example, "certs/client_root.cert.pem".

TIBCOTARGET ssl_password The password used to encrypt the certificate files.

TIBCOTARGET ssl_trusted List of CA certificates to trust as issuers of server certificates. Supply only 

CA root certificates.

TIBCOTARGET ssl_vendor The vendor name of the SSL implementation that the client uses.

TIBCOTARGET ssl_verify_host Specifies whether the client should verify the EMS server’s certificate. The 

values for this parameter are enabled or disabled. By default, this parameter is 

enabled, signifying the client should verify the server’s certificate.

When disabled, the client establishes secure communication with the 

server, but does not verify the server’s identity.

TIBCOTARGET ssl_verify_

hostname
Specifies whether the client should verify the name in the CN field of the 

server’s certificate. The values for this parameter are enabled and disabled. 

By default, this parameter is enabled, signifying the client should verify the 

name of the connected host or the name specified in the 

ssl_expected_hostname parameter against the value in the server’s 

certificate. If the names do not match, the client rejects the connection.

When disabled, the client establishes secure communication with the 

server, but does not verify the server’s name.
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Task B Configure Integration Gateway Properties

Besides the properties described in Configure Integration Gateway Properties on page 32, 

you need to add the following SSL-specific properties to the specific queue or topic 

listener you defined in the JMS configuration section of integrationGateway.properties. 

• If you want to use the JMS transport type in Queue mode, the SSL-specific properties 

are following:

ig.jms.Queue#.Url=ssl://TIBCO_EMS_server_name:ssl_port
ig.jms.Queue#.SecurityPrincipal=security_principal
ig.jms.Queue#.SecurityCredentials=password_for_certificates

Use the supplied Password Encryption Utility to generate an encrypted password for 

ig.jms.Queue#.SecurityCredentials.

• If you want to use the JMS transport type in Topic mode, the SSL-specific properties 

are following:

ig.jms.Topic#.Url=ssl://TIBCO_EMS_server_name:ssl_port
ig.jms.Topic#.SecurityPrincipal=security_principal
ig.jms.Topic#.SecurityCredentials=password_for_certificates

Use the supplied Password Encryption Utility to generate an encrypted password for 

ig.jms.Topic#.SecurityCredentials.

Task C Define Node for SSL Connection

You need to define a separate node for SSL connection. To define a node, follow the steps 

in Define Nodes on page 33. Update the properties in the Connectors tab to match the 

SSL-specific properties you specified in Task A, Configuring TIBCOTARGET 

Connector, on page 58.
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Chapter 2 Working with TIBCO ActiveMatrix 

BusinessWorks

This chapter introduces how to create a project, define business processes, and execute the 

processes in TIBCO ActiveMatrix BusinessWorks.

Topics

• Overview, page 62

• Starting TIBCO Designer, page 63

• Creating a Project, page 64

• Configuring an Adapter Instance, page 66

• Creating a Process, page 67

• Testing the Process, page 70
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Overview

TIBCO ActiveMatrix BusinessWorks is a scalable, extensible, and easy to use integration 

platform that allows you to develop and test integration projects. TIBCO ActiveMatrix 

BusinessWorks includes a graphical user interface, TIBCO Design, for defining business 

processes and an engine that executes the process. 

TIBCO Designer is also used to configure TIBCO ActiveMatrix Adapter for PeopleSoft 

instances. See Chapter 4, Configuring an Adapter Instance, on page 79 for details.

In enterprise applications, you may need to manipulate different adapter services. TIBCO 

ActiveMatrix BusinessWorks facilitates your deployment and configuration process with 

easy drag, drop, and link operations for complex services transactions.

In TIBCO ActiveMatrix BusinessWorks, adapters provide services to activities inside the 

business process. The business process can communicate with adapters by using activities 

found in the adapter palette. These activities interact with each of the standard adapter 

services.

For more information about business processes and activities, see the TIBCO 

ActiveMatrix BusinessWorks documentation.
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Starting TIBCO Designer

To start TIBCO Designer, execute one of the following platform-specific commands to 

open the TIBCO Designer window. 

• On Microsoft Windows

From the Start menu, select All Programs > TIBCO > TIBCO Designer n.n > 

Designer n.n. 

or

From the command line, run TIBCO_HOME\designer\n.n\bin\designer.exe

• On UNIX

TIBCO_HOME/designer/n.n/bin/designer.sh

TIBCO Designer Interface

The TIBCO Designer window contains the following areas: Menu, Toolbar, Project Panel, 

Global Variables Panel, Tester Panel, Palettes Panel, Design Panel, and Configuration 

Panel, as shown in Figure 21. For detailed information, see Help > Designer Help. 

Figure 21   The TIBCO Designer Window
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Creating a Project

To create a project in TIBCO Designer, follow these steps:

1. Start TIBCO Designer.

2. Click the New empty project button in the TIBCO Designer dialog.

Figure 22   Create a Project

3. Select the Multi-File Project tab in the Save Project dialog. Click the Browse button 

to save the newly created project in the desired location or type the path in the Project 

Directory field. 

For example, type E:\workspace\ADPSFT_DEMO in the Project Directory field, as shown in 

Figure 23. 
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Figure 23   Save Project

4. Click the OK button to open the TIBCO Designer window. 
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Configuring an Adapter Instance

After creating a project in TIBCO Designer, you need to create an adapter instance and 

configure it to access the PeopleSoft application server. See Chapter 4, Configuring an 

Adapter Instance, on page 79 for details.
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Creating a Process

After creating the adapter instance, you may need to create a process to deal with 

workflow. 

For detailed information about creating and configuring a process, see TIBCO Designer 

User’s Guide. 

To create a process, follow these steps:

1. Select your project in the Project Panel. 

2. Expand the Process palette in the Palettes Panel and drag a Process Definition 

resource into the Design Panel on the right.

3. Double-click the Process Definition button in the Design Panel to open the 

ActiveEnterprise Adapter Palette under the Project Panel.

4. Drag one or more the following activities into the Process Definition Design Panel, 

and configure the activities under the Configuration Panel.

— Publish to Adapter, page 67

— Adapter Subscriber, page 68

— Adapter Request-Response Server, page 68

— Invoke an Adapter Request-Response Server, page 68

— Respond to Adapter Request, page 69

For detailed information about configuring the above activities, see the TIBCO 

ActiveMatrix BusinessWorks documentation. 

5. Click the Apply button to save the configuration.

Publish to Adapter

The Publish to Adapter activity publishes a message that can be received by an adapter 

subscription service. 

Subscription services are configured during the adapter configuration, and the activity 

uses the information configured in the adapter configuration to fill in most of the fields of 

this activity. 

Make sure you have added services into the adapter instance before configuring a process. 
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CI Subscription Service and Message Subscription Service are two subscription services 

available in TIBCO ActiveMatrix Adapter for PeopleSoft. See Adding and Configuring a 

PeopleSoft Adapter Service on page 75 for detailed information.

Adapter Subscriber

The Adapter Subscriber activity starts a process based on the receipt of a message from 

the publication service of the specified adapter. 

Publication services are configured during adapter configuration, and the activity uses the 

information configured in the adapter configuration to fill in most of the fields of this 

activity.

CI Publication Service and Message Publication Service are the two publication services 

available in TIBCO ActiveMatrix Adapter for PeopleSoft. See Adding and Configuring a 

PeopleSoft Adapter Service on page 75 for detailed information.

Adapter Request-Response Server

The Adapter Request-Response Server starts a process based on the receipt of a request 

from an adapter. The adapter sends a request using a preconfigured request-response 

invocation service, and the process that is started acts as the implementation of the 

request. The process sends any required responses back to the adapter service using the 

Respond to Adapter Request activity. 

Adapter request-response invocation services are configured during adapter configuration, 

and the activity uses the information configured in the adapter configuration to fill in most 

of the fields of this activity.

Request-Response Invocation Service is available in TIBCO ActiveMatrix Adapter for 

PeopleSoft. See Adding and Configuring a PeopleSoft Adapter Service on page 75 for 

detailed information.

Invoke an Adapter Request-Response Server

The Invoke an Adapter Request-Response Service activity is used to communicate with an 

adapter request-response service. This service invokes an operation with input and output 

by way of the adapter. 

Request-response services are configured during adapter configuration, and the activity 

uses the information configured in the adapter configuration to fill in most of the fields of 

this activity. 

Request-Response Service is available in TIBCO ActiveMatrix Adapter for PeopleSoft. 

See Adding and Configuring a PeopleSoft Adapter Service on page 75 for detailed 

information.
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Respond to Adapter Request

The Respond to Adapter Request activity is used to send a response to an adapter for a 

previously received request. For example, you may have a Wait for Adapter Request 

activity in a process definition. The incoming adapter request may require a response from 

your process. The Respond to Adapter Request is used to send that response. 
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Testing the Process

After creating and configuring a process, you can test it with TIBCO Designer. This 

allows you to make sure the process works correctly before you deploy it.

See TIBCO BusinessWorks Process Design Guide for detailed information about using test 

mode.
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Chapter 3 Getting Started

This chapter describes the basic steps to configure and run TIBCO ActiveMatrix Adapter 

for PeopleSoft. Details for each step described here are provided later in the manual.

Topics

• Prerequisites, page 72 

• Configuring an Adapter Instance, page 73 

• Adding and Configuring a PeopleSoft Adapter Service, page 75 

• Starting the Adapter, page 76 
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Prerequisites

Before starting the configuration, ensure that all required software has been installed and 

is operating correctly. For detailed information about required software, see TIBCO 

ActiveMatrix Adapter for PeopleSoft Installation. 

You should know how to drag and drop icons in TIBCO Designer and be familiar with 

saving projects. If you are not familiar with these topics, see the documentation for 

TIBCO Designer, which can be accessed from the Help > Designer Help menu option in 

TIBCO Designer.

If your installation is standalone, verify that a repository server is up and running (see the 

TIBCO Designer Help menu: Help > Help For > Repository).

See Chapter 1, Preparing PeopleSoft, on page 1 for information about preparing the 

PeopleSoft application to work with the adapter.
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Configuring an Adapter Instance

Each project contains one or more instances of the adapter configuration. This 

configuration is accessed whenever an adapter application is started.

A typical sequence of creating a project and configuring an adapter instance is as follows:

1. Starting TIBCO Designer, page 73

2. Creating a Project, page 73

3. Creating and Configuring a PeopleSoft Adapter Configuration, page 74

Starting TIBCO Designer

To start TIBCO Designer, execute one of the following platform-specific commands to 

open the TIBCO Designer window. 

• On Microsoft Windows

From the Start menu, select All Programs > TIBCO > TIBCO Designer n.n > 

Designer n.n. 

or

From the command line, run TIBCO_HOME\designer\n.n\bin\designer.exe

• On UNIX

TIBCO_HOME/designer/n.n/bin/designer.sh

For detailed information about starting TIBCO Designer, see Starting TIBCO Designer on 

page 63.

Creating a Project

To create a project in TIBCO Designer, follow these steps:

1. Start TIBCO Designer.

2. Click the New empty project button in the TIBCO Designer dialog.

3. Select the Multi-File Project tab (if it is not already selected) in the Save Project 

dialog. Type E:\workspace\ADPSFT_DEMO in the Project Directory field. 

4. Click the OK button to open the TIBCO Designer window. 

For detailed information about creating a new project, see Creating a Project on page 64. 
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Creating and Configuring a PeopleSoft Adapter Configuration

To create and configure a PeopleSoft adapter configuration, follow these steps:

1. Click to open the ADPSFT_DEMO project in the Project Panel. 

2. Expand the PeopleSoft Adapter palette in the Palettes Panel, and drag the PeopleSoft 

Adapter Configuration icon to the Design Panel on the right.

3. Click the PeopleSoftAdapterConfiguration icon in the Design Panel. The 

PeopleSoft Adapter Configuration Panel appears. 

In the Configuration tab:

— Specify the instance name. The default name is PeopleSoftAdapterConfiguration.

— Specify the PeopleTools version as 8.41 and above.

— Click the Apply button to save your configuration.

In the Design-Time Connection tab:

— Specify the necessary information to access the PeopleSoft system.The login ID 

and password you specify are PeopleSoft, not TIBCO.

— Specify the necessary information to connect to the PeopleSoft Application Server 

from where the Component Interfaces are downloaded. Port must specify the JOLT 

listener port, not the application server port.

— Click the Connect... button. This opens communication between TIBCO Designer 

and the PeopleSoft Application Server. When the connection is successful message 

appears, click the OK button.

— Click the Apply button to save your configuration.

4. Save your project. 

For detailed information about creating and configuring a PeopleSoft Adapter 

Configuration, see Configuring an Adapter Instance on page 82. 

If the PeopleSoft Adapter palette does not appear in the Palette Panel, Select Palettes > 

Adapters > PeopleSoft Adapter from the Menu.
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Adding and Configuring a PeopleSoft Adapter Service

After creating a PeopleSoft Adapter Configuration, add and configure the adapter services 

in the adapter. 

The following six adapter services can be added:

• CI Publication Service, page 96

• Message Publication Service, page 103

• CI Subscription Service, page 108

• Message Subscription Service, page 112

• Request-Response Service, page 117

• Request-Response Invocation Service, page 122

For detailed information about adding and configuring a PeopleSoft adapter service, see 

Chapter 5, Configuring Adapter Services, on page 93. 

To add and configure a CI Publication Service, follow these steps:

1. In the Project Panel, expand the adapter instance folder which is, by default, 

PeopleSoftAdapterConfiguration.

2. Click Adapter Services in the project panel.

3. Drag a CI Publication Service icon to the Design Panel.

4. Specify options in the Configuration tab. See Configuration Options on page 96 for 

more information.

— Specify the Component Interface Name and click Fetch Interface... . This returns a list 

of the available Component Interfaces from PeopleSoft with a matching name. 

Choose the Component Interface.

— Click the Apply button. This generates a unique endpoint with a TIBCO 

Rendezvous subject name. The adapter automatically enters this information in the 

Advanced tab.

— Click the Get Schema button. This downloads the Component Interface schema 

from PeopleSoft to TIBCO Designer.

— Click the Save to PeopleSoft button. This will save the details required in the 

PeopleSoft database to trigger the Publication Service.

5. Save your project.

Rendezvous is selected as the default Transport Type. If you select JMS as the Transport Type, a 

unique endpoint with the destination name will be generated.
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Starting the Adapter

After configuring the adapter with Publication, Subscription and Request-Response 

Services, you can start the adapter.

This section describes three ways to start the adapter:

• Starting the Adapter with the Adapter Tester, page 76

• Starting the Adapter from the Command line with a Repository File, page 76

You can also deploy the adapter with TIBCO Administrator. For more information, see 

Chapter 6, Deploying and Starting an Adapter Using TIBCO Administrator, on page 131.

Starting the Adapter with the Adapter Tester

To start the adapter with the Adapter Tester, the adapter and TIBCO Designer must be 

installed on the same machine.

1. Start TIBCO Designer.

2. Select Tools > Show Adapter Tester on the Menu

3. In the left pane, select the adapter instance that you want to start.

4. Click the Run Settings tab. In the Working Directory field, enter a directory to place 

running files.

5. In the Adapter Executable field, select the executable. For example, TIBCO Adapter for 

PeopleSoft 6.1 (adpsft8.exe).

6. Click the Apply button.

7. Click the Start button. To view the output messages, click the Console tab.

Starting the Adapter from the Command line with a Repository File

To start the adapter from the command line with a repository file, the project must be run 

as a local repository and saved in DAT (repository) format.

Task A Convert the Project to a Repository File

To export the project to a local repository:

1. Start TIBCO Designer.

2. Select Project > Export Full Project... on the Menu. The Export Project dialog 

appears. 
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3. Click the Local Repository tab and enter the project name and the output directory in 

the Export Project dialog. Click the OK button.

4. In the Create Project dialog, select File Type and TIBCO Messaging Encoding. Click 

the Yes button.

Task B Start the Adapter

The adapter can be run by specifying the path of the DAT file in the repo URL, in the 

properties file or TIBCO Runtime Agent.

1. At the command prompt, go to the PS_HOME\bin directory, which hosts the adapter 

executable.

2. Enter the following command to start the adapter:

adpsft8.exe -system:repourl repository_file_url -system:configurl configuration_url

For example,

adpsft8.exe -system:repourl D:\example\pub.dat

-system:configurl PeopleSoftAdapterConfiguration
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Chapter 4 Configuring an Adapter Instance

This chapter explains how to create and configure an adapter instance. All the tasks are 

performed using TIBCO Designer

Topicsc

• Creating an Adapter Instance, page 80

• Configuring an Adapter Instance, page 82

• Saving the Project, page 90

• Testing the Adapter, page 91
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Creating an Adapter Instance

After creating a project in TIBCO Designer, you need to create an adapter instance and 

configure it to access the PeopleSoft application server.

For detailed information about creating a project in TIBCO Designer, see Creating a 

Project on page 64.

To create an adapter instance, follow these steps:

1. Click to open the newly created project in the Project Panel. 

2. Expand the PeopleSoft Adapter palette in the Palettes Panel, and drag the PeopleSoft 

Adapter Configuration icon to the Design Panel on the right, as shown in Figure 24.

Figure 24   Create a PeopleSoft Adapter Configuration

3. Click the PeopleSoftAdapterConfiguration icon in the Design Panel. The 

PeopleSoft Adapter Configuration Panel appears. 

If the PeopleSoft Adapter palette does not appear in the Palette Panel, Select Palettes > 

Adapters > PeopleSoft Adapter from the Menu.
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4. Click the Save button to save your project. 
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Configuring an Adapter Instance

Configure an adapter instance in the following tabs in the Configuration Panel:

• Configuration Tab, page 82

• Design-time Connection Tab, page 83

• Runtime Connection Tab, page 84

• Adapter Services Tab, page 85

• General Tab, page 86

• Logging Tab, page 86

• Startup Tab, page 88

• Monitoring Tab, page 88

Configuration Tab

The Configuration tab contains the following fields, as shown in Table 12.

Table 12   Configuration Tab

Field Description

Instance Name The name of the adapter instance.

Use the default name or replace it with a name of your choice. 

See Guidelines for Choosing an Instance Name on page 83 for more information. 

Description (Optional) A short description of the adapter instance.

Version The version string indicates the ActiveEnterprise (AE) format in which the adapter instance is saved. 

When a new adapter instance is created in TIBCO Designer 5.x, the version string is set to AE Version 

5.1. 

To change versions, click the Change Version... button. An adapter instance can be saved in 
AE 4.0 or AE 5.0 format.

Message Filter Specify a message filter, if you have configured a message filter resource for use with the adapter. 

The filter allows you to manipulate incoming and outgoing data before sending it on the network or 

handing it to the target application. Filters can be written using the TIBCO Adapter SDK. See 

TIBCO Adapter SDK Programmer’s Guide for information about writing a message filter.

Show All Tabs Select this checkbox to display the Adapter Services tab and General tab for advanced options 

configuration.
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Guidelines for Choosing an Instance Name

• An instance name must use alphanumeric characters. An underscore (_) character can 

be used. The entire instance name must be less than 80 characters. The space character 

cannot be used in an instance name. 

• An instance name cannot use global variables.

• An instance name must be unique with respect to other adapter instances for the same 

adapter in the project. The same instance name can be used to name an adapter 

instance for a different adapter in the same project. For example, a PeopleSoft adapter 

instance named TEST and a Siebel adapter instance named TEST can coexist in the same 

project.

• Each instance name must be unique per adapter within a project even if each instance 

is defined in a different folder. That is, configuring same-named adapter instances in 

different folders will not make their names unique.

When you create an adapter instance, the palette automatically creates several resources 

for it. The names of these resources derive from the name of the instance they belong to. 

Changing the adapter instance name results in an automatic regeneration of the resources 

names. If you manually modify any resource name, that particular name will not be 

automatically regenerated next time your rename the adapter instance.

Design-time Connection Tab

Many of the fields listed in Table 13 make use of global variables. Click the Global 

Variables tab in the project panel to enter a value for a global variable.

PeopleTools 

Version

From the drop-down list, select the version of PeopleTools that you will use.

Table 12   Configuration Tab (Cont’d)

Field Description

Table 13   Design-time Configuration Tab

Field Description

Application Server Name The host name or IP address of the machine that hosts the PeopleSoft 

Application Server.

Port The port number that the PeopleSoft Application Server is configured to.

Note: this is the JOLT Listener port (the default is 9000) not the 

Workstation Listener port (default is 7000).
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Connect... Button

The Connect... button allows you to test whether the specified configuration fields result 

in a valid connection to the PeopleSoft Application Server.

Runtime Connection Tab

If you have checked the Use Design-Time Connection For Runtime checkbox in the 

Design-time Connection tab, most options in the Runtime Connection tab will inherit the 

design-time configuration and cannot be changed.

Login The username used to log in to the PeopleSoft Application Server.

Password The password associated with the username that is used to log in to the 

PeopleSoft Application Server.

Remember Password If this checkbox is not checked (by default), the password must be entered 

each time the project is opened. If it is checked, the password will be 

stored in the project repository.

Use Design-time Connection For 

Runtime

If this checkbox is checked (by default), all values specified in the 

Design-time Connections tab apply to runtime connections. If it is 

checked, you can enter different runtime connection parameters.

DTA Transport Select the transport to be used by the design-time adapter, JMS or 

Rendezvous.

Table 13   Design-time Configuration Tab (Cont’d)

Field Description

Table 14   Runtime Connection Tab

Field Description

Application Server Name The host name or IP address of the machine that hosts the PeopleSoft 

Application Server.

Port The port number that the PeopleSoft Application Server is configured to.

Note: this is the JOLT Listener port (the default is 9000) not the 

Workstation Listener port (default is 7000).

Login The username used to log in to the PeopleSoft Application Server.

Password The password associated with the username that is used to log in to the 

PeopleSoft Application Server.
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Adapter Services Tab

This tab is visible only when you check the Show All Tabs checkbox in the Configuration 

tab.

Specify common parameters to one or more types of services. 

For detailed information about creating and configuring adapter services, see Chapter 5, 

Configuring Adapter Services, on page 93.

Maximum Number of Reconnect 

Attempts

Specify the total number of reconnection attempts to make before the 
runtime adapter or adapter service is stopped. A value of -1 means 
reconnection attempts will continue indefinitely. 

Number of Reconnect Attempts 

Before Suspending Impacted 

Service(s)

Specify the number of reconnection attempts to make before suspending 
a runtime adapter or adapter service. The value of the Adapter Termination 

Criteria field determines whether the adapter or an adapter service is 
stopped.

Interval between Reconnect Attempts 

(milliseconds)

Specify the time interval in milliseconds to elapse between each reconnection 

attempt. 

Adapter Termination Criteria (after 

max number of reconnect attempts

This field is disabled.

Table 14   Runtime Connection Tab (Cont’d)

Field Description

Table 15   Adapter Services Tab

Field Description

Publisher Polling 

Interval

This parameter determines how often the adapter will read from its queue table (TIB_CI_MQUEUE). 

The default setting is 5000 milliseconds (5 seconds)

Note: This field is applicable only for the CI Publication Service.



TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

86 | Chapter 4  Configuring an Adapter Instance

General Tab

This tab is visible only when you check the Show All Tabs checkbox in the Configuration 

tab.

Logging Tab

The Logging tab specify the output destination (sinks) for the trace messages and set the 

tracing level for the roles selected.

Table 16   General Tab

Field Description

Termination Subject or Topic A message sent on the termination subject (if Rendezvous is the transport) or topic (if JMS 

is the transport) stops the adapter. In most cases, you should use the default value. 

See TIBCO Rendezvous Concepts for information about specifying subject names. See 

the TIBCO Enterprise Message Service User’s Guide for information about publishing 

on a topic.

Number of Threads The number of connections to be opened with the PeopleSoft application server by the 

adapter.

Table 17   Logging Tab

Field Description

Use Advanced Logging If the checkbox is not checked (by default), you can set two standard output 
destinations (sinks) for trace messages and set the tracing level for the roles 
selected.

If the checkbox is checked, you have complete control on selecting the destinations 
and associating desired roles with each of the destinations.

To create and configure sinks, see Guildline for Creating and Configuring the Sinks on 

page 87. 

Log to Standard I/O (STDIO Sink) If the checkbox is checked, trace messages are displayed in the command 

prompt window where the adapter is started. If the checkbox is not checked, trace messages 

do not display in the window.

Log File Specify the name of the log file (log sink) to which trace messages are written. 

Global variables can be used to specify the location of the log file. See Using 

Global Variables on page 144 for more information. 

The roles available are Info, Debug, Warning, and Error messages. The trace message 

generated depends on the roles selected. Turning on the roles can affect the performance of 

the adapter. Therefore, it is recommended that you turn on the required roles only.
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Guildline for Creating and Configuring the Sinks

To create and configure the sinks, follow these steps:

1. Check the Use Advanced Logging checkbox in the Logging Tab. 

2. Expand ProjectName > PeopleSoftAdapterConfiguration > Advanced > Log Sinks in the 

Project Panel.

3. Drag the Generic Log Sink palette from the Palettes panel to the Design panel, and 

then select a Sink Type in the Configuration tab. Click the Apply button. For detailed 

information about Sink Types, see Sink Types on page 87.

4. For all the sinks, optionally the name and description can be provided.

5. Select a sink displayed in the Design Panel and configure it in the Configuration 

Panel. There are two predefined sinks in the adapter instance, fileSink and stdioSink.

Sink Types

There are four sink types available: File, Hawk, Network, and STDIO. Each of them has certain 

configuration options:

• For the File sink, the file limit, file count, and the option to append or overwrite can be 

specified. When created by default, this is set to 30000 bytes, 3 and append mode 

respectively. 

• For the STDIO sink, the option to write to stdout or stderr can be selected. When created 

by default,  stdout is selected. 

• The Hawk sink uses the hawk session, created and used by the adapter for monitoring 

purposes, to send tracing messages to the TIBCO Hawk monitor or Display.

Log Info Messages The roles available are Info, Debug, Warning, and Error messages. The trace 

message generated depends on the roles selected. Turning on the roles can affect 

the performance of the adapter. Therefore, it is recommended that you turn on the 

required roles only.

Trace messages of the selected level(s) will be collected in the named log sink. You can 

configure what levels of trace messages you want logged, and where trace messages are 

sent. There are three types of logs (log sinks) that you can configure to hold trace messages, 

corresponding to three levels (roles) of trace messages, Information, Warning and Error. A 

fourth level of trace messages, Debug, is reserved and should not be enabled unless 

requested by the TIBCO Product Support Group. This option writes a lot of information to 

the log file and significantly reduces the speed of the adapter.

Log Debug Messages

Log Warning Messages

Log Error Messages

Table 17   Logging Tab (Cont’d)

Field Description
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• For details on Hawk sessions, see Using Global Variables on page 144. The 

configuration for the Hawk sink involves specifying the MicroAgent Name that must be 

specified in the configuration panel. 

• The Network sink is used to publish tracing message on TIBCO Rendezvous. The 

configuration for the network sink involves specifying the session, and the subject on 

which the trace messages needs to be published. 

Startup Tab

The Startup tab contains the following fields, as shown in Table 18.

Monitoring Tab

Many of the fields listed in the Monitoring tab make use of global variables. Click the 

Global Variables tab in the project panel to enter a value for a global variable.

Table 18   Startup Tab

Field Description

Show Startup 

Banner

If the checkbox is checked (by default), the startup banner displays the runtime adapter version, the 

infrastructure version on which the adapter is built, and copyright information in the console 

window when the adapter is started.

The content of the start banner is predefined and cannot be changed.

Metadata Search 

URL

Specifies the location where the adapter searches for base schemas. The adapter searches for any 

schema that has been defined and saved at this location, and that should be loaded at startup. 

This field is predefined and cannot be changed. 

Table 19   Monitoring Tab

Field Description

Enable Standard 

Microagent

Allows you to turn on or off the standard TIBCO Hawk Microagent. 

Clicking the Globe icon, you can switch the way of configuration between a standard checkbox and 

text value (true or false). 

Standard 

Microagent Name

The name for the standard microagent that will be registered with the TIBCO Hawk system. 

In most cases the default value is used. The InstanceId variable need not be set because it is 

automatically set at runtime by the runtime adapter.

Standard 

MicroAgent 

Timeout (ms)

The timeout value for the standard microagent in milliseconds. 

The default value is 10000. 
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Enable Standard 

Microagent

Allows you to turn on or off the standard TIBCO Hawk Microagent. 

Clicking the Globe icon, you can switch the way of configuration between a standard checkbox and 

text value (true or false). 

Class Microagent 

Name

The name for the class microagent that will be registered with the TIBCO Hawk system. 

In most cases the default value is used. 

Class MicroAgent 

Timeout (ms)

The timeout value for the class microagent in milliseconds.

The default value is 10000.

Default 

Microagent 

Session 

Specify the name of the TIBCO Rendezvous session that will be used by the standard, class, and 

custom microagents. 

The session name and the corresponding session are automatically generated by TIBCO Designer. 

Do not change the session name or the session. However, you can modify the session parameters if 

required. Navigate to the Sessions folder under the Advanced folder to modify the session parameters. 

Make sure you have set the correct parameter value for the global variables that correspond to the 

TIBCO Hawk configuration. If the session parameters are not set properly, the microagents will not 

display in TIBCO Hawk Display.

For a list of all supported microagents, see Chapter 8, Monitoring the Adapter Using TIBCO Hawk, 

on page 163.

Table 19   Monitoring Tab (Cont’d)

Field Description
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Saving the Project

Adapter configuration information and all other parameter settings related to the adapter 

configuration are saved in a TIBCO Designer project. You can save the project that 

represents it, at any time while configuring the adapter. Each time you save a project, any 

configuration information you have entered is saved as a repository instance.

For the saving procedure and more information about the repository choices, see TIBCO 

Designer User’s Guide.
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Testing the Adapter

Before testing the adapter, see Chapter 1, Preparing PeopleSoft, page 1 to set up the 

PeopleSoft environment. To test the adapter, start it after configuring and check for correct 

messaging. In this method, you can configure the adapter as required, then start it. If your 

preparations and configurations are successful, the adapter will connect to PeopleSoft and 

messaging will indicate no errors.



TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

92 | Chapter 4  Configuring an Adapter Instance



 TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

| 93

Chapter 5 Configuring Adapter Services

This chapter explains how to create and configure adapter services for an adapter instance. 

All the tasks are performed using TIBCO Designer. 

Topics

• Creating an Adapter Service, page 94

• CI Publication Service, page 96

• Message Publication Service, page 102

• CI Subscription Service, page 107

• Message Subscription Service, page 111

• Request-Response Service, page 116

• Request-Response Invocation Service, page 121

• Common Configuration Options for Adapter Services, page 126
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Creating an Adapter Service

After configuring an adapter instance, create one or multiple adapter services for it. For 

detailed information about configuring an adapter instance, see Chapter 4, Configuring an 

Adapter Instance, on page 79.

To create an adapter service, follow these steps:

1. Expand ProjectName > PeopleSoftAdapterConfiguration in the Project Panel, and then 

click the Adapter Services folder. All the available services for the adapter appears in 

the Palettes Panel, as shown in Figure 25.

Figure 25   Available Adapter Services shown in TIBCO Designer

2. Drag a service icon in the Palettes Panel to the Design Panel.

If you cannot see the Project Panel and the palettes Panel in the same TIBCO Designer 

window, select Edit > Preferences on the Menu to open the TIBCO Designer Preferences 

dialog. Under the View tab, click the Use tabs radio button in the Layout pane. 
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3. Specify configuration options for the created service in the Configuration Panel. 

— CI Publication Service, page 96

— Message Publication Service, page 102

— CI Subscription Service, page 107

— Message Subscription Service, page 111

— Request-Response Service, page 116

— Request-Response Invocation Service, page 121

4. Click the Save button to save your configuration. 
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CI Publication Service

When running as a CI Publication Service, the adapter uses PeopleCode embedded in a 

TIBCO page to persist data entered by PeopleSoft users into a queue table. The runtime CI 

Publication Service polls that queue table. If an unprocessed event is found, it sends the 

message out to the TIBCO environment and stamps the queue entry as processed.

• Configuration Options, page 96

• Configuration Task Sequence, page 100

Configuration Options

Configure a CI Publication Service under the following tabs in the Configuration Panel. 

• Configuration Tab, page 96

• Schema Tab on page 98

• Advanced Tab on page 99

Configuration Tab

The Configuration tab contains the following fields:

For a CI Publication Service to work, a shadow page (formerly “panel”) named 

TIB_CI_ADAPTER_WRK must be embedded in any component that will be published. For 

instructions on how to do this, see CI Publication Service on page 23.

Table 20   CI Publication Service Configuration - Configuration Tab (Sheet 1 of 2)

Field Description

Name The name of the Component Interface stored in the PeopleSoft database. It matches the 
Component Interface Name and is automatically filled in by TIBCO Designer.

Component Interface 

Name

TIBCO Designer automatically supplies this name when you click the Fetch Interface… 

button and select a Component Interface. When starting the adapter, it uses this name to find 

the Component Interface in PeopleSoft. You can enter a partial string in this field to filter the 

Component Interfaces that are presented in the drop-down list when you click the Fetch 

Interface… button.

For example, entering p would narrow the drop-down list to only Component Interface names 

beginning with p.
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Publish On: This field determines which PeopleSoft modes will cause a Publish to occur.

Note: After saving the configuration settings to the PeopleSoft database if you modify 
the Publish on settings, you must once again click the Apply button, and then click the 
Get Schema button, and finally click the Save To PeopleSoft button.

Add Add mode allows the input of new records, for example a new PRODUCT.

Update Update mode is used to view current data and modify future data.

Update 

All

Update all is used to view history, current and future data but only modify future data.

Correctio

n

Correction is used to view history, current and future data, and correct all records.

Publish Current Record Check this checkbox to publish the current record (for Effective Dated records only).

Note: The adapter will consider a record as Effective Dated if the effective date field in that 

record starts with EFFDT.

Transport Type The transport to be used by the runtime adapter, JMS or Rendezvous. See Transport Type on 

page 126 for details.

JMS

JMS Compress Available only for the JMS transport. It can be Uncompressed or Compressed. See Compressing 

JMS Messages on page 161 for details.

Connection Factory 

Type

Available only for the JMS transport. It can be Topic or Queue. See Connection Factory Type on 

page 128 for details.

Delivery Mode Available only for the JMS transport. It can be Persistent or Non-Persistent. See Delivery Mode on 

page 128 for details.

Wire Format Services must use the same wire format to exchange data. It is XML Message. See Wire Format 

on page 127 for details.

Rendezvous

Quality of Service Available only for the Rendezvous transport. It can be Certified or Reliable. Reform to Quality of 

Service on page 126 for details.

Wire Format Services must use the same wire format to exchange data. It can be XML Message or 

ActiveEnterprise Message. See Wire Format on page 127 for details.

Table 20   CI Publication Service Configuration - Configuration Tab (Sheet 2 of 2)

Field Description
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Save To PeopleSoft

Click the Save To PeopleSoft button to save the configuration to the PeopleSoft 

application server.

Get Schema

Click the Get Schema button to list the fields of the fetched schema in the Schema Tab.

If you have changed any configuration, either on the service level or on the instance level, 

click the Get Schema button to ensure that the modification is reflected in the service at 

runtime.

Schema Tab

In the Schema tab you can view all elements but change only the trigger and runtime input 

settings, as shown in Figure 26.

Figure 26   CI Publication Service - Schema Tab

To view schema elements, click on the folders to expand them. It is not necessary to click 

the Apply button.

To change the trigger setting, follow these steps:

1. Expand the PROPERTIES folder until the Trigger column is populated.

2. Check or uncheck the Trigger checkbox required. If checked, an update to this field 

will trigger a publish.

If a copied instance containing a CI Publication Service is used with different connection 

parameters, ensure that the Save To PeopleSoft button is clicked after changing the 

parameters.
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3. Check or uncheck the Runtime Input checkbox. If checked, this field will be 

included in the runtime input.

4. Click the Apply button, and then click the Save To PeopleSoft button in the 

Configuration tab. 

The Schema tab contains the following fields:

Advanced Tab

The Advanced tab contains the following fields:

Table 21   CI Publication Service Configuration - Schema Tab

Field Description

Name This column shows a field name if the schema attribute is a field or the record name if the schema 

attribute is a record. You can expand folders in this column to display triggers for PROPERTIES 

fields. When the adapter publishes data, the governing schema puts data only in the PROPERTIES 

node.

Field Type This column applies only if a field is shown. 

Note: The values are TIBCO field-types and not PeopleSoft field-types.

Trigger? This column indicates whether a change in the field will cause PeopleCode to store an entry into the 

queue table. By default, a trigger is enabled for all fields so that a change in any field will trigger an 

event. To disable the trigger for a field, uncheck the checkbox.

Key? This column indicates whether the field is a key in a PeopleSoft database. 

Note: The values are TIBCO field-types and not PeopleSoft field-types.

Runtime Input This column indicates whether the field will be included in the runtime input.

Note: The key fields are always included in the runtime input.

Table 22   CI Publication Service Configuration - Advanced Tab

Field Description

Destination Available only for the JMS transport.

By default, a dynamic destination is generated using the Domain and Deployment global variables, the 

adapter acronym, the adapter instance name, and the service name.

If you use this default dynamic destination, ensure that the values for Domain and Deployment are not 

empty. You can override the default dynamic destination by specifying the static destination in this 

field. The static destination must be defined on the EMS server before it can be used by the runtime 

adapter. See the TIBCO Enterprise Message Service User’s Guide for information about 

destinations.
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Configuration Task Sequence

To configure a CI Publication Service, follow these steps:

1. In the Project Panel, expand the adapter instance folder (by default, 

PeopleSoftAdapterConfiguration).

2. Click Adapter Services in the project panel.

3. Drag a CI Publication Service icon to the Design Panel.

4. Specify options in the Configuration tab. See Configuration Options on page 96 for 

more information.

5. Click the Apply button. This generates a unique endpoint with a TIBCO Rendezvous 

subject name. The adapter automatically enters this information in the Advanced tab.

6. Enter the name for the Component Interface and click the fetch interface button to 

fetch the component interface.

7. Click the Get Schema button. This downloads the Component Interface schema from 

PeopleSoft to TIBCO Designer.

8. Click the Save to PeopleSoft button. This will save the details required in the 

PeopleSoft database to trigger the Publication Service.

9. Save your project. 

Message Subject Available only for the Rendezvous transport.

By default, a service uses a message subject that is generated using the Domain and 
Deployment global variables, the adapter acronym, the adapter instance name and the service 
name. If you use this default subject, make sure the values for Domain and Deployment are not 
empty. You can type a TIBCO Rendezvous subject name different from the default in this 
field. See TIBCO Rendezvous Concepts for information about specifying subject names. 

Endpoint 

Reference

The location in TIBCO Repository where the endpoint information will be stored (default).

Endpoints store information such as message subject, endpoint type, and startup state.

Schema Reference A link to a location for the defined PeopleSoft adapter schema.

Table 22   CI Publication Service Configuration - Advanced Tab

Field Description

Rendezvous is selected as the default Transport Type. If you select JMS as the Transport Type, a 

unique endpoint with the destination name will be generated.
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When a publication service is deleted, the corresponding entry in the PeopleSoft database 

is not automatically deleted. You must delete the entry in the PeopleSoft database using 

the SQL script that is generated in the following location:

TIBCO_HOME\adapter\adpsft8\version_number\scripts

On deleting a Publication Service do the following in the PeopleSoft system:

• Detach the Work Panel for the Component Interface associated with the Publication 

Service instance.

• Locate the SQL script in the scripts directory and run it to delete the entry in the 

PeopleSoft database. The name of the script file is Component Interface Name_Adapter 

Configuration Name.sql. For example, if an adapter configuration called pub, created for 

the Component Interface ACTIVITY, is deleted, the .sql file generated will be named 

ACTIVITY_pub.sql.

In a scenario where two Publication Services are associated with the same Component 

Interface, for example Publication Services A and B, which are both associated with 

ACTIVITY CI. If you delete Publication Service A, do not detach the Work Panel for the 

ACTIVITY CI. Detaching the Work Panel in this scenario will disable Publication Service 

B as well.
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Message Publication Service

When running as a Message Publication Service, the adapter uses PeopleCode provided 

with the adapter to capture data from PeopleSoft into a PeopleSoft message and send it 

over HTTP or JMS to the adapter. The runtime Message Publication Service receives the 

message, processes it and publishes it out to the TIBCO environment. It then sends back 

an acknowledgement to the PeopleSoft system.

For the Message Publication service to work, the PeopleCode provided with the 

installation needs to be copied in the SavePostChange event of the component from which the 

data has to be published out.

• Configuration Options, page 102

• Configuration Task Sequence, page 105

Configuration Options

Configure a Message Publication Service under the following tabs in the Configuration 

Panel. 

• Configuration Tab, page 102

• Schema Tab, page 103

• SubscriberOptions Tab, page 104

• Advanced Tab, page 105

Configuration Tab

The Configuration tab contains the following fields:

Table 23   Message Publication Service Configuration - Configuration Tab

Field Description

Name The name of the Message stored in the PeopleSoft database. It matches the Message Name 
and is automatically filled in by TIBCO Designer.

Message Name TIBCO Designer automatically supplies this name when you click the Fetch Message button 

and select a Message. When starting the adapter, it uses this name to find the Message in 

PeopleSoft. You can enter a partial string in this field to filter the Messages that are presented 

in the drop-down list when you click the Fetch Message button.

For example, entering p would narrow the drop-down list to only Message names beginning 

with p.
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Get Schema

Click the Get Schema button to list the fields of the fetched schema in the Schema Tab.

If you have changed any configuration, either on the service level or on the instance level, 

click the Get Schema button to ensure that the modification is reflected in the service at 

runtime.

Schema Tab

In the Schema tab you can view all elements.

To view schema elements, click on the folders to expand them. It is not necessary to click 

the Apply button.

Publish Current Record Check this checkbox to publish the current record (for Effective Dated records only).

Note: The adapter will consider a record as Effective Dated if the effective date field in that 

record starts with EFFDT.

Transport Type The transport to be used by the runtime adapter, JMS or Rendezvous. See Transport Type on 

page 126 for details.

JMS

JMS Compress Available only for the JMS transport. It can be Uncompressed or Compressed. See Compressing 

JMS Messages on page 161 for details.

Connection Factory 

Type

Available only for the JMS transport. It can be Topic or Queue. See Connection Factory Type on 

page 128 for details.

Delivery Mode Available only for the JMS transport. It can be Persistent or Non-Persistent. See Delivery Mode on 

page 128 for details.

Wire Format Services must use the same wire format to exchange data. It is XML Message. See Wire Format 

on page 127 for details.

Rendezvous

Quality of Service Available only for the Rendezvous transport. It can be Certified or Reliable. See Quality of Service 

on page 126 for details.

Wire Format Services must use the same wire format to exchange data. It can be XML Message or 

ActiveEnterprise Message. See Wire Format on page 127 for details.

Table 23   Message Publication Service Configuration - Configuration Tab (Cont’d)

Field Description
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The Schema tab contains the following fields:

SubscriberOptions Tab

The SubscriberOptions tab contains the following fields:

Table 24   Message Publication Service Configuration - Schema Tab

Field Description

Name This column shows a field name if the schema attribute is a field or the record name if the schema 

attribute is a record.

Field Type This column applies only if a field is shown. 

Note: The values are TIBCO field-types and not PeopleSoft field-types.

Table 25   Message Publication Service Configuration - SubscriberOptions Tab

Field Description

Subscriber Subject Enter the subject on which the adapter should subscribe for messages from PeopleSoft. The 

Subscriber Subject should be the same as the one mentioned in Define Nodes on page 33.

Client TimeOut (in 

millisecond)

The time taken by the Client to time out. By default, it is 5000 milliseconds.

Subscriber Transport 

Type

The Transport Type used by the adapter to send messages to the PeopleSoft Integration Broker. 

The Transport Type can be JMS or HTTP. 

JMS

Connection Factory 

Type

Available only for the JMS transport. It can be Topic or Queue. See Connection Factory Type on 

page 128 for details.

Delivery Mode Available only for the JMS transport. It can be Persistent or Non-Persistent. See Delivery Mode on 

page 128 for details.

HTTP

HTTP 

Port

Available only for the HTTP transport. The port at which the adapter waits for HTTP 
messages. By default, the adapter listens at port 2002 for IB messages.
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Advanced Tab

The Advanced tab contains the following fields:

Configuration Task Sequence

To configure a Message Publication Service, follow these steps:

1. In the Project Panel, expand the adapter instance folder (by default, 

PeopleSoftAdapterConfiguration).

2. Click Adapter Services in the project panel.

3. Drag a Message Publication Service icon to the Design Panel.

4. Specify options in the Configuration tab. See Configuration Tab on page 102 for 

more information.

Table 26   Message Publication Service Configuration - Advanced Tab

Field Description

Destination Available only for the JMS transport.

By default, a dynamic destination is generated using the Domain and Deployment global variables, the 

adapter acronym, the adapter instance name, and the service name.

If you use this default dynamic destination, ensure that the values for Domain and Deployment are not 

empty. You can override the default dynamic destination by specifying the static destination in this 

field. The static destination must be defined on the EMS server before it can be used by the runtime 

adapter. See the TIBCO Enterprise Message Service User’s Guide for information about 

destinations.

Message 

Subject

Available only for the Rendezvous transport.

By default, a service uses a message subject that is generated using the Domain and 
Deployment global variables, the adapter acronym, the adapter instance name and the service 
name. 

If you use this default subject, make sure the values for Domain and Deployment are not empty. 
You can type a TIBCO Rendezvous subject name different from the default in this field. 
See TIBCO Rendezvous Concepts for information about specifying subject names. 

Endpoint 

Reference

The location in TIBCO Repository where the endpoint information will be stored (default).

Endpoints store information such as message subject, endpoint type, and startup state.

Schema 

Reference

A link to a location for the defined PeopleSoft adapter schema.
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5. Click the Apply button. This generates a unique endpoint with a TIBCO Rendezvous 

subject name. The adapter automatically enters this information in the Advanced tab.

6. Click the Get Schema button. This downloads the Message schema from PeopleSoft 

to TIBCO Designer.

7. Save your project. 

Rendezvous is selected as the default Transport Type. If you select JMS as the Transport Type, a 

unique endpoint with the destination name will be generated.
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CI Subscription Service

When running as a Subscription Service the adapter receives messages from the TIBCO 

Environment and inserts the message data into a PeopleSoft database through Component 

Interface APIs.

• Configuration Options, page 107

• Configuration Task Sequence, page 110

Configuration Options

Configure a Subscription Service under the following tabs in the Configuration Panel. 

• Configuration Tab, page 107

• Schema Tab, page 108

• Advanced Tab, page 109

Configuration Tab

The Configuration tab contains the following fields:

Table 27   Subscription Service Configuration - Configuration Tab

Field Description

Name The name of the Component Interface stored in the PeopleSoft database. It matches the 
Component Interface Name and is automatically filled in by TIBCO Designer.

Component Interface 

Name

TIBCO Designer automatically supplies this name when you click the Fetch Interface… 

button and select a Component Interface. When starting the adapter, it uses this name to find 

the Component Interface in PeopleSoft. You can enter a partial string in this field to filter the 

Component Interfaces that are presented in the drop-down list when you click the Fetch 

Interface… button.

For example, entering p would narrow the drop-down list to only Component Interface names 

beginning with p.

Transport Type The transport to be used by the runtime adapter, JMS or Rendezvous. See Transport Type on 

page 126 for details.

JMS

Connection Factory 

Type

Available only for the JMS transport. It can be Topic or Queue. See Connection Factory Type on 

page 128 for details.
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Get Schema

Click the Get Schema button to list the fields of the fetched schema in the Schema Tab.

If you have changed any configuration, either on the service level or on the instance level, 

click the Get Schema button to ensure that the modification is reflected in the service at 

runtime.

Schema Tab

In the Schema tab you can view all elements.

To view schema elements, click on the folders to expand them. It is not necessary to click 

the Apply button.

The Schema tab contains the following fields:

Delivery Mode Available only for the JMS transport. It can be Durable or Non Durable. See Delivery Mode on 

page 128 for details.

Wire Format Services must use the same wire format to exchange data. It is XML Message. See Wire Format 

on page 127 for details.

Rendezvous

Quality of Service Available only for the Rendezvous transport. It can be Certified, Reliable or Distributed Queue. See 

Quality of Service on page 126 for details.

Wire Format Services must use the same wire format to exchange data. It can be XML Message or 

ActiveEnterprise Message. See Wire Format on page 127 for details.

Table 27   Subscription Service Configuration - Configuration Tab (Cont’d)

Field Description

Table 28   Subscription Service Configuration - Schema Tab

Field Description

Name This column shows a field name if the schema attribute is a field, or shows a record name if the 

schema attribute is a record. 

Field Type This column applies only if a field is shown. 

Note: The values are TIBCO field-types and not PeopleSoft field-types.

Key? This column indicates whether the field is a key in a PeopleSoft database. 

Note: The values are TIBCO field-types and not PeopleSoft field-types.
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Advanced Tab

The Advanced tab contains the following fields:

Operation Code

The input data received by the Subscription Service contains a field called operation code 

(OPRN_CODE) if the Component Interface associated with the service contains records that 

are level 1 and above. The value in the operation code field determines the mode of update 

carried out on child records in the target PeopleSoft database. The values that can be 

specified in the input data for OPRN_CODE are:

• I - If the incoming row(s) is present insert it.

Runtime Input This column indicates whether the field will be included in the runtime input.

Note: The key fields are always included in the runtime input.

Table 28   Subscription Service Configuration - Schema Tab (Cont’d)

Field Description

Table 29   Subscription Service Configuration - Advanced Tab

Field Description

Destination Available only for the JMS transport.

By default, a dynamic destination is generated using the Domain and Deployment global variables, the 

adapter acronym, the adapter instance name, and the service name.

If you use this default dynamic destination, ensure that the values for Domain and Deployment are not 

empty. You can override the default dynamic destination by specifying the static destination in this 

field. The static destination must be defined on the EMS server before it can be used by the runtime 

adapter. See the TIBCO Enterprise Message Service User’s Guide for information about 

destinations.

Message Subject Available only for the Rendezvous transport.

By default, a service uses a message subject that is generated using the Domain and 
Deployment global variables, the adapter acronym, the adapter instance name and the service 
name. 

If you use this default subject, make sure the values for Domain and Deployment are not empty. 
You can type a TIBCO Rendezvous subject name different from the default in this field. 
See TIBCO Rendezvous Concepts for information about specifying subject names. 

Endpoint 

Reference

The location in TIBCO Repository where the endpoint information will be stored (default).

Endpoints store information such as message subject, endpoint type, and startup state.

Schema Reference A link to a location for the defined PeopleSoft adapter schema.
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• U - If the incoming row(s) is present, update it.

• R - Replace existing row(s) with the incoming row(s). (Deprecated)

• D - If the incoming row(s) is present delete it.

• Null - If no operation code is specified an update is carried out.

See Implementation of Keys in the TIBCO Adapter for PeopleSoft on page 158 for more 

information on the operation codes. 

Configuration Task Sequence

To configure a Subscription Service, follow these steps:

1. In the Project Panel, expand the adapter instance folder (by default, 

PeopleSoftAdapterConfiguration).

2. Click Adapter Services in the project panel.

3. Drag a Subscription Service icon to the Design Panel.

4. Specify options in the Configuration tab. See Configuration Tab on page 107 for more 

information.

5. Click the Apply button. This generates a unique endpoint with a TIBCO Rendezvous 

subject name. The adapter automatically enters this information in the Advanced tab.

6. Click the Get Schema button. This downloads the Component Interface schema from 

PeopleSoft to TIBCO Designer.

7. Save your project. 

Rendezvous is selected as the default Transport Type. If you select JMS as the Transport Type, a 

unique endpoint with the destination name will be generated.
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Message Subscription Service

When running as a Subscription Service the adapter receives messages from the TIBCO 

Environment and inserts the message data into a PeopleSoft database using the Integration 

Broker.

• Configuration Options, page 111

• Configuration Task Sequence, page 114

Configuration Options

Configure a Message Subscription Service under the following tabs in the Configuration 

Panel. 

• Configuration Tab, page 111

• Schema Tab, page 112

• SubscriberOptions Tab, page 113

• Advanced Tab, page 114

Configuration Tab

The Configuration tab contains the following fields:

Table 30   Message Subscription Service Configuration - Configuration Tab

Field Description

Name The name of the Message stored in the PeopleSoft database. It matches the Message Name 
and is automatically filled in by TIBCO Designer.

Message Name TIBCO Designer automatically supplies this name when you click the Fetch Message… 

button and select a Message. When starting the adapter, it uses this name to find the Message in 

PeopleSoft. You can enter a partial string in this field to filter the Messages that are presented 

in the drop-down list when you click the Fetch Message… button.

For example, entering p would narrow the drop-down list to only Message names beginning 

with p.

Transport Type The transport to be used by the runtime adapter, JMS or Rendezvous. See Transport Type on 

page 126 for details.

JMS

Connection Factory 

Type

Available only for the JMS transport. It can be Topic or Queue. See Connection Factory Type on 

page 128 for details.
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Get Schema

Click the Get Schema button to list the fields of the fetched schema in the Schema Tab.

If you have changed any configuration, either on the service level or on the instance level, 

click the Get Schema button to ensure that the modification is reflected in the service at 

runtime.

Schema Tab

In the Schema tab you can view all elements.

To view schema elements, click on the folders to expand them. It is not necessary to click 

the Apply button.

The Schema tab contains the following fields:

Delivery Mode Available only for the JMS transport. It can be Durable or Non Durable. See Delivery Mode on 

page 128 for details.

Wire Format Services must use the same wire format to exchange data. It is XML Message. See Wire Format 

on page 127 for details.

Rendezvous

Quality of Service Available only for the Rendezvous transport. It can be Certified, Reliable or Distributed Queue. See 

Quality of Service on page 126 for details.

Wire Format Services must use the same wire format to exchange data. It can be XML Message or 

ActiveEnterprise Message. See Wire Format on page 127 for details.

Table 30   Message Subscription Service Configuration - Configuration Tab (Cont’d)

Field Description

Table 31   Message Subscription Service Configuration - Schema Tab

Field Description

Name This column shows a field name if the schema attribute is a field or the record name if the schema 

attribute is a record. You can expand folders in this column to display triggers for PROPERTIES 

fields. When the adapter publishes data, the governing schema puts data only in the PROPERTIES 

node.

Field Type This column applies only if a field is shown. 

Note: The values are TIBCO field-types and not PeopleSoft field-types.



 TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

Message Subscription Service | 113

SubscriberOptions Tab

The SubscriberOptions tab contains the following fields:

Table 32   Message Subscription Service Configuration - SubscriberOptions Tab

Field Description

Requesting Node Enter the name of the Requesting Node. The Requesting Node mentioned in the Node 

definition in PeopleSoft should be the same as the one mentioned here.

Node Password The Node Password is the same as the Password specified in the Node definition in PeopleSoft.

Client TimeOut (in 

millisecond)

The time taken by the Client to time out. By default, it is 5000 milliseconds.

Subscriber Transport 

Type

The Transport Type used by the adapter to send messages to the PeopleSoft Integration Broker. 

The Transport Type can be JMS or HTTP. 

JMS

Connection Factory 

Type

Available only for the JMS transport. It can be Topic or Queue. See Connection Factory Type on 

page 128 for details.

Delivery Mode Available only for the JMS transport. It can be Persistent or Non-Persistent. See Delivery Mode on 

page 128 for details.

IB Subscriber Subject Available only for the JMS transport. The subject on which IB subscribes for messages 
from the adapter. The subject name entered here should be the same as the one 
entered in the integrationGateway.properties file

User Name Available only for the JMS transport. The user name used to connected to the TIBCO 

Enterprise Message Server (EMS).

Password Available only for the JMS transport. The password used to connect to the TIBCO 
Enterprise Message Server (EMS).

JNDI URL Available only for the JMS transport. The URL of the TIBCO Enterprise Message Server 
(EMS).

HTTP

HTTP 

Port

Available only for the HTTP transport. The port at which the adapter waits for HTTP 
messages. By default, the adapter listens at port 2002 for IB messages.
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Advanced Tab

The Advanced tab contains the following fields:

Configuration Task Sequence

To configure a Subscription Service, follow these steps:

1. In the Project Panel, expand the adapter instance folder (by default, 

PeopleSoftAdapterConfiguration).

2. Click Adapter Services in the project panel.

3. Drag a Message Subscription Service icon to the Design Panel.

4. Specify options in the Configuration tab. See Configuration Tab on page 111 for 

more information. 

Table 33   Message Subscription Service Configuration - Advanced Tab

Field Description

Destination Available only for the JMS transport.

By default, a dynamic destination is generated using the Domain and Deployment global variables, the 

adapter acronym, the adapter instance name, and the service name.

If you use this default dynamic destination, ensure that the values for Domain and Deployment are not 

empty. You can override the default dynamic destination by specifying the static destination in this 

field. The static destination must be defined on the EMS server before it can be used by the runtime 

adapter. See the TIBCO Enterprise Message Service User’s Guide for information about 

destinations.

Message Subject Available only for the Rendezvous transport.

By default, a service uses a message subject that is generated using the Domain and 
Deployment global variables, the adapter acronym, the adapter instance name and the service 
name. 

If you use this default subject, make sure the values for Domain and Deployment are not empty. 
You can type a TIBCO Rendezvous subject name different from the default in this field. 
See TIBCO Rendezvous Concepts for information about specifying subject names. 

Endpoint 

Reference

The location in TIBCO Repository where the endpoint information will be stored (default).

Endpoints store information such as message subject, endpoint type, and startup state.

Schema 

Reference

A link to a location for the defined PeopleSoft adapter schema.
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5. Click the Apply button. This generates a unique endpoint with a TIBCO Rendezvous 

subject name. The adapter automatically enters this information in the Advanced tab.

6. Click the Get Schema button. This downloads the message schema from PeopleSoft 

to TIBCO Designer.

7. Specify options in the SubscriberOptions tab. See SubscriberOptions Tab on 

page 113 for more information.

8. Click the Apply button.

9. Save your project. 

Rendezvous is selected as the default Transport Type. If you select JMS as the Transport Type, a 

unique endpoint with the destination name will be generated.
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Request-Response Service

This service is often called a Request Reply Server or RPC (Remote Procedural Call) 

Server. When running as a Request-Response Service, the adapter receives requests from 

the TIBCO environment, parses them, calls the appropriate Component Interface API to 

set the input fields, then calls another set of Component Interface APIs to get the output 

fields. The output fields are wrapped in a schema and sent back to the caller.

• Configuration Options, page 116

• Configuration Task Sequence, page 114

Configuration Options

Configure a Request-Response Service under the following tabs in the Configuration 

Panel. 

• Configuration Tab, page 116

• Schema Tab, page 117

• Advanced Tab, page 119

Configuration Tab

The Configuration tab contains the following fields:

Table 34   Request-Response Service Configuration - Configuration Tab

Field Description

Name The name of the Component Interface stored in the PeopleSoft database. It matches the 
Component Interface Name and is automatically filled in by TIBCO Designer.

Component Interface 

Name

TIBCO Designer automatically supplies this name when you click the Fetch Interface button 

and select a Component Interface. When starting the adapter, it uses this name to find the 

Component Interface in PeopleSoft. You can enter a partial string in this field to filter the 

Component Interfaces that are presented in the drop-down list when you click the Fetch 

Interface button.

For example, entering p would narrow the drop-down list to only Component Interface names 

beginning with p.

Transport Type The transport to be used by the runtime adapter, JMS or Rendezvous. See Transport Type on 

page 126 for details.

JMS
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Get Schema

Click the Get Schema button to list the fields of the fetched schema in the Schema Tab.

If you have changed any configuration, either on the service level or on the instance level, 

click the Get Schema button to ensure that the modification is reflected in the service at 

runtime.

Schema Tab

In this tab you can view all schema elements and change Direction.

To view schema elements, click on the folders to expand them. It is not necessary to click 

the Apply button.

To change the Direction, follow these steps:

1. Expand the required folder until the Direction column is populated.

2. Click on the direction of the required field and then select the new direction from the 

drop-down list.

3. Click the Apply button.

Connection Factory 

Type

Available only for the JMS transport. It can be Topic or Queue. See Connection Factory Type on 

page 128 for details.

Delivery Mode Available only for the JMS transport. It can be Durable or Non Durable. See Delivery Mode on 

page 128 for details.

Wire Format Services must use the same wire format to exchange data. It is XML Message. See Wire Format 

on page 127 for details.

Rendezvous

Quality of Service Available only for the Rendezvous transport. It can be Certified, Reliable or Distributed Queue. See 

Quality of Service on page 126 for details.

Wire Format Services must use the same wire format to exchange data. It can be XML Message or 

ActiveEnterprise Message. See Wire Format on page 127 for details.

Table 34   Request-Response Service Configuration - Configuration Tab (Cont’d)

Field Description
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The Schema tab contains the following fields:

Operation Code

The input data received by the Request-Response Service contains a field called operation 

code (OPRN_CODE) if the Component Interface associated with the service contains records 

that are level 1 and above. The value in the operation code field determines the mode of 

update carried out on child records in the target PeopleSoft database. The values that can 

be specified in the input data for OPRN_CODE are:

• I — If the incoming row(s) is present insert it.

• U — If the incoming row(s) is present update it.

• R — Replace existing row(s) with the incoming row(s).

• D — If the incoming row(s) is present delete it.

• Null — If no operation code is specified an update is carried out.

Table 35   Request-Response Service Configuration - Schema Tab

Field Description

Name This column shows a field name if the schema attribute is a field, or shows a record name if the 

schema attribute is a record. 

Field Type This column applies only if a field is shown. 

Note: The values are TIBCO field-types and not PeopleSoft field-types.

Direction The valid values for Direction are:

• In — This field is read from the incoming request but not set in the outgoing reply. 

Indicates the PROPERTIES field is used as an input field.

• Out — This field is not read from the incoming request but set in the outgoing reply. 

Indicates the PROPERTIES field is used as an output field.

• InOut — This field is read from the incoming request and set in the outgoing reply. 

Indicates the PROPERTIES field is used in both directions. When a field direction is 

INOUT, the field value is used in the request sent to PeopleSoft as well as retrieved from 

PeopleSoft and sent back to the request as part of the reply.

Key? This column indicates whether the field is a key in a PeopleSoft database. 

Note: The values are TIBCO field-types and not PeopleSoft field-types.

Runtime Input This column indicates whether the field will be included in the runtime input.

Note: The key fields are always included in the runtime input.
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See Implementation of Keys in the TIBCO Adapter for PeopleSoft on page 158 for more 

information on the operation codes. 

Advanced Tab

The Advanced tab contains the following fields:

Configuration Task Sequence

To configure a Request-Response Service, follow these steps:

1. In the Project Panel, expand the adapter instance folder (by default, 

PeopleSoftAdapterConfiguration).

2. Click Adapter Services in the project panel.

3. Drag a Request-Response Service icon to the Design Panel.

4. Specify options in the Configuration tab. See Configuration Tab on page 116 for 

more information. 

Table 36   Request-Response Service Configuration - Advanced Tab

Field Description

Destination Available only for the JMS transport.

By default, a dynamic destination is generated using the Domain and Deployment global variables, the 

adapter acronym, the adapter instance name, and the service name.

If you use this default dynamic destination, ensure that the values for Domain and Deployment are not 

empty. You can override the default dynamic destination by specifying the static destination in this 

field. The static destination must be defined on the EMS server before it can be used by the runtime 

adapter. See the TIBCO Enterprise Message Service User’s Guide for information about 

destinations.

Message 

Subject

Available only for the Rendezvous transport.

By default, a service uses a message subject that is generated using the Domain and 
Deployment global variables, the adapter acronym, the adapter instance name and the service 
name. 

If you use this default subject, make sure the values for Domain and Deployment are not empty. 
You can type a TIBCO Rendezvous subject name different from the default in this field. 
See TIBCO Rendezvous Concepts for information about specifying subject names. 

Endpoint 

Reference

The location in TIBCO Repository where the endpoint information will be stored (default).

Endpoints store information such as message subject, endpoint type, and startup state.

Schema 

Reference

A link to a location for the defined PeopleSoft adapter schema.
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5. Click the Apply button. This generates a unique endpoint with a TIBCO Rendezvous 

subject name. The adapter automatically enters this information in the Advanced tab.

6. Click the Get Schema button. This downloads the Component Interface schema from 

PeopleSoft to TIBCO Designer.

7. Click the Apply button.

8. Save your project. 

Rendezvous is selected as the default Transport Type. If you select JMS as the Transport Type, a 

unique endpoint with the destination name will be generated.
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Request-Response Invocation Service

The Request-Response invocation service uses the Integration Gateway to transfer HTTP 

or JMS messages. When you save a message in PeopleSoft, the SavePostChange method gets 

executed and the message is converted to XML and published to a Message Channel 

residing on the PeopleSoft Application Server. When the Integration Engine finds a new 

message in the Message Channel, it looks for an active node associated with the Message 

Channel. On finding the node, based on the Target Connector, the Integration Engine 

builds the request and sends it to the PeopleSoft adapter. On receiving the request, the 

adapter processes the requests and sends the response back to PeopleSoft.

For the Request-Response Invocation service to work, the PeopleCode provided with the 

installation needs to be copied in the SavePostChange event of the component from which the 

data has to be sent out. For instructions on how to do this, see Preparing PeopleSoft 

Application Messages on page 27.

• Configuration Options, page 116

• Configuration Task Sequence, page 114

Configuration Options

Configure a Request-Response Invocation Service under the following tabs in the 

Configuration Panel.

• Configuration Tab, page 121

• Inbound Message Tab, page 122

• Outbound Message Tab, page 123

• SubscriberOptions Tab, page 123

• Advanced Tab, page 123

Configuration Tab

The Configuration tab contains the following fields:

Table 37   Request-Response Invocation Service Configuration - Configuration Tab

Field Description

Name The name of the Message stored in the PeopleSoft database. It matches the Message 

Name and is automatically filled in by TIBCO Designer.
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Inbound Message Tab

The Inbound Message tab contains the following fields:

Message Name TIBCO Designer automatically supplies this name when you click the Fetch Message… 

button and select a Message. When starting the adapter, it uses this name to find the Message in 

PeopleSoft. You can enter a partial string in this field to filter the Messages that are presented 

in the drop-down list when you click the Fetch Message… button.

For example, entering p would narrow the drop-down list to only Message names beginning 

with p.

Publish Current Record Check this checkbox to publish the current record (for Effective Dated records only).

Note: The adapter will consider a record as Effective Dated if the effective date field in that 

record starts with EFFDT.

Transport Type The transport to be used by the runtime adapter, JMS or Rendezvous. See Transport Type on 

page 126 for details.

JMS

JMS Compress Available only for the JMS transport. It can be Uncompressed or Compressed. See Compressing 

JMS Messages on page 161 for details.

Connection Factory 

Type

Available only for the JMS transport. It can be Topic or Queue. See Connection Factory Type on 

page 128 for details.

Delivery Mode Available only for the JMS transport. It can be Persistent or Non Persistent. See Delivery Mode on 

page 128 for details.

Wire Format Services must use the same wire format to exchange data. It is XML Message. See Wire Format 

on page 127 for details.

Rendezvous

Quality of Service Available only for the Rendezvous transport. It can be Certified, Reliable or Distributed Queue. See 

Quality of Service on page 126 for details.

Wire Format Services must use the same wire format to exchange data. It can be XML Message or 

ActiveEnterprise Message. See Wire Format on page 127 for details.

Table 37   Request-Response Invocation Service Configuration - Configuration Tab (Cont’d)

Field Description

Table 38   Request-Response Invocation Service Configuration - Inbound Message Tab

Field Description

Name This column shows a list of field names available in the schema.
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Outbound Message Tab

The Outbound Message tab contains the following fields:

SubscriberOptions Tab

The SubscriberOptions tab contains the following fields:

Field Type This column shows the datatype corresponding to the fields in the schema.

Table 38   Request-Response Invocation Service Configuration - Inbound Message Tab

Field Description

Table 39   Request-Response Invocation Service Configuration - Outbound Message Tab

Field Description

Name This column shows a list of field names available in the schema.

Field Type This column shows the datatype corresponding to the fields in the schema.

Table 40   Request-Response Invocation Service Configuration - SubscriberOptions Tab

Field Description

Subscriber Subject Enter the subject on which the adapter should subscribe for messages from PeopleSoft. The 

Subscriber Subject should be the same as the one mentioned in Define Nodes on page 33.

Client TimeOut (in 

millisecond)

The time taken by the Client to time out. By default, it is 5000 milliseconds.

Subscriber Transport 

Type

The Transport Type used by the adapter to send messages to the PeopleSoft Integration Broker. 

The Transport Type can be JMS or HTTP. 

JMS

Connection Factory 

Type

Available only for the JMS transport. It can be Topic or Queue. See Connection Factory Type on 

page 128 for details.

Delivery Mode Available only for the JMS transport. It can be Persistent or Non-Persistent. See Delivery Mode on 

page 128 for details.

HTTP

HTTP 

Port

Available only for the HTTP transport. The port at which the adapter waits for HTTP 
messages. By default, the adapter listens at port 2002 for IB messages.
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Advanced Tab

The Advanced tab contains the following fields:

Configuration Task Sequence

To configure a Request-Response Invocation Service, follow these steps:

1. In the Project Panel, expand the adapter instance folder (by default, 

PeopleSoftAdapterConfiguration).

2. Click Adapter Services in the project panel.

3. Drag a Request-Response Invocation Service icon to the Design Panel.

4. Specify options in the Configuration tab. See Configuration Tab on page 121 for 

more information. 

Table 41   Request-Response Invocation Service Configuration - Advanced Tab

Field Description

Destination Available only for the JMS transport.

By default, a dynamic destination is generated using the Domain and Deployment global variables, the 

adapter acronym, the adapter instance name, and the service name.

If you use this default dynamic destination, ensure that the values for Domain and Deployment are not 

empty. You can override the default dynamic destination by specifying the static destination in this 

field. The static destination must be defined on the EMS server before it can be used by the runtime 

adapter. See the TIBCO Enterprise Message Service User’s Guide for information about 

destinations.

Message 

Subject

Available only for the Rendezvous transport.

By default, a service uses a message subject that is generated using the Domain and 
Deployment global variables, the adapter acronym, the adapter instance name and the service 
name. 

If you use this default subject, make sure the values for Domain and Deployment are not empty. 
You can type a TIBCO Rendezvous subject name different from the default in this field. 
See TIBCO Rendezvous Concepts for information about specifying subject names. 

Endpoint 

Reference

The location in TIBCO Repository where the endpoint information will be stored (default).

Endpoints store information such as message subject, endpoint type, and startup state.

Schema 

Reference

A link to a location for the defined PeopleSoft adapter schema.
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5. Click the Apply button. This generates a unique endpoint with a TIBCO Rendezvous 

subject name. The adapter automatically enters this information in the Advanced tab.

6. Click the Get Schema button. This downloads the Message schema from PeopleSoft 

to TIBCO Designer.

7. Specify options in the SubscriberOptions tab. See SubscriberOptions Tab on 

page 123 for more information. 

8. Save your project.

Rendezvous is selected as the default Transport Type. If you select JMS as the Transport Type, a 

unique endpoint with the destination name will be generated.
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Common Configuration Options for Adapter Services

This section explains the following common configuration options for adapter services:

• Transport Type, page 126

• Quality of Service, page 126

• Wire Format, page 127

• Connection Factory Type, page 128 

• Delivery Mode, page 128

The transport type (Rendezvous or JMS) you select for the runtime adapter determines 

transport specific service options. Only options that are compatible with a service’s 

transport type will be available in the Configuration Panel. 

Transport Type

There are two transport types available for the runtime adapter, namely JMS and Rendezvous. 

After selecting the transport type, you can configure the transport specific options. Only 

options that are compatible with the service’s transport type appear in the Configuration 

Panel. 

The transport can be configured to use a trusted store and identity resource for use in SSL 

(Secure Sockets Layer) configurations. TIBCO Rendezvous sessions and JMS topics have 

an SSL configuration field which uses a dialog to perform SSL configuration.

To enable and configure SSL:

1. In the Project Panel, select the adapter instance.

2. Expand Advanced > Sessions, and then select the TIBCO Rendezvous session or 

JMS session.

3. Check the Use SSL? checkbox in the Configuration Panel.

4. Click the Configure SSL... button to do further configuration.

The SSL configuration options are explained in the online help associated with the session 

dialog.

Quality of Service

If you have selected Rendezvous as the transport type, then select Quality of Service.
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Certified 

Guarantees that every certified message reaches its intended recipient in the order sent. 

The message can be sent across network boundaries and, if a network fails, delivery 

attempts continue until it succeeds or the message times out. This is called certified 

message delivery.

If certified message delivery is used, data is stored in a ledger file. The size of the ledger 

depends on several factors, the most important one is the retention rate of stored data. That 

is, the ledger grows fastest in response to the cumulative length of undeliverable 

messages. Ensure that sufficient disk space is available for the expected size of the ledger.

Reliable

Ensures that each multicast or broadcast message is received as long as the physical 

network and packet recipients are working. It also ensures that the loss of a message is 

detected.

This option can compensate for brief network failures because it can retransmit a message 

on request if the first attempt failed. This choice is appropriate when message delivery is 

expected but some loss can be tolerated.

Distributed Queue

Distributed Queue delivers a message to one-of-many service listeners (workers). It 

contains features of both Certified Messaging and Fault Tolerance.

Wire Format

XML Message

The XML Message wire format conforms to specifically constructed and fully compliant 

XML Schema (XSD) based on the existing definition of the ActiveEnterprise schema.

ActiveEnterprise Message

The ActiveEnterprise Message is available only for the Rendezvous transport.

For the XML Message wire format, when carriage returns are passed through the adapter, 

they are converted to line feeds. This behavior is as per the W3C specifications.
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Control information for validation is sent in the message. If no control information is 

included, an exception is returned to the subscription service. ActiveEnterprise standard 

wire format provides class information and packing rules for the TIBCO Adapter SDK set 

of data types. This format allows ActiveEnterprise components to perform extra validation 

on messages sent or received.

See TIBCO Adapter SDK Programmer’s Guide for details about the control information 

generated and sent with ActiveEnterprise messages.

Connection Factory Type

For JMS transport, there are two kinds of connection factories.

Topic

A message published to a topic is broadcast to one or more subscribers. All messages 

published to the topic are received by all services that have subscribed to the topic. This 

messaging model is known as publish-subscribe.

Queue

A message sent to a queue is consumed by one and only one receiver. Each message has 

only one receiver though multiple receivers may connect to the queue. The first receiver to 

access the queue gets the message. The other receivers do not. This messaging model is 

known as point-to-point.

Delivery Mode

For JMS transport, there are two groups of delivery modes.

CI Publication Service, IB Publication Service, and Request-Response Invocation 

Service

• Persistent — In general, a message marked as persistent will be available to a JMS 

client even if the EMS server goes down.

Messages sent with the persistent delivery mode are always written to persistent 

storage, except when they are published to a topic that has no durable subscribers. 

When a topic has no durable subscribers, there are no subscribers that need messages 

resent in the event of a server failure. Therefore, messages do not need to be saved, 

and performance is improved because disk I/O is not required.

• Non-Persistent — A message marked as non-persistent will not be available to a JMS 

client if the EMS server goes down.
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Subscription Service, Message Subscription Service, and Request-Response Service

• Durable — In general, a message marked as durable will be available to a JMS client 

even if the EMS server goes down.

• Non-Durable — A message marked as non-durable will not be available to a JMS 

client if the EMS server goes down.

See TIBCO Enterprise Message Service User’s Guide for more information about the 

semantics for this field.
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Chapter 6 Deploying and Starting an Adapter Using 

TIBCO Administrator 

This chapter provides an overview about deploying, starting, stopping, and monitoring 

adapter services using the TIBCO Administrator. 

Topics

• Creating an EAR File in TIBCO Designer, page 132

• Deploying the Project, page 133 

• Starting or Stopping the Adapter, page 135

• Monitoring the Adapter, page 136
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Creating an EAR File in TIBCO Designer

The Enterprise Archive file (EAR) contains information on what you wish to deploy. This 

could be one or more adapter services, one or more TIBCO ActiveMatrix BusinessWorks 

process engines, or both. 

To create an EAR file in TIBCO Designer, follow these steps:

1. Configure the adapter services.

2. Select the project in the Project Panel.

3. Drag the Enterprise Archive icon from the General Palettes Panel to the Design 

Panel.

4. Select the Enterprise Archive you have just created in the Project Panel.

If there are any configured adapter services in your project, an Adapter Archive 

resource becomes available in the Palettes panel.

5. Drag the Adapter Archive icon from the Palettes panel to the Design Pane.

6. Configure the adapter archive in the Configuration Panel. Click the Browse resources 

button to select the adapter instance in the Adapter field and then click the Apply 

button.

7. Select the Enterprise Archive in the Project Panel, and then click the Build Archive 

button in the Configuration Panel to create the archive file.

See Also

See the TIBCO Designer User’s Guide for more information about this procedure. The 

guide is available from the Designer Help menu.

Building an archive creates the EAR file, which you can then deploy from TIBCO 

Administrator. If you make changes to the business processes or adapter services included 

in the archive, you need to rebuild the archive. Saving the project does not affect the 

archive. 
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Deploying the Project

Before deploying a project, the machine on which the adapter is installed must be part of a 

TIBCO administration domain. After you have installed the TIBCO Administration 

Server, any machine on which you install TIBCO Runtime Agent (required by an adapter) 

can be added to the administration domain. The TIBCO software installed on the machine 

is then visible and accessible via the TIBCO Administrator GUI. 

When you deploy a project, startup scripts and other information about the different 

components are sent to the machines to which the components were assigned. The project 

data store and TIBCO Administration Server are updated with the deployed components. 

To deploy a project:

1. Import the EAR file into TIBCO Administrator.

a. Start TIBCO Administrator. Log into the domain.

b. In the left panel, select Application Management.

c. Click the New Application button.

d. In the Upload EAR File dialog, browse to select the EAR file. Click the OK 

button.

2. Assign adapter archives in the EAR file to adapters installed in the administration 

domain and likewise assign process archives to process engines.

3. In the New Application Configuration dialog, uncheck the Quick Configure 

checkbox, and then click the Save button.

4. Specify startup options for each adapter service.

5. In the Configuration Builder, click the top level application name, and then perform 

following tasks:

a. Change the values in the Advanced tab if necessary.

b. Click the Save button.

c. In the Configuration Builder, select the adapter archive, and then click the Add to 

Additional Machines button.

d. Select the machine and click the OK button. 

e. Click the Save button.

6. In the Configuration tab, click the Deploy button, and then click the OK button.

7. Once the deployment is complete, click the Application Processes button under the 

application. Select the adapter and the TIBCO ActiveMatrix BusinessWorks engine 

and click the Start Selected button. 
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See Also

See the TIBCO Administrator User’s Guide for an introduction to the TIBCO 

administration domain and detailed information about the above steps. 

See the TIBCO Administrator Server Configuration Guide for fault tolerance information.
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Starting or Stopping the Adapter

The TIBCO Administrator Application Management module allows you to start, and stop 

deployed applications.

Starting the Adapter

To start an adapter service from the module:

1. In the Administrator GUI left-hand pane, expand Application Management > 

ApplicationName > Service Instances.

2. In the Service Instance panel, check the checkbox next to the adapter service.

3. Click the Start Selected button.

The status changes from Stopped to Starting up to Started.

Stooping the Adapter

To stop the adapter service, click the Stop Selected button.

See Also

See the TIBCO Administrator User’s Guide for more information.
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Monitoring the Adapter

TIBCO Administrator offers a number of monitoring options. 

• Specify alerts and TIBCO Hawk rulebases for each machine in the domain.

• Specify alerts and Hawk rulebases for each adapter service. 

• View the log for each adapter service. 

See Also

See the TIBCO Administrator User’s Guide for information about configuring the above 

monitoring options.
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Chapter 7 Configuring Advanced Topics

This chapter describes advanced topics such as modifying connection parameters, 

defining a TIBCO Hawk session and setting encoding options among others.

Topics

• Password Handling, page 138

• Modifying DTA Rendezvous Connection Parameters, page 139

• Modifying Palette Rendezvous Connection Parameters, page 140

• Modifying the DTA JMS Connection Parameters, page 141

• Defining a TIBCO Hawk Session, page 142

• Using Global Variables, page 144

• Setting Encoding Options, page 150

• Configuring a Remote Adapter, page 151

• Running Multiple Design-Time Adapters, page 152

• Multi-threading and Deployment, page 153

• Using the Operation Code Feature, page 154

• Using the Adapter with a Revision Control System, page 155

• Implementation of Keys in the TIBCO Adapter for PeopleSoft, page 158

• Compressing JMS Messages, page 161
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Password Handling

At design-time, the adapter uses a password to connect to the backend application and 

fetch metadata. At runtime, the adapter uses a password to connect to the back-end 

application and interoperate with it.

If you plan to run the adapter locally, define the runtime password value to be a global 

variable. Before starting the adapter, include the runtime password as client variable in the 

adapter's .tra file and obfuscate it using obfuscate tool. For example, if the password value 

is defined as %%myPassword%%, create a global variable named myPassword in the global 

variables section with no value and include the following entry in the adapter's .tra file:

tibco.clientVar.myPassword

If you plan to deploy the adapter using TIBCO Administrator 5.1, check the Service 

property of the global variable in the global variables section. Before deploying the 

adapter, go to the Advanced tab of the adapter archive and set the password value under 

the Runtime Variables section. 

Regeneration differences between adapters:

• Default subjects are not regenerated to reflect the new instance name when a service is 

moved.

• Manually changed certified messaging and certified messaging queue ledger file 

names are regenerated to defaults when a service is moved, or copied and pasted to a 

new instance.

• If a service associated with a custom session is moved, or copied and pasted, the 

custom session is not moved, or copied and pasted. The session is regenerated as a 

default session.

Do not set the password to type Password in the global variables section for Version AE 

Version 4.0 or AE Version 5.0 or any intermediate version.
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Modifying DTA Rendezvous Connection Parameters

You can modify the TIBCO Rendezvous connection properties used by the design-time 

adapter. The properties can be modified in the adpsft8DTA.tra properties file or in the 

adpsft8DTA.dat project. Both files are located in the bin directory.

Modifying the Properties File

The adpsft8DTA_RV.tra properties file contains properties that specify, for example, the 

pathname to the project where configuration information for the design-time adapter is 

defined, the location of the directories where trace files and the certified messaging ledger 

file are stored, and so on. Properties specified in the adpsft8DTA_RV.tra properties file 

overwrite the same properties specified in the project. 

Use the following steps to specify custom Rendezvous connection properties for the 

design-time adapter.

1. Change directory to the bin directory. For example, on Microsoft Windows:
cd C:\tibco\adapter\adpsft8\version_number\bin

2. Using a text editor, open the adpsft8DTA_RV.tra properties file.

3. Add or edit the following properties:

tibco.clientVar.RvDaemon

tibco.clientVar.RvNetwork

tibco.clientVar.RvService

See the TIBCO Rendezvous documentation for correct values to use for the 

parameters.

4. Restart the design-time adapter after making these modifications. The changes are not 

applied until the design-time adapter is restarted.
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Modifying Palette Rendezvous Connection Parameters

Use the following steps to modify TIBCO Rendezvous connection parameters for the 

palette.

1. Open TIBCO Designer.

2. Open an existing project or a new project.

3. Drag and drop the PeopleSoft Adapter Configuration icon from the palette panel to 

the design panel.

4. Click Global Variables tab.

5. To modify TIBCO Rendezvous parameters with which the palette connects to the 

design-time adapter server,

— Select the required parameters (adpsft8DTARvDaemon, adpsft8DTARvNetwork, 

adpsft8DTARvService) in the Name list.

— Enter the value in the Value field and click the Enter button.

All subsequent interactions between TIBCO Designer and the design-time adapter will be 

on these set parameters. See the TIBCO Rendezvous documentation for correct values to 

use for the parameters.
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Modifying the DTA JMS Connection Parameters

You can modify the JMS connection properties used by the design-time adapter. The 

properties can be modified in the adpsft8DTA_JMS.tra properties file or by modifying the 

global variables for an adapter instance. The adpsft8DT_JMS.tra file is located in the bin 

directory.

Modifying the Properties File

The adpsft8DTA_JMS.tra properties file contains properties that specify, for example, the 

pathname to the project where configuration information for the design-time adapter is 

defined, the location of the directories where trace files and the certified messaging ledger 

file are stored, and so on. Properties specified in the adpsft8DTA_JMS.tra properties file 

overwrite the same properties specified in the project.

Use the following steps to specify custom TIBCO JMS connection properties for the 

design-time adapter.

1. Change directory to the bin directory. For example, on Microsoft Windows: 

cd TIBCO_HOME\adapter\adpsft8\version_number\bin

2. Using a text editor, open the adpsft8DTA_JMS.tra properties file. Add or edit the following 

properties:

tibco.clientVar.JmsProviderUrl value 

tibco.clientVar.TerminateSubject value 

where value is a valid JMS Server Provider url or Terminate Subject to stop the DTA. 

See the TIBCO Enterprise Message Service Documentation for correct values to use 

for the parameters.

3. Restart the design-time adapter after making these modifications. The changes are not 

applied until the design-time adapter is restarted.

Modifying the DAT File

If you enable the EMS authorization, you MUST add the username and the password in 

the adpsft8DTA.dat file, otherwise the JMS design-time adapter can not be started 

successfully.

You should set following values in the file: (Note: there are 2 places in the file)

<string name="connUsername" value=""/>

<string name="connPassword" value=""/>
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Defining a TIBCO Hawk Session

To use TIBCO Hawk to monitor the adapter you must first define a TIBCO Rendezvous 

session. A pre configured default Hawk session is available. You can modify the settings 

of the pre configured session provided or define a new one. Use the following steps to 

create a session:

1. In the project tree panel, click the PeopleSoft Adapter Configuration icon defined 

for your adapter configuration.

2. In the Configuration tab click the Show All tabs check box, then click the Monitoring 

tab.

3. Use default setting for all fields.

4. Click the Apply button.

The next diagram shows the definition for a Monitoring tab. The pre configured 

session called HawkSession is displayed in this screen.

5. Open the Advanced folder for the adapter configuration. Highlight the Sessions folder by 

clicking on it.

6. Drag the GenericSession icon from the palettes panel to the design panel.

7. In the Session Type field, click the drop-down arrow and choose RV. Click the Apply 

button.

8. In Name, type the name previously assigned in the Default MicroAgent Session field under the 

Monitoring tab.

9. In Service, type 7474 (the default used by TIBCO Hawk).

10. In Daemon, type tcp:7474 (the default used by TIBCO Hawk).
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11. Click the Apply button and save the project.

The next diagram shows a new hawk session defined.

To modify the parameters of the pre configured session, select HawkSession from the Advanced 

folder in the project panel and modify parameters as required.
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Using Global Variables

The variable substitution mechanism can override global variables predefined in the 

project in a restricted manner. Predefined variables can be viewed and set in TIBCO 

Designer. Variables are specified as %%VARNAME%% and cannot contain any white space.

Variable substitution allows you to accomplish the following.

• Substitute string variables specified in the project at startup time.

• Locally define the value for a variable for a specific project. The local value takes 

precedence over any global value.

• Specify the value for a variable in a properties file. This overrides the project 

repository and values set in code, but not variables set on the command line. 

• Enforce the pre-defined variables listed in Predefined Global Variables on page 146.

Variables can be used anywhere in the configuration and will be replaced by the 

locally-defined adapter instance. 

Specifying Variables Using TIBCO Designer

Global variables provide an easy way to set defaults for use throughout your project. 

There are several ways in which they can be used: 

• Define a variable using TIBCO Designer, then override the value for individual 

applications at deployment time using TIBCO Administrator. You can also override 

values for predefined variables, unless the GUI does not allow you to make set them 

later. 

• Predefine a variable using TIBCO Designer, then override the value for individual 

services (for example, publication service or TIBCO ActiveMatrix BusinessWorks 

process) at deployment time using TIBCO Administrator. The values you specify are 

then used at runtime. You can also override values for predefined variables, unless the 

GUI does not allow you to set them later.

For example, you could assign the value 7474 to the predefined global variable RvDaemon. 

You can then use the variable in different sessions in your adapter. If you wish to change 

the TIBCO Rendezvous daemon for your adapter, you can globally set it to a different 

value or override it from the command line. 

To use global variables in your project, follow these steps: 

1. In the project panel, select the Global Variables tab.
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The project panel is updated to display all currently defined global variables. Click 

Open Advanced Editor (pencil icon at the top left corner). You now have these 

choices:

— To assign or change a variable value, select that region and triple-click the variable. 

The variable expands so you can change either the variable name or the variable 

value. Press Enter when you’re done.

— To add a new global variable group, click the left most icon at the bottom of the 

dialog box. Specify the name of the group, then press Enter. With the group icon 

selected, you can click the abc icon to add variables to the group. 

— To add a global variable, click the abc icon. A new global variable item is added to 

the bottom of the list. Supply the variable name and, optionally, the value. Press 

Enter when you’re done. 

The global variable is now displayed in the global variables list. 

2. When you want to use the global variable in the fields of a resource, enter the variable 

name surrounded by %% on both sides. 

When the project is deployed and the configured components are run, all occurrences 

of the global variable name are replaced with the global variable value (unless it was 

overridden in a way that had higher precedence). 

A number of global variables are predefined. See Predefined Global Variables on 

page 146 for information. You may add definitions of any variables you need to the 

predefined variables.

Changing Global Variable Values at Runtime

You can change the value of a global variable when you deploy your project in TIBCO 

Administrator. See the section on modifying runtime variables in the TIBCO 

Administrator User’s Guide for more information on using TIBCO Administrator. 

You can also specify values for global variables when starting a process engine on the 

command line. To do this, specify the following as a command line argument when 

starting the process engine:

-tibco.clientVar.variablePathAndName value

where variablePathAndName is the name of the variable you wish to set, including the path 

to the variable if it is contained in a folder. value is the value you wish to set the variable to. 

For example, if you have a global variable named item1 contained in a folder named myGroup 

and you wish to set its value to 500, add the following argument to the command line when 

starting the process engine:

-tibco.clientVar.myGroup/item1 500
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Predefined Global Variables

Table 42 lists and explains the predefined global variables. Some global variables are 

automatically used within the system when an adapter instance is configured.

Table 42   Predefined Global Variables (Sheet 1 of 4)

Variable Description

General Global Variables 

Deployment Defaults to the TIBCO Designer project name. This global variable is 

used by the system to partially define the subject name defined for a 

service.

DirLedger Used by the system when defining the path name of the TIBCO 

Rendezvous certified messaging ledger file. The default is root 

installation directory.

DirTrace Used by the system to partially create the path name for log file used by 

the adapter. The default is the root installation directory. 

Domain The default value is MyDomain. This value can be any string value. This 

global variable is used by the system to partially define the subject name 

defined for a service.

Env Included for backward compatibility. Do not use.

HawkEnabled Used by the system to indicate whether TIBCO Hawk is used to monitor 

the adapter. True indicates that a Hawk microagent is defined for the 

adapter. False indicates the microagent is not to be used.

JmsProviderUrl Tells applications where the JMS daemon is located. Setting this value 

mostly makes sense in early stages of a project, when only one JMS 

daemon is used.

JmsSslProviderUrl  Specifies where the JMS SSL daemon is located. 

RemoteRvDaemon Used by the system to identify the TIBCO Rendezvous routing daemon. 

See TIBCO Rendezvous Administration for details about specifying the 

routing daemon name.

RvDaemon Used by the system to identify the TIBCO Rendezvous daemon 

parameter. The parameter instructs the transport object about how and 

where to find the Rendezvous daemon and establish communication. 

The default value is 7500, which is the default value used by the 

Rendezvous daemon. See TIBCO Rendezvous Concepts for details 

about specifying the daemon parameter.
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RvNetwork Used by the system to identify the TIBCO Rendezvous network 

parameter. Every network transport communicates with other transports 

over a single network interface. On computers with more than one 

network interface, the network parameter instructs the TIBCO 

Rendezvous daemon to use a particular network for all outbound 

messages from this transport. See TIBCO Rendezvous Concepts for 

details about specifying the network parameter.

RvService Used by the system to identify the TIBCO Rendezvous service 

parameter. The Rendezvous daemon divides the network into logical 

partitions. Each transport communicates on a single service; a transport 

can communicate only with other transports on the same service. See 

TIBCO Rendezvous Concepts for details about specifying the service 

parameter.

RvaHost Used by the system to identify the computer on which the TIBCO 

Rendezvous agent runs. See TIBCO Rendezvous Administration for 

details about specifying the rva parameters.

RvaPort Used by the system to identify the TIBCO Rendezvous agent TCP port 

where the agent listens for client connection requests. See TIBCO 

Rendezvous Administration for details about specifying the rva 

parameters.

TIBHawkDaemon Used by the system to identify the TIBCO Hawk daemon parameter. 

See the TIBCO Hawk Installation and Configuration manual for details 

about this parameter. 

TIBHawkNetwork Used by the system to identify the TIBCO Hawk network parameter. 

See the TIBCO Hawk Installation and Configuration manual for details 

about this parameter.

TIBHawkService Used by the system to identify the TIBCO service parameter. See the 

TIBCO Hawk Installation and Configuration manual for details about 

this parameter.

Table 42   Predefined Global Variables (Sheet 2 of 4)

Variable Description
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TIBCO ActiveMatrix Adapter for PeopleSoft Global Variables

adpsft8.connection.appse

rver

Used by the system to identify the computer on which the PeopleSoft 

application server runs. 

adpsft8.connection.login Used by the system to identify the username to log in the PeopleSoft 

server.

adpsft8.connection.pass

word

Used by the system to identify the password to log in the PeopleSoft 

server.

adpsft8.connection.port Used by the system to identify the PeopleSoft application server port.

adpsft8.message.http.por

t

Used by the system to identify the message port.

adpsft8.multithread.num

ber

Used by the system to identify the number of connections to be opened 

with the PeopleSoft application server by the adapter. This variable is 

applied to the Number Of Threads field in the General Tab when you 

configure an adapter instance.

See also: General Tab on page 86.

adpsft8DTAJmsProvider

URL

Used by the system to identify the TIBCO EMS server address.

adpsft8DTARvDaemon Used by the system to identify the TIBCO Rendezvous daemon 

parameter to connect to the design-time adapter. The parameter 

instructs the transport object about how and where to find the 

Rendezvous daemon and establish communication. See TIBCO 

Rendezvous Concepts for details about specifying the daemon 

parameter.

adpsft8DTARvNetwork Used by the system to identify the TIBCO Rendezvous network 

parameter to connect to the design-time adapter. Every network 

transport communicates with other transports over a single network 

interface. On computers with more than one network interface, the 

network parameter instructs the TIBCO Rendezvous daemon to use a 

particular network for all outbound messages from this transport. See 

TIBCO Rendezvous Concepts for details about specifying the network 

parameter.

Table 42   Predefined Global Variables (Sheet 3 of 4)

Variable Description
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adpsft8DTARvService Used by the system to identify the TIBCO Rendezvous service 

parameter used to connect to the design-time adapter. The Rendezvous 

daemon divides the network into logical partitions. Each transport 

communicates on a single service; a transport can communicate only 

with other transports on the same service. See TIBCO Rendezvous 

Concepts for details about specifying the service parameter.

Table 42   Predefined Global Variables (Sheet 4 of 4)

Variable Description
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Setting Encoding Options

See TIBCO ActiveMatrix Adapter for PeopleSoft Concepts for an introduction to 

Internationalization topics such as Unicode and how adapters handle it.

The wire format encoding used for communication between adapters and TIBCO 

applications is determined by the encoding property set in the project. Configure 

inter-communication encoding prior to running the adapter so it can handle files in 

different encoding.

The adapter configuration can be saved in a local or repository server-based project.

• If the adapter configuration is saved in a repository server-based project, 

inter-communication encoding is determined by the repo.encoding property in the server's 

config file. Each adapter or TIBCO application that uses the repository server for 

storing and retrieving configuration data from a project uses this encoding setting 

when communicating. This assures that all components (including adapters and other 

TIBCO applications) that use the same repository also use the same encoding value to 

communicate. The repo.encoding property value can be ISO8859-1 (the default) or 

UTF-8. If English or other Latin-1 language data is transmitted between adapters, 

ISO8859-1 should be used. Otherwise use UTF-8.

• If an adapter configuration is saved in a local project, the inter-communication 

encoding is determined by the encoding property of the local project file. To 

communicate with other adapters using the same encoding, all adapters and 

applications must set their local project file encoding property identical. Use the 

Repository Finder in TIBCO Designer to set the encoding property for a local project. The 

default encoding is Latin-1.

When a local project is later promoted to a repository server-based project, the encoding 

property set in the project file is superseded by the server's encoding property.

The encoding property discussed above is the encoding used by the communication 

between adapters and applications, not the encoding used for the persistent storage of the 

project files. Project files are always saved using UTF-8.
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Configuring a Remote Adapter

If only TIBCO Designer is installed on your computer but the adapter is installed on a 

remote computer, you can still configure the adapter from your computer, as long as the 

remote computer has a PeopleSoft client.

To do this:

1. Copy the two TIBCO ActiveMatrix Adapter for PeopleSoft palette files (adpsft8palette.dat 

and adpsft8palette.jar), located in TIB_ADPSFT8_HOME\lib\palettes, from the remote 

computer to your computer.

2. Go to the TIBCO_HOME\Designer\designer_version_number\bin directory and open the designer.tra 

file. Modify the path specified for the property that enables Designer to find the 

adapter’s palette as shown:
#application.args -d

java.property.palettePath

TIB_ADPSFT8_HOME/lib/palettes

Save and close the designer.tra file.

3. Open the project in TIBCO Designer. In the project tree panel, select the PeopleSoft 

Adapter Configuration icon and configure it as required. This icon represents the 

remote adapter configuration.
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Running Multiple Design-Time Adapters

A single design-time adapter can support multiple simultaneous connections to the 

PeopleSoft Application Server and can serve multiple TIBCO Designers simultaneously. 

If, however, your circumstances require multiple design-time adapters to be running, you 

can modify adapter software so that another design-time adapter can run using another 

TIBCO Rendezvous port (for the DTA using TIBCO Rendezvous) or another JMS 

Provider url (for the DTA using TIBCO JMS).

To do this:

1. If the design-time adapter is running, stop it.

2. Edit the design-time adapter properties file to set the required connection parameters. 

For details on setting design-time adapter connection parameters see Modifying DTA 

Rendezvous Connection Parameters on page 139 or Modifying the DTA JMS 

Connection Parameters on page 141.

3. Open the required project in TIBCO Designer, select the Global Variables tab and set 

the values of the following predefined global variables to those specified in the 

design-time adapter properties file:

— adpsft8DTARvDaemon

— adpsft8DTARvNetwork

— adpsft8DTARvService

4. Start the design-time adapter and proceed with project configuration on TIBCO 

Designer using the new instance of design-time adapter.
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Multi-threading and Deployment

The adapter maintains a pool of threads allowing the adapter to respond to and process 

multiple events simultaneously, thereby improving the performance of the adapter. The 

threads are shared across all the services configured in a particular instance. Each thread 

creates its own session with the PeopleSoft Application Server. The number of 

connections can be configured using the Number of Threads field (see General Tab on 

page 86). 

PeopleSoft’s Component Interfaces are thread-safe but not instance-safe. Hence, it is 

advisable not to run multiple instances of the Subscription Service or Request-Response 

Service if the incoming messages would insert or update the same record.

Do not run more than one adapter instance configured for Publication Service against the 

same record in a PeopleSoft database, because this may result in race condition when the 

services are trying to manipulate the same record. However, the adapter instances work 

well if the Publication Service of each running instance is configured for different 

component interfaces.
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Using the Operation Code Feature

The adapter, running as a Publication Service, is capable of capturing the mode of 

operation of the outbound transaction. This mode is published out as a property of the 

outgoing schema. The name of the property is OpCode and its valid values are:

A — Add

U — Update

L — Update All

C — Correction

In a typical business scenario, if a record is updated in a PeopleSoft system A, this update 

needs to be replicated in another PeopleSoft system B. The OpCode property is published 

out as a part of the outbound schema from the adapter for System A. The mapping 

component (TIBCO IntegrationManager, etc.) is used to map the OpCode properties of the 

inbound and outbound schemas. The adapter for System B, running as a Subscription 

Service, uses this property as an input for processing the inbound transaction.

The Operation Code feature is not available for the 4.x adapter. However its presence in 

the configuration will not affect 4.x adapter functionality.
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Using the Adapter with a Revision Control System

TIBCO Designer supports revision control systems such as MicroSoft Visual SourceSafe 

and Perforce. If you are using a revision control system, you must manually add some 

configured resources to the revision control system and check in the resources when 

completing the instance configuration. 

As part of service configuration, the adapter creates schema files in 

root/AESchemas/ae/PeopleSoft. For example, if you configure a service in an adapter 

configuration Instance1, the following files are created:

Project_root/AESchemas/ae/PeopleSoft/Instance1.aeschema

Project_root/AESchemas/ae/PeopleSoft/Instance1/businessObjects.aeschema
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When the project is saved and a revision control system has been specified, the adapter 

displays a warning that additional files were created and should be added to the revision 

control system. This warning appears only when the files are created for the first time. The 

warning displays a Go To Resource button that helps in navigating to the resource. You should 

use the Multi-User>Add Resources to RCS menu command to add these files to the revision 

control system.
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For information about how to use the Multi-User feature in TIBCO Designer, see TIBCO 

Designer User’s Guide.

Copy, Cut, Paste and Move Operations

To successfully copy and paste a service from adapter Instance1 to Instance2, the adapter 

configuration and schema files for the Instance2 must be checked out.

To successfully cut and paste a service from adapter Instance1 to Instance2, the adapter 

configuration and schema files for both Instance1 and Instance2 must be checked out.

To successfully move a service from adapter Instance1 to Instance2, the adapter 

configuration and schema files for both Instance1 and Instance2 must be checked out.
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Implementation of Keys in the TIBCO Adapter for PeopleSoft

PeopleSoft Component Interfaces become schemas in the adapter. When applying a 

PeopleSoft Component Interface to a Subscription Service or a Request-Response Service 

in the adapter, the fields in the CREATEKEYS (if applicable), GETKEYS and 

FINDKEYS buckets in every Component Interfaces definition hold a special significance 

as described below.

FINDKEYS

The adapter exposes the FINDKEYS functionality of PeopleSoft Component Interface 

technology as a feature which can be used with the adapter's Request-Response Service. If 

the FINDKEYS values are specified in the incoming request, they take precedence over any 

GETKEYS or CREATEKEYS values specified. The adapter's Request-Response Service uses 

the same to query PeopleSoft and return a sequence of FINDKEY keys with values, which 

satisfy the query criterion, as a reply. Please note that any other part of the incoming 

request (GETKEYS, CREATEKEYS or PROPERTIES) is ignored.

Fields in FINDKEYS should be a superset of fields in GETKEYS() as the fields under these will 

decide the query criterion.

GETKEYS

The adapter primarily uses GETKEYS to update a particular record in PeopleSoft. For 

Request-Response Service, if the FINDKEYS values are not specified in the incoming 

request, the adapter looks for GETKEYS values. For a Subscription service, the adapter by 

default looks for GETKEYS and ignores the FINDKEYS completely.

If the GETKEYS values are specified (if not specified, see CREATEKEYS on page 159), the 

adapter queries PeopleSoft to check if the record exists. If the record exists, the adapter 

updates that record in PeopleSoft fields with values specified under the PROPERTIES keys.

The GETKEYS keys should be a subset of the FINDKEYS keys. This is to avoid an error 

scenario wherein the adapter is trying to search a record with a key which is not a part of 

FINDKEYS in the CI definition.

If the record does not exist, the adapter looks for CREATEKEYS (in such a scenario see 

CREATEKEYS on page 159).
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CREATEKEYS

The adapter primarily uses CREATEKEYS to create a record in PeopleSoft. If neither 

GETKEYS nor FINDKEYS are specified in the incoming requests (or due to the conditions 

arising out of the two scenarios described in GETKEYS), the adapter looks for CREATEKEYS 

in the incoming request. 

If specified, the adapter queries PeopleSoft to check if the record already exists. If the 

record is not found, the adapter creates a new record with the CREATEKEYS fields as 

primary fields and PROPERTIES keys as values for the non-primary fields. If the record 

already exists, an error is thrown by the adapter saying CREATEKEYS failed.

The CREATEKEYS should be a subset of the FINDKEYS keys. This is to avoid an error 

scenario wherein the adapter is trying to search a record with a key which is not a part of 

FINDKEYS in the CI definition.

Each CI can have multiple levels up to Level 3. In this case, the adapter mandates the 

occurrence of key fields at all levels in this scenario for performing the CREATE, UPDATE, 

DELETE or FIND operations successfully at all levels.

In case of the Publication Service (CI based as well as Application Messaging based), the 

adapter populates the PROPERTIES with the values extracted from the parsed XML 

(obtained from the TIB_CI_MQUEUE table). The GETKEYS, CREATEKEYS or FINDKEYS hold no 

significance whatsoever.

Valid Operation Codes for the Adapter

PeopleSoft Component Interface can have multiple levels up to Level 3. The adapter can 

INSERT, UPDATE or DELETE the records at all these levels. In these case, the key fields should 

be present at all levels and the user needs to provide the operation code at all levels. 

Valid values for OPRN_CODE for CREATEKEYS and GETKEYS scenario are:

• UPDATE — U

• INSERT — I

• DELETE — D

CREATEKEYS Scenarios

For all CREATEKEYS scenarios, specify I as the value for OPRN_CODE for all the records in 

the request.

GETKEYS Scenarios

1. To update details of an existing record, specify U as the value for OPRN_CODE at all 

levels.
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2. To insert a new record under an existing record, specify I as the OPRN_CODE for the 

record to be inserted. If the new record to be inserted is not a Level1 record, specify U 

as the OPRN_CODE for the parent record(s) under which the new record is inserted in the 

following format:

Level1 record    - 'U'

Level2 record   - 'I'

3. To delete a record under an existing record, specify D as the OPRN_CODE for the record 

to be deleted. If the record to be deleted is not a Level1 record, specify U as the 

OPRN_CODE for the parent record(s) from which the record is to be deleted in the 

following format:

Level1 record    - 'U'

Level2 record   - 'D'

4. While inserting a new Level1 record with Level2 and Level3 records under it, specify 

the value for the OPRN_CODE in the following format:

Level1 record    - 'I'

Level2 record   - 'I'

Level3 record - 'I'

For some CIs, PeopleSoft by default creates child records while inserting a new 

record. For example, while inserting a new Level1 record for some CIs, PeopleSoft 

creates Level2 and Level3 records by default. In such a scenario specify the value for 

the OPRN_CODE in the following format:

Level1 record    - 'I'

Level2 record   - 'U'

Level3 record - 'U'
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Compressing JMS Messages

JMS message compression is a service-level option. It is especially useful when messages 

are to be stored on the TIBCO Enterprise Message Service server, including persistent 

queue messages, or topics with durable subscribers. Enabling compression ensures that 

messages occupy less memory in storage and are handled faster by the TIBCO Enterprise 

Message Service server. When JMS messages are compressed and stored, they are 

handled by the server in the compressed form.

The compression option only compresses the body of a message. Headers and properties 

are never compressed. It is best to enable compression when the message bodies are large 

and the messages are to be stored on a server.

When messages are not to be stored, compression is not as useful. Compression normally 

takes time, and therefore the time to send or publish and receive compressed messages is 

generally longer than the time to send the same messages uncompressed. There is little 

purpose to message compression for small messages that are not to be stored by the server.

JMS message compression is only available for CI Publication Service, Message 

Publication Service, and Request-Response Invocation Service.

You can enable or disable this feature for message senders by using the JMS Compress 

drop-down list in the Configuration tab of a service. See Configuration Tab in the 

Configuration Options section of each of the three services in Chapter 5, Configuring 

Adapter Services.



TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

162 | Chapter 7  Configuring Advanced Topics



 TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

| 163

Chapter 8 Monitoring the Adapter Using TIBCO Hawk

This chapter explains how to use TIBCO Hawk microagents to monitor and manage the 

adapter.

Topics

• Overview, page 164

• Starting TIBCO Hawk Software, page 165

• The Auto-Discovery Process, page 166

• Invoking Microagent Methods, page 167

• Available Microagents, page 170
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Overview

TIBCO Hawk is a sophisticated tool for enterprise-wide monitoring and managing of all 

distributed applications and systems. System administrators can use it to monitor adapters 

in a wide area network of any size. TIBCO Hawk can be configured to monitor system and 

adapter parameters and to take actions when predefined conditions occur. These actions 

include: sending alarms that are graphically displayed in TIBCO Hawk Display, sending 

email, paging, running executables, or modifying the behavior of a managed adapter. 

Unlike other monitoring applications, TIBCO Hawk relies on a purely distributed 

intelligent agent architecture using Publication or Subscription to distribute alerts. TIBCO 

Hawk uses TIBCO Rendezvous for all messaging and thus gains the benefits and 

scalability from the TIBCO Rendezvous features of Publication or Subscription, subject 

name addressing, interest-based routing, and reliable multicast. 

TIBCO Hawk is a purely event-based system that uses alerts. The agents are configured 

with rules that instruct them on everything from what and how to monitor to what actions 

to take when problems are discovered. Thus the workload is fully distributed throughout 

the enterprise. Every agent is autonomous in that it does not depend on other components 

to perform its functions. 

TIBCO Hawk Enterprise Monitor consists of the following components:

The TIBCO Hawk Enterprise Monitor consists of following components:

• Display GUI front end that displays alarms and provides editors to create rule bases, 

create tests, view messages, and invoke microagents to request information or initiate 

an action.

• Agents Intelligent processes that perform monitoring and take actions as defined in 

rules.

• Rulebases Rules that are loaded by agents to determine agent behavior.

• Application Management Interface (AMI) Manages network applications via TIBCO 

Rendezvous and supports communication between a network application and 

monitoring TIBCO Hawk agents, including the ability to examine application 

variables, invoke methods, and monitor system performance.

• Microagents Feed information back to TIBCO Hawk and expose action methods to 

rulebases.
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Starting TIBCO Hawk Software

The TIBCO Hawk agent can be configured to start automatically during the system boot 

cycle. See the TIBCO Hawk Installation and Configuration guide for information about 

starting TIBCO Hawk. 

TIBCO Hawk Administrator’s Guide explains how to start TIBCO Hawk Display.
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The Auto-Discovery Process

After you start an instance of TIBCO Hawk Display, it continually discovers machines 

running TIBCO Hawk Agents on your network. Container icons are created for each 

agent, and arranged hierarchically in clusters. By default, agent icons are clustered 

according to subnets.

At first, the Agents container is empty. Its counter displays a value of zero and, on the 

right, the Discovered counter is also at zero. Both icons are initially green in color to show 

that no alerts, or warning messages, are in effect. As agents are discovered, the counters 

increment to reflect the current number of discovered agents:

Figure 27   TIBCO Hawk Enterprise Monitor

Monitored network nodes are arranged in a hierarchical tree of containers. Clicking a 

container in the left panel displays nested items on the right.

Icon colors change to reflect the highest level of alert found on discovered agents. For 

explanations of icon elements and characteristics, see TIBCO Hawk Administrator’s 

Guide.
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Invoking Microagent Methods

A set of default microagents, platform-specific and platform-independent, is loaded when 

a TIBCO Hawk Agent is started. When you install and start the TIBCO ActiveMatrix 

Adapter for PeopleSoft, microagents for the adapter are dynamically added to the local 

agent.

To invoke a microagent method on a TIBCO Hawk Agent, follow these steps:

1. In TIBCO Hawk Display, right-click on the agent icon and select Get Microagents.

If TIBCO Hawk security is implemented on your system and you do not have access 

to microagents on this agent, an error dialog displays. Select another agent, or contact 

your system administrator to obtain access.

2. The Microagents, Methods and Arguments dialog displays. The panel on the upper 

left lists microagents you can access on the current agent.

Figure 28   Microagents, Methods and Arguments Dialog

This dialog has two modes, Invoke and Subscribe. Invoking a method immediately 

returns a single set of current results. Subscribing provides updates of current results 

at regular intervals. Radio buttons at the bottom of the dialog control these modes.

3. Click a microagent name, such as Self, to display a list of associated methods and text 

descriptions in the panels below.
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4. Click the name of the method to invoke, such as getMicroAgentInfo, as shown in 

Figure 29.

Figure 29   Select Microagent and Method

If the method accepts arguments, fields for each argument display in the upper right 

panel. Detailed help text displays in the lower panel.

5. Specify any arguments for the method invocation.

6. Verify that the Invoke radio button is selected.

7. Click the Invoke button to invoke the selected method. The Invocation Results dialog 

displays the results returned by the method, as shown in Figure 30.
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Figure 30   Invocation Result Dialog

8. Click the Done button to close the dialog.

These steps describe how to interactively invoke a microagent method and receive a single 

set of results in TIBCO Hawk Display. You can also use a microagent method as the data 

source of a TIBCO Hawk rule. Rules automatically receive method results, apply tests to 

evaluate them, then take action if necessary. For more information on building TIBCO 

Hawk rules and rule bases, see your TIBCO Hawk Administrator’s Guide.
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Available Microagents

Each adapter has two microagents, a standard TIBCO Hawk microagent named 

COM.TIBCO.ADAPTER.xyz where xyz is the adapter configuration name and a custom 

microagent. 

The microagents provide:

• Business level statistics—statistics that report the progress of the adapter as it interacts 

with PeopleSoft. For example, in a database adapter such statistics might indicate 

whether objects were successfully or unsuccessfully inserted, updated, or deleted in 

the database.

• Queries that return information about the state of the adapter. This can be an important 

tool for seeing the internals of an adapter and debugging it if something appears 

wrong. For example, methods can return information about threads, internal queues, 

or connections to the target system. Using these methods, one might be able to 

identify certain bottlenecks or gauge how successfully an adapter is scaling with 

respect to the current environment.

• Updates of the adapter runtime parameters. This includes retrieving the current 

runtime parameters and setting new runtime parameters without restarting the adapter. 

An example of this is getting and setting the polling interval. Updating a runtime 

parameter through the Hawk microagent only affects the setting of the instance that is 

running. It does not make a permanent change of the setting in either the repository or 

the .tra file.

By default, all microagents are available at runtime.

perfMon property value set in the adapter’s property file affects the business statistics related 

methods. If this property is set to on, the adapter does all the performance related 

calculations. When you invoke the methods, if the perfMon property is set to off, default 

values are displayed and not the valid values.

You can disallow adding custom methods to the class microagent when deploying the 

adapter by changing the addCustomHawkMethodstoClassMAgent property value in the adapter’s 

property file. If this property is set to on, custom methods are added to the class 

microagents. If set to off, these methods are not visible.

Table 43 and Table 44 lists each standard method available for the adapter..

Custom microagents are deprecated in this release. All business statistics related methods 

which were part of the custom microagent are now available in the class microagent.
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Table 43   Standard Microagent Methods

Method Description

activateTraceRole() Activates a mapping of a role to a sink at runtime.

deactivateTraceRole() Deactivates a mapping of a roles to sinks at runtime.

getAdapterServiceInformation() Returns information about the services implemented by this 

adapter.

getComponents() Returns information about the publisher, subscriber and 

IODescriptor.

getConfig() Returns basic configuration information. More specific 

information is accessed by the more specific methods. 

getConfigProperties() Returns all attributes and elements for the given repository 

object.

getRvConfig() Returns information about all TIBCO Rendezvous sessions 

defined. 

getStatus() Returns general status information, such as the number of 

TIBCO Rendezvous messages received and published, the 

number of errors since the last call, the PID of the 

application, and more. 

getTraceSinks() Returns information about sinks to which traces currently 

go.

getVersion() Returns the configuration ID, application name, version, 

and date for this adapter instance. 

_onUnsolictedMsg() Displays alert messages sent to the current adapter.

preRegisterListener() Preregisters an anticipated listener.

resetConnectionStatistics( ) Resets all the counts for the connection statistics.

resetThreadStatistics() Resets all the counts for the thread statistics.

reviewLedger() Returns information retrieved from the ledger file of a 

certified messaging session for a publisher adapter.

setThreadNumber() (Component Interface only) Sets the number of 

connections to be opened with the PeopleSoft application 

server by the adapter.
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setTraceSinks() Adds a role or changes the file limit of a previously 

specified sink.

stopApplicationInstance() Stops the running adapter instance.

unRegisterListener() Unregisters a currently preregistered listener.

Table 44   Class Microagent Methods

Method Description

getActivityStatisticsBySchemaName() Returns the total number of objects processed for the 

given schema by each service that uses the schema.

getActivityStatistics() Returns the total number of objects processed for all the 

schemas.

getActivityStatisticsByOperation() Returns the total number of objects processed for all the 

schemas by each service that is associated with a 

specified operation.

getActivityStatisticsByService() Returns information about the services implemented by 

this adapter.

getConnectionStatistics() Returns the state and statistics for all the current 

connections used by the adapter.

getPerfMonSetting() Returns the setting of the perfMon option.

getQueueStatistics() Returns the current count of elements in any internal 

queue used by the adapter.

getThreadStatistics() Returns the operation counts of the current threads

getPollingInterval() Returns the current polling interval setting. 

setPollingInterval() Sets the polling interval for the publication service.

Table 43   Standard Microagent Methods (Cont’d)

Method (Cont’d) Description (Cont’d)



 TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

activateTraceRole() | 173

activateTraceRole() 

Purpose Activates a mapping of a role to a sink at runtime. This replaces the now-deprecated 

setTraceSink() TIBCO Hawk method.

Parameters

Table 45   Input Parameters of activateTraceRole()

Input Parameters Type Description

roleName string Name of the role to activate.

sinkName string Name of the sink for which to activate the role.
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deactivateTraceRole() 

Purpose Deactivates a mapping of a roles to sinks at runtime.

Parameters

Table 46   Input Parameters of deactivateTraceRole()

Input Parameters Type Description

roleName string Name of the role to deactivate.

sinkName string Name of the sink for which to deactivate the role.
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getActivityStatistics()

Purpose Returns the total number of objects processed for all the schemas, based on the request 

type. Also, returns the number of success and error objects.

Parameters

Returns

Table 47   Input parameter of getActivityStatistics()

Input Parameter Type Description

GetSubTotalBy string Indicates how to group the subtotals, by Service or 

Operation.

Table 48   Returns of getActivityStatistics()

Returns Type Description

Name string Service name or All Services which represents the 

final tally of all the services.

Total integer Total number of objects processed including both 

success and failures.

Success integer Total number of objects successfully processed.

Failure integer Total number of objects that caused an error during 

processing.

MeasurementInterval integer Displays the time (in seconds) since last time the 

adapter was reset, or if never reset, since the 

adapter started.
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getActivityStatisticsByOperation()

Purpose Returns statistics about one operation.

Parameters

Returns

Table 49   Input parameter of getActivityStatisticsByOperation()

Input Parameter Type Description

Operation string Name of the operation.

Table 50   Returns of getActivityStatisticsByOperation()

Returns Type Description

Operation string Name of the operation.

Service Name string Name of the service.

Total integer Total number of objects processed, both success 

and failures.

Success integer Total number of objects successfully processed.

Failure integer Total number of objects that caused an error 

during processing.

MeasurementInterval integer Displays the time (in seconds) since last time the 

adapter was reset, or if never reset, since the 

adapter started.

LineIndex string Concatenated string of Service Name and Operation 

separated by a comma.
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getActivityStatisticsByService()

Purpose Returns statistics about the data handled by a given adapter service or all adapter services 

since the time the adapter was started.

Parameters

Returns

Table 51   Input parameter of getActivityStatisticsByService()

Input parameter Type Description

Service Name string Name of service to get the statistics for. If no service 

name is given, performance statistics for all services is 

returned.

Table 52   Returns of getActivityStatisticsByService()

Returns Type Description

Service Name string Service name.

Schema Name string Name of top level schema processed by this service.

Operation string Type of operation this service provides.

Total integer Total number of objects processed, both success and 

failures.

Success integer Total number of objects successfully processed.

Failure integer Total number of objects that caused an error during 

processing.

MeasurementInterval integer Displays the time (in seconds) since last time the 

adapter was reset, or if never reset, since the adapter 

started.

LineIndex string Concatenated string of Service Name and Operation 

separated by a comma.
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getAdapterServiceInformation() 

Purpose Returns information about the services implemented by this adapter. The information is a 

summary of available adapter services.

Parameters

Returns

Table 53   Input parameter of getAdapterServiceInformation()

Input Parameter Type Description

serviceName string Name of the service from which to get information. 

Default is ALL.

Table 54   Returns of getAdapterServiceInformation()

Returns Type Description

Line integer Sequential row number.

ServiceName string Name of the service as defined at design-time.

EndpointName string Name of the endpoint used for this service.

Type string Type of the endpoint, for example, publisher or 

subscriber.

Quality of Service string Quality of service for the endpoint. For example, 

RVCM or JMS Persistent.

Subject string Subject defined for this endpoint. 

Class string Class associated with the endpoint.

Number of Messages integer Number of messages processed for this endpoint.
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getComponents()

Purpose Returns information about the currently active TIBCO Hawk components such as 

publishers, subscribers, or timers.

Parameters

Returns

Table 55   Input Parameters of getComponents()

Input Parameters Type Description

Component Name string Name of the component. If no value is provided, all 

components are displayed.

Component Type string Any of Publisher, Subscriber, Timer, or IODescriptor. The 

default value is All.

Table 56   Returns of getComponents()

Returns Type Description

Instance ID string Name of this adapter instance as defined at design 

time.

Adapter Name string Name of the adapter.

Component Name string Name of the component.

Component Type string The name of the TIBCO Adapter SDK class for this 

component, such as MPublisher, MSubscriber, or 

MIODescriptorSource. For more information about the 

class, see your TIBCO Adapter SDK documentation.

Session Name string Name of the session.

Description string Information about this component, for example, time 

interval, signal type, validating the publisher or 

subscriber.
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getConfig()

Purpose Retrieves generic configuration information. More specific configuration information is 

accessed through separate methods.

Returns

Table 57   Returns of getConfig()

Returns Type Description

Instance ID string Configuration ID of this adapter.

Adapter Name string Name of the adapter.

Repository 

Connection

string URL of the repository used for adapter instance.

Configuration URL string Location of the adapter project; either a file name or 

configuration URL.

Command string Command line arguments used to start the adapter.
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getConfigProperties()

Purpose Returns all attributes and elements for the given repository object.

Parameters

Returns

Table 58   Input parameter of getConfigProperties()

Input Parameter Type Description

Property string Name of the property for which elements (tags) and 

attributes are desired. For example, agentone/startup.

If no value is given, all properties are returned.

Table 59   Returns of getConfigProperties()

Returns Type Description

Element Name string Repository directory for the property.

Attribute Name string Name of the repository object attribute.

Attribute Value string Value of the repository object attribute.

Line integer Line number in which this property is defined in the 

project file.
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getConnectionStatistics()

Purpose Returns the state and statistics for all the current connections used by the adapter.

Returns

Table 60   Returns of getConnectionStatistics()

Returns Type Description

Connection ID string Unique identification of a particular connection.

Connection Type string Type or key that will match this connection to a 

thread or queue.

State string Current state: UP, RETRYING, POLLING, 

DOWN, or UNKNOWN. 

The UNKNOWN state is returned when the 

perfMon property is set to OFF. 

NumRetries integer Total number of times this connection had to be 

reestablished.

TotalNumOperations integer Total number of operations processed by this 

connection since the adapter started.

CurrentNumOperatio

ns

integer Total number of operations processed by this 

connection since the last reconnection.

NumLostConnections integer Total amount of time that this connection has 

been lost.

MeasurementInterval integer Displays the time (in seconds) since last time 

the adapter was reset, or if never reset, since the 

adapter started. 
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getQueueStatistics()

Purpose Returns the current count of elements in any internal queue used by the adapter. This 

includes the TIBCO Rendezvous event queues automatically spawned by Rendezvous for 

each adapter.

Returns

Returns the current count of elements in any internal queue used by the adapter. This 

includes the TIBCO Rendezvous event queues automatically spawned by Rendezvous for 

each adapter.

Table 61   Returns of getQueueStatistics()

Returns Type Description

QueueID string Unique identification of a particular queue.

QueueType string Type or key that will match this queue to a thread or 

connection.

QueueCount integer Current number of elements in the queue.

MaxQueueSize integer Maximum number of elements in the queue.

MeasurementInterval integer Displays the time (in seconds) since last time the 

adapter was reset, or if never reset, since the adapter 

started.
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getRvConfig()

Purpose Returns information about the TIBCO Rendezvous session defined by this adapter.

Parameters

Returns

Table 62   Input parameter of getRvConfig()

Input Parameter Type Description

Session Name string Name of the TIBCO Rendezvous session for which 

configuration is required. If not given, information about 

all currently defined sessions is returned. The default is 

all.

Table 63   Returns of of getRvConfig()

Returns Type Description

Instance ID string The configuration ID of this adapter.

Adapter Name string Name of the adapter.

Session Name string Name of the session.

Service string Service parameter for this session.

Daemon string Daemon parameter for this session.

Network string Network parameter for this session.

Synchronous boolean Returns 1 if this is a synchronous session, 0 otherwise.

Session Type string Type of session; one of M_RV, M_RVCM, or M_RVCMQ.

Certified Name string Name of this certified session.

Ledger File string Ledger file for this certified messaging session. Returns 

the empty string for sessions that are not certified 

messaging sessions.

CM Timeout string Timeout for this certified messaging session. Returns 

the empty string for sessions that are not certified 

messaging sessions.
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getStatus()

Purpose Retrieves basic status information about the adapter.

This information is fairly limited. Additional methods are provided ingetConfig() on 

page 180 and getRvConfig() on page 184.

Returns

Table 64   Returns of getStatus()

Returns Type Description

Instance ID string Configuration ID for this adapter instance.

Adapter Name string Name of the adapter.

Uptime integer Number of seconds since startup.

Messages Received integer Number of TIBCO Rendezvous messages received.

Messages Sent integer Number of TIBCO Rendezvous messages published.

New Errors integer Number of errors since the last call to this method.

Total Errors integer Total number of errors since startup.

Process ID integer Process ID of the application.

Host string Name of host machine on which this adapter is 

running.
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getThreadStatistics()

Purpose Returns the operation counts of the current threads.

Returns

Table 65   Returns of getThreadStatistics()

Returns Type Description

ThreadID string Unique identification of a particular thread.

ThreadType string Type that tells what part of the adapter this thread 

belongs to. Valid types include "Publisher", 

"Subscriber", "RPC", or "Connection".

TaskType string One-word description of the tasks this thread 

processes.

TaskCount integer Number of tasks processed by this thread.

MeasurementInterval integer Displays the time (in seconds) since last time the 

adapter was reset, or if never reset, since the adapter 

started.
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getTraceSinks()

Purpose Returns information about sinks to which traces currently go.

Parameters

Returns

Table 66   Input Parameters of getTraceSinks()

Input Parameters Type Description

Sink Name string Name of the sink for which you need information. If 

no name is specified, information about all sinks is 

returned. Default is all.

Role Name string Name of the role for which you need information for 

the specified sink or sinks. Default is all.

Table 67   Returns of getTraceSinks()

Returns Type Description

Instance ID string Name of this adapter instance as a string.

Adapter Name string Name of the application for this sink.

Sink Name string Name of the sink.

Sink Type string Type of this sink. One of fileSink, rvSink, hawkSink, 

stderrSink.

Roles string Roles this sink supports, as a string. For example 

“warning, error, debug”.
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getVersion()

Purpose Retrieves version information for the current application. Two lines may be returned, one 

for the TIBCO Adapter SDK, one for the adapter.

Returns

Table 68   Returns of getVersion()

Returns Type Description

Instance ID string The configuration ID as a string, for example SDK.

Adapter Name string Name of the adapter as a string, for example agentone.

Version string Version number as a string, for example 1.1.
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_onUnsolictedMsg()

Purpose Displays all alert messages sent from the adapter or an error if not successful.
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preRegisterListener()

Purpose Preregisters an anticipated listener. Some sending applications can anticipate requests for 

certified delivery even before the listening applications start running. In such situations, 

the sender can preregister listeners, so TIBCO Rendezvous software begins storing 

outbound messages in the sender’s ledger. If the listening correspondent requires old 

messages, it receives the backlogged messages when it requests certified delivery.

Parameters

Returns OK if the listener was preregistered successfully, false otherwise.

Table 69   Input Parameters of preRegisterListener()

Input Parameters Type Description

Session Name string Name of the session that anticipates the listener.

Publisher Name string Name of the component for which the listener 

should be preregistered.

Listener Session Name string Name of the listener to preregister.
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resetConnectionStatistics( )

Purpose Resets all the counts for the activity statistics.
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resetThreadStatistics()

Purpose Resets all the counts for the thread statistics.
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reviewLedger()

Purpose Returns information retrieved from the ledger file of a TIBCO Rendezvous certified 

messaging session.

Before invoking this method, ensure that the certified messaging publisher adapter has 

established a certified delivery agreement with its subscriber agents.

Parameters

Returns

Table 70   Input Parameters of reviewLedger()

Input Parameters Type Description

Session Name string Name of the TIBCO Rendezvous session for which 

ledger information is desired (default is all).

Subject string Name of the subject for which ledger information is 

desired.

Table 71   Returns of reviewLedger()

Return Type Description

Session Name string Name of the TIBCO Rendezvous CM session to 

which this information applies.

Subject string Subject name for this session.

Last Sent Message integer Sequence number of the most recently sent message 

with this subject name.

Total Messages string Total number of pending messages with this subject 

name.

Total Size integer Total storage (in bytes) occupied by all pending 

messages with this subject name.

If the ledger contains ten messages with this subject 

name, then this field sums the storage space over all of 

them.

Listener Session Name string Within each listener sub-message, the Listener 

Session Name field contains the name of the 

delivery-tracking listener session.
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Last Confirmed string Within each listener submessage, the Last Confirmed 

field contains the sequence number of the last message 

for which this listener session confirmed delivery.

Line integer Row number in ledger file.

UnacknowledgedMessa

ges

integer Number of RVCM messages pending for this listener. 

The value is computed by subtracting the last sent 

sequence number from the last acknowledged 

sequence number.

Table 71   Returns of reviewLedger() (Cont’d)

Return Type Description
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setThreadNumber()

Purpose (Component Interface only) Sets the number of connections to be opened with the PeopleSoft 

application server by the adapter.

This method dynamically updates the number of connections at runtime without restarting 

the adapter.

Note There is a lapse before the connection numbers are updated successfully. This is because 

the PeopleSoft server needs time to release the old connections and start the new ones.

Parameters

Table 72   Input Parameters of setThreadNumber()

Input Parameters Type Description

Thread Number integer Must be a positive value.
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setTraceSinks()

Purpose Adds a role or changes the file limit of a previously specified sink.

Parameters

Returns OK if successful or an error if not successful.

Table 73   Input Parameters of setTraceSinks()

Input Parameters Type Description

Sink Name string Name of the sink for which you want to add a role or 

change the file limit.

Role Name string Name of the role you want to add to this sink (warning, 

error, debug, or user defined). Default is all.

File Size integer Maximum file size for this sink.

This parameter is ignored if the sink specified by 

sinkName is not a file sink.
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stopApplicationInstance() 

Purpose Stops the specified adapter by calling the internal stop() method.

Returns OK if successful or an error if not successful.
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unRegisterListener() 

Purpose Unregisters a currently preregistered listener.

Parameters

Returns True if the listener was unregistered successfully, false otherwise.

Table 74   Input Parameters of unRegisterListener()

Input Parameters Type Description

Session Name string Name of the session that anticipates the listener.

Publisher Name string Name of the component for which the listener should 

be preregistered.

Listener Session Name string Name of the listener to unregister.
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getActivityStatisticsBySchemaName()

Purpose Returns the total number of objects processed for the given schema by each service that 

uses the schema. Also, returns the number of success and error objects.

Parameters

Returns

Table 75   Input parameter of getActivityStatisticsBySchema()

Input Parameter Type Description

Schema Name string Name of the schema.

Table 76   Returns of getActivityStatisticsBySchema()

Returns Type Description

Service Name string Name of the service that is associated with the 

specified schema.

Total string Total number of objects processed for this schema 

for a Publication Service.

Total number of objects received for this schema 

for a Subscription Service.

Success string Number of objects that were successfully 

identified for this schema, which will be 

published or written to a file.

Failure string Number of objects that were identified for this 

schema but were not published because the header 

of the schema failed validation for a Publication 

Service, or was written to a file because the 

schema was not associated with a subscriber for a 

Subscription Service.
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getPerfMonSetting()

Purpose Returns the setting of the perfMon option.

Returns

Table 77   Returns of getPerfMonSetting()

Returns Type Description

Setting string Value of the perfMon option.
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getPollingInterval()

Purpose Returns the current polling interval setting.

Returns

Table 78   Return of getPollingInterval()

Return Type Description

PollingInterval integer Polling interval in milliseconds.
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setPollingInterval()

Purpose Sets the polling interval for the Publication Service.

Parameters

Table 79   Input Parameters of setPollingInterval()

Input Parameters Type Description

PollingInterval integer Polling interval in milliseconds.

ServiceName string Name of service where the polling interval is set.
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Appendix A Frequently Asked Questions

This appendix lists answers to the frequently asked questions.

Topics

• Frequently Asked Questions, page 206
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Frequently Asked Questions

The frequently asked questions are listed in this section. 

What is the TIBCO Runtime Agent?

The TIBCO Runtime Agent provides the runtime environment for TIBCO 

ActiveEnterprise components, that is, all the shared libraries including third-party 

libraries.

Can TIBCO Designer be brought from a UNIX command-line?

No. TIBCO Designer is a GUI based tool and a UNIX GUI environment is mandatory to 

run it. It cannot be brought up from a terminal.

Why does the connection to the Design-Time Adapter fail?

Ensure that the Design-Time Adapter has been started. Check the Design -Time 

Connection parameters specified.

When starting the adapter, what if the repository is not found?

Start the repository server before starting the adapter. If you are starting a remote 

repository ensure that repository server is installed on the remote location. Ensure that a 

properly configured .dat file is available in the path specified (local or remote). Ensure that 

the repourl has been specified accurately in the adapter’s .tra file.

Why does the adapter startup fail?

Either the repository file (.dat) is not placed in the install_path\tibco\repository\remoterepos 

directory, or the .dat file is not properly configured. Ensure that the repourl syntax has been 

specified accurately in the adapter’s .tra file. Ensure that the path specified for the .tra file is 

correct.

Why does the adapter startup fail, even after specifying the appropriate DAT file?

You must start the repository server before you start the adapter. If it is a remote repository 

ensure that the repourl syntax has been specified accurately in the adapter’s .tra file. Ensure 

that the path specified for the .tra file is correct.



 TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

Frequently Asked Questions | 207

When saving an adapter configuration to the project, if an error occurs where is it 
logged?

TIBCO Designer error messages are logged to the files stderr.log and designer.log under the 

TIBCO_HOME\Designer\ver\logs directory.

When an error occurs in a Subscription Service adapter service, where is it displayed?

Errors that occur in a request-response operation are sent to the client. Errors that occur in 

a subscription operation are logged to a trace file. The log file path and name is set in the 

.tra file corresponding to the adapter instance. All logs are sent to install_path\adapter\adaper 

name\version\logs unless otherwise specified.

Why does the adapter fail to respond to a request? 

The subject name may be inconsistent. The subject name to which the adapter listens may 

be different from that of the subject name of the client.

Why does the adapter fail to respond to a request after successfully receiving it?

The adapter may fail to respond due to various reasons like errors resulting from class 

mismatch, records not being available in the target application or, connectivity problems 

with the target application.
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Appendix B Trace Messages

This appendix explains the trace messages that are logged to a location specified at 

configuration time.

Topics

• Overview, page 210

• Trace Message Fields, page 212

• Status Messages, page 215
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Overview

Trace messages provide information about adapter activities. The messages are logged to 

the console where the runtime adapter was started and to a log file. Trace messages can 

also be redirected to TIBCO Hawk Display, or sent to other applications using the TIBCO 

Rendezvous transport. 

Each trace message can include the following fields: 

<Timestamp> <Adapter Identifier> <Role> <Category> <Status Code> <Tracking Identifier> 

The above fields are explained in Trace Message Fields, page 212. The following diagram 

shows an example trace message and calls out the fields.

Example Trace Messages

The following trace messages were written during a session where TIBCO ActiveMatrix 

Adapter for PeopleSoft received an object from TIBCO Adapter for R/3 and then 

processed the object.

The first message indicates that TIBCO Adapter for PeopleSoft has started successfully. 

The timestamp indicates when the adapter started, and the role indicates that the trace 

message is informational, which means the activity is normal for the adapter. The category 

is identified, and the corresponding status code is displayed.

2003 Mar 07 15:13:36:512 GMT +5 SubCancelPO Info [System] AEPS8-4003018 Adapter Initialized Successfully.... 

The second trace message indicates that the adapter received an object (in this case a 

Business Event).

2003 Mar 07 15:52:24:740 GMT +5 SubCancelPO Info [Adapter] AEPS8-4003005 Received an Event.

The third trace message indicates that the adapter is processing the event with the name 

FROM_SAP_CANCEL_PO.

2003 Mar 07 15:52:25:501 GMT +5 SubCancelPO Info [Adapter] AEPS8-4003006 Processing Business Event 

FROM_SAP_CANCEL_PO. 

2003 Feb 22 20:15:12:937 GMT -8 

PeopleSoftAdapter.PeopleSoftAdapterConfiguration Info [Adapter]

2003 Mar 07 15:13:36:512 GMT +5 SubCancelPO Info [System] 

tracking=#MU3oTJ/WWCV1MU96J0zzwA9kzzw#

Timestamp

Adapter Identifier Role Category

Status Code

Tracking Identifier

AEPS8-4003018 Adapter Initialized Successfully....
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The fourth trace message indicates that the adapter has successfully processed the event 

FROM_SAP_CANCEL_PO.

2003 Mar 07 15:52:33:833 GMT +5 SubCancelPO Info [Adapter] AEPS8-4003031 Finished Processing..: 

FROM_SAP_CANCEL_PO. 



TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

212 | Appendix B  Trace Messages

Trace Message Fields

Each trace message includes the following fields: 

Table 80   Tracing Fields (Sheet 1 of 3)

Field Name Description

Timestamp Timestamp of occurrence. For example, 2003 Feb 22 20:14:51:718 GMT -8.

Adapter Identifier Name of the adapter that wrote the trace message. This is a combination of the adapter 

acronym and adapter configuration name. For example, the application identifier, 

adpsft8.publisher1 identifies a TIBCO Adapter for PeopleSoft service named publisher1.

Role A role can be: 

• Info. Indicates normal adapter operation. No action is necessary. A tracing 

message tagged with Info indicates that a significant processing step was reached 

and has been logged for tracking or auditing purposes. Only info messages 

preceding a tracking identifier are considered significant steps.

• Warn. An abnormal condition was found. Processing will continue, but special 

attention from an administrator is recommended.

• Error. An unrecoverable error occurred. Depending on the error severity, the 

adapter may continue with the next operation or may stop altogether.

• Debug. A developer-defined tracing message. In normal operating conditions, 

debug messages should not display. 

When configuring the adapter you define what roles should or should not be logged. 

For example, you may decide not to log Info roles to increase performance.
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Category One of the following:

• Adapter. The adapter is processing an event.

• Application. The adapter is interacting with PeopleSoft.

• Configuration. The adapter is reading configuration information.

• Database. The adapter is interacting with a database.

• DTA. (Design-time adapter) The trace message if from the DTA.

• Metadata. The adapter is retrieving metadata from PeopleSoft.

• Palette. The adapter is interacting with the palette.

• Publisher Service. The publication service is reporting this trace message.

• Request-Response Client Service. The request-response invocation service is 

reporting this trace message.

• Request-Response Server. The request-response service is reporting this trace 

message.

• Shutdown. The adapter is shutting down.

• Startup. The adapter is starting.

• Subscription Service. The subscription service is reporting this trace message.

• System. This category is not linked to a specific event process. The trace message 

may be related to a Microsoft Windows service related messages, memory 

allocation, file system error, and so on.

• TibRvComm. The adapter is communicating with TIBCO Rendezvous.

• XML. The adapter is parsing XML documents.

Status Code Unique code for the message and description. Status codes are identified by a unique 

number and description. If a trace message includes an error or warn role, the status 

code documentation includes a resolution. See Status Messages on page 215 for 

details.

Tracking Identifier A unique identifier that is "stamped" on each message by the originating adapter. The 

tracking identifier remains in effect from a message’s beginning to its completion as it 

is exchanged by TIBCO applications. If the adapter is the termination point of the 

message, the tracking identifier is not displayed in the trace message.

You cannot modify the tracking identifier format or configure what information is 

displayed.

Table 80   Tracing Fields (Sheet 2 of 3)

Field Name Description
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Application 

Information

Application-specific information added to the tracking info to trace the message back 

to its source. Set initially by the originating adapter and carried forward. It is 

augmented by each intermediate component.

Table 80   Tracing Fields (Sheet 3 of 3)

Field Name Description
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Status Messages

In environments where multiple applications are used simultaneously, the possible status 

of messages increases as well. This chapter lists the various messages in numerical order.

Resolutions are provided wherever possible for error and warning messages. If there is no 

resolution provided, or if you need additional help, contact TIBCO Support at 

http://support.tibco.com.

Message Category Resolution

AEPS8-3400100 PSDTA ready to serve requests from Designer....

Information Metadata Indicates normal adapter operation. No action 

necessary.

AEPS8-3400101 Established connection to application server with parameters: opr %1, server 

%2.

Information Metadata Indicates normal adapter operation. No action 

necessary.

AEPS8-3400102 Sending discovery message to find other running instances of PSDTA on subject 

%1, service %2.

Information Metadata Indicates normal adapter operation. No action 

necessary.

AEPS8-3400103 Assuming master status.

Information Metadata Indicates normal adapter operation. No action 

necessary.

AEPS8-3400104 Received Reply to Discovery Request.

Information Metadata Indicates normal adapter operation. No action 

necessary.

AEPS8-3400105 SaveOperation successfully saved %1 publication service to PeopleSoft database.

Information Metadata Indicates normal adapter operation. No action 

necessary.
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AEPS8-3400106 Advisory Message %1  

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-3400107 The current adapter instance skipped the event %1 with sequence number %2 as 

it is locked

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-3400200 An instance of PSDTA is already available on %1.

Error Metadata Change DTA RV Service value

AEPS8-3400400 Connection to the app server failed with the following parameters : ID %1,  server 

and port %2.

Error Metadata Check connection parameters to the application 

server

AEPS8-3400401 Invalid Parameter used with reply.set or request.get

Error Metadata Make sure the schemas in the repository are 

configured properly.

AEPS8-3400403 Error while getting the list of CIs, check PeopleSoft Project'

Error Metadata Check permissions to TIB CIs

AEPS8-3400404 Error while appending Business component name to sequence.

Error Metadata Make sure the Design-time adapter is up.

AEPS8-3400405 Connection params %1 may be invalid or appserver may be down.

Error Metadata Check connection parameters to the application 

server

AEPS8-3400406 PeopleSoft generated a JOAException

Error Metadata Check if the PeopleSoft Application Server and the 

database are up.

Message Category Resolution
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AEPS8-3400407 Error while getting the list CI fields, check PeopleSoft Project.

Error Metadata Check PeopleSoft project

AEPS8-3400408 SDK operation error in getCIImpl.java.

Error Metadata Make sure that the Design Time Adapter is up.

AEPS8-3400409 A Component Interface does not exist for specified name %1.

Error Metadata Check if specified CI exists in PeopleSoft system

AEPS8-3400410 SDK operation error in saveOperation.java.

Error Metadata Make sure that the Design Time Adapter is up.

AEPS8-4001015 No Record Exists for the Specified Get Keys.

Information Application Indicates normal adapter operation. No action 

necessary.

AEPS8-4001016 Record Exists for the Specified Create Keys.

Information Application Indicates normal adapter operation. No action 

necessary.

AEPS8-4003000 Initializing Adapter....

Information System Initializing Adapter....

AEPS8-4003001 Loading Information From Repository.

Information Configuratio

n

Loading Information From Repository...

AEPS8-4003002 Connecting to Application Server.

Information Application Connecting to Application Server.

AEPS8-4003003 Registering hawk methods.

Information Configuratio

n

Registering hawk methods.

Message Category Resolution
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AEPS8-4003004 Shutting down Adapter.

Information System Shutting down Adapter.

AEPS8-4003005 Received an Event.

Information Adapter Received an Event.

AEPS8-4003006 Processing Business Event %1

Information Adapter Processing Business Event

AEPS8-4003007 Processing Event[TEST MODE] %1

Information Adapter Processing Event[TEST MODE]

AEPS8-4003008 Received an RPC event.

Information Adapter Received an RPC event.

AEPS8-4003009 Processing an RPC event %1.

Information Adapter Processing an RPC event %1.

AEPS8-4003010 Incoming Business event has both GET and CREATE Keys specified, GETKEYS 

will take precedence.

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003011 No Records Found For GETKEY Value(s), will Create Record using 

CREATEKEY Value(s).

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003012 Successfully Created Keys.

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003013 Calling Set Data for %1 and value is %2

Information Adapter Indicates normal adapter operation. No action 

necessary.

Message Category Resolution
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AEPS8-4003014 Retrieving Base Configuration Parameters.

Information Configuratio

n

Indicates normal adapter operation. No action 

necessary.

AEPS8-4003015 Connection to Application Server succeeded with the following parameters :%1: 

%2,oprID : %3

Information Application Indicates normal adapter operation. No action 

necessary.

AEPS8-4003016 Re-establishing connection to Application Server due to a previous error.

Information Application Indicates normal adapter operation. No action 

necessary.

AEPS8-4003018 Adapter Initialized Successfully....

Information System Indicates normal adapter operation. No action 

necessary.

AEPS8-4003019 Adapter Initialized Successfully in Test Mode.....

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003050 Processing for the event %1 failed due to unavailability of JMS session.

Information Adapter Check if the JMS server is up

AEPS8-4003051 Established connection to app server with parameters - server : %1, oprId : %2 

for Publisher.

Information Application Indicates normal adapter operation. No action 

necessary.

AEPS8-4003052 Re-Established connection to app server with parameters - server : %1,oprId : 

%2 for Publisher.

Information Application Indicates normal adapter operation. No action 

necessary.

Message Category Resolution
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AEPS8-4003053 Processing the event %1 with tracking Id %2

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003054  Processing of the data for the event %1 failed. Mqueue record status has NOT 

been set to E. 

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003055 Processing of the data for the event %1 failed. Mqueue record status has been set 

to E.

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003056 Event %1 with tracking Id %2 was processed successfully. The record status has 

been set to P 

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003057 Processing of the event %1 with sequence number %2 failed. The record has been 

stamped with guide %3 and record status has been set to E. 

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003058 Queue Poller Polled Successfully...

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003059  Parsing the XML data from Mqueue table : Key name is %1 And Key Value is 

%2 

Information Xml Indicates normal adapter operation. No action 

necessary.

AEPS8-4003061 The timer interval is %1

Information Configuratio

n

Indicates normal adapter operation. No action 

necessary.

Message Category Resolution
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AEPS8-4003062 0 is an invalid value for timer interval, overriding the same with %1

Information Configuratio

n

Indicates normal adapter operation. No action 

necessary.

AEPS8-4003063 Registering %1 as Publisher...

Information Configuratio

n

Indicates normal adapter operation. No action 

necessary.

AEPS8-4003064 No CI publishers found....

Information Configuratio

n

Indicates normal adapter operation. No action 

necessary.

AEPS8-4003065 Disconnected from Application Server.

Information Application Indicates normal adapter operation. No action 

necessary.

AEPS8-4003066 %1 %2

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003067 No AM publishers found....

Information Configuratio

n

Indicates normal adapter operation. No action 

necessary.

AEPS8-4003020 Retrieving Subscriber Component Parameters

Information Configuratio

n

Indicates normal adapter operation. No action 

necessary.

AEPS8-4003021 Registering %1 as Subscriber

Information Configuratio

n

Indicates normal adapter operation. No action 

necessary.

AEPS8-4003022 Registering %1 as RPC Server

Information Configuratio

n

Indicates normal adapter operation. No action 

necessary.

Message Category Resolution
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AEPS8-4003023 Sending Data on Explicit Subject: %1 

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003024 Registering hawk methods.

Information Configuratio

n

Indicates normal adapter operation. No action 

necessary.

AEPS8-4003025 Retrieving List of BusinessEvent subscriptions.

Information Configuratio

n

Indicates normal adapter operation. No action 

necessary.

AEPS8-4003026 No Events Configured For this Subscriber.

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003027 Send Reply to RPC Event... %1

Information Adapter Send Reply to RPC Event.

AEPS8-4003028 Send Reply to RPC Event[TEST MODE]... %1

Information Adapter Send Reply to RPC Event[TEST MODE]...

AEPS8-4003029 Hawk Agents registered Successfully

Information Configuratio

n

Indicates normal adapter operation. No action 

necessary.

AEPS8-4003030 No Hawk agent in the repository

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003031 Finished Processing..: %1

Information Adapter Indicates normal adapter operation. No action 

necessary.

Message Category Resolution
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AEPS8-4003032 Processing %1 Failed

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4003033 Caught Base Error %1

Information Application Indicates normal adapter operation. No action 

necessary.

AEPS8-4003034 Received shutdown event

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4002000 Failed to find Error Message %1 in %2

Warning Configuratio

n

Unjar the package that has the message bundle to see 

if the message code is there

AEPS8-4002001 Business Event%1 is not Configured.

Error Adapter Configure a service for the event

AEPS8-4002002 Incoming Business event in has no Tracking Info.

Warning Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4002003 Advisory Message %1  

Warning Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4001000 Instance Name is Null.

Error System Unjar the package that has the message bundle to see 

if the message code is there

AEPS8-4001001 Could not load information from Repository.

Error System Make sure that the repository is not corrupt. Use the 

’Validate for deployment’ option in the TIBCO 

Designer to validate the sanctity of the repository.

Message Category Resolution
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AEPS8-4001002 Could not establish connection to CI Agent.

Error System Check connection parameters to the application 

server

AEPS8-4001004 Could not Create Event Processor 

Error System Make sure that the repository is not corrupt. Use the 

’Validate for deployment’ option in the TIBCO 

Designer to validate the sanctity of the repository.

AEPS8-4001005 Failed to Create MInstance from incoming Event.

Error Adapter Ensure that Message Conversion/Wire Format is set 

to AEMessage.

AEPS8-4001006 Incoming Message has its  BusinessEvent Name as NULL.

Error Adapter Specify Event name in the message

AEPS8-4001007 Sending Data on Reply Address %1 Failed.

Error Adapter Check if the Reply Address specified in the request is 

correct.

AEPS8-4001008 Sending Data on Error Address %1 Failed.

Error Adapter Check if the Reply Address specified in the request is 

correct.

AEPS8-4001009 Failed to Create Reply Business Document.

Error Adapter Check if the Reply Address specified in the request is 

correct.

AEPS8-4001010 Incoming Message is not in the Expected format.

Error Adapter Check message format

AEPS8-4001011 The %1 is not in the CLASSPATH

Error Application Ensure that Component Interface class is generated 

using buldCI.bat, and the files are in CLASSPATH
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AEPS8-4001012 An Error has Occurred while invoking API GetComponent() on CI %1

Error Application This error could be due to one of the following

AEPS8-4001013 Primary Key field %1 cannot be NULL

Error Adapter Specify the key values in the message

AEPS8-4001014 A call to Find() method before %1 operation failed.

Error Application Check permissions on the Component Interfaces 

included with TIB Project.

AEPS8-4001017 CREATE KEYS failed.

Error Application Check if a record already exists for the given Create 

Keys, or if the data provided for creation is invalid.

AEPS8-4001018 Neither GET/CREATE Keys is Specified in the message.

Error Application Specify GET/CREATE keys in the message

AEPS8-4001019 Find operation Failed on %2

Error Application Test the above operation for the CI in PeopleSoft 

TestCI tool.

AEPS8-4001020 getPropertyByName(%1) operation Failed on %2

Error Application Test the above operation for the CI in PeopleSoft 

TestCI tool.

AEPS8-4001021 %1 operation Failed on %2

Error Application Test the above operation for the CI in PeopleSoft 

TestCI tool.

AEPS8-4001022  getPropertyByName (%1) operation Failed on %2

Error Application Test the above operation for the CI in PeopleSoft 

TestCI tool.

AEPS8-4001023  %1 operation Failed on %2

Error Application Test the above operation for the CI in PeopleSoft 

TestCI tool.
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AEPS8-4001024  %1 operation Failed on %2

Error Application Test the above operation for the CI in PeopleSoft 

TestCI tool.

AEPS8-4001025 *******Error********

Error Application Check the permissions granted to Component 

Interfaces imported with TIB Project.

AEPS8-4001028 Stack Trace  %1

Error Adapter Tracing out an exception.

AEPS8-4001030 User Id cannot be NULL.

Error Application Specify a valid PeopleSoft User Id in the 

configuration

AEPS8-4001032 Server Name cannot be NULL.

Error Application Specify a valid PeopleSoft server name in the 

configuration

AEPS8-4001033 Port Number cannot be NULL.

Error Application Specify a valid port number in the configuration 

AEPS8-4001034 Operator Password cannot be NULL

Error Application Specify a valid PeopleSoft password in the 

configuration.

AEPS8-4001035 Incoming Message has PROPERTIES field as NULL.

Error Application Check the Properties value in the message.

AEPS8-4001036 Caught MException in PS8Adapter::main().

Error Application The adapter could not start up. See the accompanying 

stack trace.

AEPS8-4001037 Caught Exception in PS8Adapter::main().

Error Application The adapter could not start up. See the accompanying 

stack trace.
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AEPS8-4001038 Failed to Disconnect from application server.

Error Application Check if the PeopleSoft Application Server is up.

AEPS8-4001039 Disconnected from Application Server.

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4001040 Error Creating %11

Error Application Check if the service has been configured properly.

AEPS8-4001041 Error Creating %1

Error APPLICATI

ON

Check if the service has been configured properly.

AEPS8-4001042 Error Creating %1

Error APPLICATI

ON

Check if the service has been configured properly.

AEPS8-4001043 %1 is a KEY field and cannot be NULL

Error Application Specify a valid value for the field.

AEPS8-4001044 Method not Found %1.%2(%3) 

Error Application Check the generated PeopleSoft APIs.

AEPS8-4001045 Failed to Connect to Appserver with Following Parameters %1:%2, OprID %3

Error Application Check connection parameters to the application 

server.

AEPS8-4001046 %1.. %2

Error Adapter Could not confirm the Data Event. Please restart the 

adapter.

AEPS8-4001047 %1.%2(%3) in setProperty(), unknown Data Type %3

Error Adapter Check the type of attributes in the incoming message.
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AEPS8-4001048 Field/Direction Info is not loaded for Record %1

Error Adapter Please mention the direction info for all fields in the 

RPC Service schema.

AEPS8-4001049 [%2]Error Occurred While Loading Direction Information for Record %1

Error Adapter Please mention the direction information for all fields 

in the RPC Service schema.

AEPS8-4001051 User Id cannot be null

Error Application Specify valid user id in the configuration.

AEPS8-4001052 Password cannot be null

Error Application Specify valid password in the configuration.

AEPS8-4001053 Application server port cannot be null

Error Application Specify valid port in the configuration.

AEPS8-4001054 PeopleSoft application server name cannot be null

Error Application Specify valid server name in the configuration.

AEPS8-4001055 Could not connect to app server with parameters - server : %1,oprId : %2 for 

Publisher.

Error Application Check connection parameters to the application 

server.

AEPS8-4001056 Could not establish session with the application server

Error Application Check application server.

AEPS8-4001057 Failed to disconnect from the application server with parameters - server : 

%1,oprId : %2 for Publisher. 

Error Application Check if the PeopleSoft Application Server is up.

AEPS8-4001059 Processing of the event %1 failed.

Error Adapter Please check if the Publication Service is configured 

properly and the PeopleSoft Application Server and 

the Database are up.
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AEPS8-4001060 Configuration for the publisher %1 doesn’t exist in the repository'

Error Adapter Check the publisher configuration

AEPS8-4001061 Exception occurred in loadCIClass: %1

Error Adapter Ensure that the services are configured properly in the 

repository.

AEPS8-4001062 Exception occurred in loadClass: %1

Error Adapter Ensure that the services are configured properly in the 

repository.

AEPS8-4001063 NullPointerException occurred in loadData for the class %1. The error message is 

: %2 

Error Adapter Ensure that the services are configured properly in the 

repository.

AEPS8-4001064 Exception occurred in getpsRepositoryInterface: %1

Error Adapter Please make sure that the repository is not corrupt. 

Reconfigure if required.

AEPS8-4001065 Function get(): Key cannot be null

Error Adapter Please make sure that the repository is not corrupt. 

Reconfigure if required.

AEPS8-4001066 Exception occurred in startTestTimer: %1

Error Adapter Ensure that the Publication Service is configured 

properly.

AEPS8-4001067 Exception occurred in startTimer: %1

Error Adapter Ensure that the Publication Service is configured 

properly.

AEPS8-4001068 Exception occurred while updating the Tib Status : %1

Error Adapter Ensure that the PeopleSoft Application Server and 

Database are up.

Message Category Resolution



TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

230 | Appendix B  Trace Messages

AEPS8-4001069 Exception occurred in getEventsFromQueue : %1

Error Adapter Ensure that the PeopleSoft Application Server and 

Database are up.

AEPS8-4001070 Error occurred while trying to update the event: %1 with sequence number : %2 

with transition status. The error message is : %3 

Error Adapter Ensure that the PeopleSoft Application Server and 

Database are up.

AEPS8-4001071 Dump of tracking information for the exception 

Error Adapter Used for tracking.

AEPS8-4001072 Advisory Message %1 

Error Adapter Used to trace out advisories.

AEPS8-4001073 No subscribers found...

Information Configuratio

n

Indicates normal adapter operation. No action 

necessary.

AEPS8-4001074 The XML string data is malformed. Error : %1

Error Adapter Check if the XML string in the TIB_CI_MQUEUE 

table is intact.

AEPS8-4001075 Could not create PROPERTIES MInstance.

Error Adapter Ensure that the service is configured properly.

AEPS8-4001076 Could not create XML parser.

Error Adapter Make sure the memory allocated to the JVM is 

sufficient.

AEPS8-4001077 The incoming request has MInstance as null.

Error Adapter Check incoming request

AEPS8-4001078 %1

Error Application Used to trace out PeopleSoft errors.

Message Category Resolution



 TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

Status Messages | 231

AEPS8-4001079 Exception occurred in loadMSGClass: %1

Error Adapter Ensure that the services are configured properly in the 

repository

AEPS8-4001080 Exception occurred in startAppMsgPub: %1

Error Adapter Ensure that the services are configured properly in the 

repository

AEPS8-4001081 HTTP Listener for Application Messaging Publisher started on port %1...

Information Configuratio

n

Indicates normal adapter operation. No action 

necessary.

AEPS8-4001082 Received a message post from PeopleSoft...

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4001083 Received a ping from PeopleSoft...

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4001084 Received an invalid request...

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEPS8-4001085 The HTTP Listener could not be started as the port %1 is already in use

Error Adapter Change the port in the repository and restart the 

adapter.

AE_ADPSFT8_C

ONN_1

Reconnect attempt %1.

Information Application Indicates normal adapter operation. No action 

necessary.

AE_ADPSFT8_C

ONN_2

Reconnect succeeded on attempt %1.

Information Application Indicates normal adapter operation. No action 

necessary.
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AE_ADPSFT8_C

ONN_3

The request received could not be processed due to connection errors. Error reply 

sent back.

Error Adapter Ensure that the PeopleSoft Application Server and 

Database are up.

AE_ADPSFT8_C

ONN_4

Adapter stopping due to persistent connection errors. Please check the PeopleSoft 

Application Server and restart adapter.

Error Adapter Ensure that the PeopleSoft Application Server and 

Database are up.

AE_ADPSFT8_C

ONN_5

Subscription services suspended due to reconnect failure.

Information Adapter Indicates normal adapter operation. No action 

necessary.

AE_ADPSFT8_C

ONN_6

Connection re-established; suspended services reactivated.

Information Adapter Indicates normal adapter operation. No action 

necessary.

AE_ADPSFT8_C

ONN_7

Operation did not succeed due to connection error in service %1. The operation 

will be reattempted.

Information Adapter Indicates normal adapter operation. No action 

necessary.

AEADPSFT8-960

005

DTA connection error has occurred. Authentication failed for app server with 

connection parameters : ID %1,  server and port %2.

Error Metadata Recheck authentication parameters. Also, verify that 

the target system supports the requested 

authentication mechanism. Please see User Guide for 

details on the specification of connection parameters.

AEADPSFT8-960

006

DTA error. An error %1 has occurred while interfacing with target application 

%2

Error Metadata Please verify whether the server is running.
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AEADPSFT8-960

008

DTA error. Request received from DTA client. Not able to download requested 

schema %1 from target application PS

Error Metadata Please check memory, disk space and other resources 

that target application API may be dependent on.

AEADPSFT8-960

009

DTA error. Request received from DTA client. Not able to download requested 

schema %1 from target application PeopleSoft AppServer.

Error Metadata Check to see whether the data/schema exists on target 

application or server.

AEADPSFT8-960

017

DTA error. Shutdown of DTA caused exception %1.

Error Adapter Please contact customer support for further 

assistance.

AEADPSFT8-960

014

DTA error. Received discovery request but missing attribute(s): %1.

Error Adapter Please check if the palette and DTA are of the same 

version. Contact customer support for further 

assistance.

AEADPSFT8-910

011

Startup Error. Duplicate instance %1 detected.

Error Adapter Please verify your repository settings for duplicate 

adapter instance name. See User Guide. 

AEADPSFT8-910

010

Startup Error. Failed to load properties file from path %1 for Application %2  

Error Message %3.

Error Adapter Please verify that the locale is set to en_US on your 

m/c.

AEADPSFT8-910

008

Startup Error.Received target application error with the target application 

PeopleSoft. The Connection pool size is %1

Error Adapter Please verify your repository settings for validity of 

connection parameters. See User Guide. 

AEADPSFT8-910

005

Startup Error. Unable to create a connection with the target application using 

connection parameters : ID %1,  server and port %2.

Error Adapter Please verify your repository settings. See User’s 

Guide.
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AEADPSFT8-930

001

Publication error. Publication service %1 with publishing on subject %2 

encountered connection error while trying to connect to target application 

PeopleSoft Appserver. Connection parameters are Appserver= %3 port= %4 

userid= %5 password= %6, and the number of retry efforts is %7.

Error Adapter Check the target application and make sure it is up 

and running. Check the connection parameters for 

right syntax and values. Please see user guide for 

details on how to specify connection parameters.

AEADPSFT8-930

003

Publication error. Publication service %1 with publishing subject as %2 received 

event from target application PeopleSoft Appserver. It failed while converting 

event to Minstance as it could not get the class description for %3.  Repository 

URL is %4 and the Configuration URL is %5.

Error Adapter Please verify the configuration of the publication 

service and check that the schema/class definitions 

are present in the repository. Please see User Guide 

for details on how to configure a Publication service

AEADPSFT8-930

007

Publication error. Publication service %1 with publication subject %2 received 

event from target application but could not create the business document %3. The 

target application is PeopleSoft Appserver, the Repository URL is %4 and the 

Configuration URL is %5

Error Adapter Verify the configuration of the publication service 

and check that the schema definition for the 

MbusinessDocument maps properly to the event 

received from the target application. Please see User 

Guide for details on how to configure a Publication 

service

AEADPSFT8-930

008

Publication error. Publication service %1 with publication subject %2 received 

SDK Exception %3 while converting the event received from target application to 

Business Document. The exception occurred while setting the attribute %4 with 

value of %5 for Business Document %6.  The target application is PeopleSoft 

AppServer, the Repository URL is %7 and Configuration URL is %8.

Error Adapter Please verify the configuration of the publication 

service and check that the schema definition for the 

MbusinessDocument maps properly to the event 

received from the target application. Please see User 

Guide for details on how to configure a Publication 

service

Message Category Resolution



 TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

Status Messages | 235

AEADPSFT8-930

014

Publication error. Publication service %1 with publication subject %2 received 

error while sending event over the wire. The Publish endpoint details are %3

Error Adapter Please verify the configuration of the publication 

service and check that the schema definition for the 

MbusinessDocument maps properly to the event 

received from the target application. Please see User 

Guide for details on how to configure a Publication 

service

AEADPSFT8-940

001

Request-Response service %1 listening on %2 received an unexpected null 

incoming request. The Repository URL is %3 and the Configuration URL is %4.

Error Adapter Please check the configuration of the application that 

is requesting the event and make sure that it matches 

the inbound event definition for the above 

Request-Response service. Please see User Guide for 

details on configuration of Request-Response service

AEADPSFT8-940

005

Request-Response error. Request-Response service %1 failed to deserialize the 

received MServerRequest to MInstance: Received event on subject %2,  SDK 

exception = %3. The Repository URL is %4 and the Configuration URL is %5

Error Adapter Please check the configuration of the application that 

is requesting the event and make sure that it matches 

the inbound event definition for the above 

Request-Response service. Please see User Guide for 

details on configuration of Request-Response service.

AEADPSFT8-940

007

Request-Response error. Error in incoming data for RPC service: %1 on subject: 

%2. Missing mandatory parameter %3 for RPC input class.

Error Adapter Ensure that the incoming request has the "Name" 

specified.

AEADPSFT8-940

008

Request-Response error. Connection error in invocation of RPC service:%1  on 

subject:%2. Connection parameters are AppServerName=%3 ,Port=%4 , 

UserId=%5 ,Passwd=%6 .

Error Adapter Check if the end application is up and running. Also 

verify the connection parameters that are specified in 

the repository.
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AEADPSFT8-940

009

Request-Response error. Request-Response failed due to target application 

invocation error.

Error Adapter Please check the target application command and the 

parameters and make sure they are valid. Probably 

they can cut and paste the command on a target 

application GUI and verify that it succeeds. Please 

augment this paragraph depending on your target 

application.

AEADPSFT8-940

010

Request-Response error. Request-Response service %1 listening on subject %2 

failed to create Reply Business Object Error %3.

Error Adapter Check the target application command and the 

parameters and make sure they are valid. Probably 

they can cut and paste the command on a target 

application GUI and verify that it succeeds. Please 

augment this paragraph depending on your target 

application. Please check the connection time out 

parameter in configuration file.

AEADPSFT8-990

001

Shutdown error. Failed to deactivate the %1 timer.  SDK exception = %2

Error Adapter Restart the adapter.

AEADPSFT8-990

002

Shutdown error. SDK cleanup exception = %1 

Error Adapter Check the configuration of the application that is 

publishing the event and make sure that it matches the 

inbound event definition for the above subscription 

service. Please see User Guide for details on 

configuration of subscription service

AEADPSFT8-990

005

Shutdown error. Error in disconnecting from target application.

Error Adapter Ensure that the PeopleSoft Application Server and the 

database are up.
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AEADPSFT8-920

001

Subscription error. Subscription service %1 listening on subject %2 received an 

unexpected event. The Repository URL is %3 and the Configuration URL is %4.

Error Adapter Check the configuration of the application that is 

publishing the event and make sure that it matches the 

inbound event definition for the above subscription 

service. Please see User Guide for details on 

configuration of subscription service.

AEADPSFT8-920

002

Subscription error. Subscription service %1 listening on subject %2 failed to 

deserialize the event received. The Repository URL is %3 and the Configuration 

URL is %4.

Error Adapter Check the configuration of the application that is 

publishing the event and make sure that it matches the 

inbound event definition for the above subscription 

service. Please see User Guide for details on 

configuration of subscription service.

AEADPSFT8-920

003

Subscription error. Subscription service %1 listening on subject %2 received 

inbound event with null data. The Repository URL is %3 and the Configuration 

URL is %4.

Error Adapter Make sure that the incoming event has data.

AEADPSFT8-920

005

Subscription error. Subscription service %1 listening on subject %2 could not 

find the tracking data. The Repository URL is %3 and the Configuration URL is 

%4.

Error Adapter Check the configuration of the application that is 

publishing the event and make sure that it matches the 

inbound event definition for the above subscription 

service. Please see User Guide for details on 

configuration of subscription service.

AEADPSFT8-920

007

Subscription error. Subscription service %1 listening on subject %2 could not get 

the class description. The Repository URL is %3 and the Configuration URL is 

%4.

Error Adapter Please check the repository configuration for this 

service. Please see User Guide for details on how to 

configure, run and test the subscription service.
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AEADPSFT8-920

008

Subscription error. Subscription service %1 listening on subject %2 could not 

find the mandatory property %3. The Repository URL is %4 and the 

Configuration URL is %5.

Error Adapter Check the configuration of the application that is 

publishing the event and make sure that it matches the 

inbound event definition for the above subscription 

service. Please see User Guide for details on 

configuration of subscription service.

AEADPSFT8-920

010

Subscription error. Subscription service %1 listening on subject %2 received 

event with missing attributes in class. The Repository URL is %3 and the 

Configuration URL is %4.

Error Adapter Check the configuration of the application that is 

publishing the event and make sure that it matches the 

inbound event definition for the above subscription 

service. Please see User Guide for details on 

configuration of subscription service.

AEADPSFT8-920

014

Subscription error. Subscription service %1 listening on subject %2 could not 

process the inbound event due to connection error against target application PS.

Error Adapter Check the target application and make sure it is up 

and running. Check the validity of the connection 

parameters. Please see User Guide for details on how 

to specify connection parameters. Please see User 

Guide for details on Connection Management.

AEPS8-4001086 AEPS8_MORE_THAN_ONE_RECORD_EXISTS_FOR_GETKEYS. More than 

one record exists for the given GETKEYS.

Error Application Specify the correct GETKEYS.

AEPSFT-100001 Palette error/Adapter Configuration names must have only alphanumeric 

characters with no embedded spaces and can be up to 80 characters long.

Error CONFIG Please type in a valid name. Adapter Configuration 

names can only have alphanumeric characters and 

can be up to 80 characters long.
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AEPSFT-100002 Palette error/The [%1] must be greater than [%2], and less than [%3].

Error CONFIG The value specified must be greater than or equal to 

0, and less than or equal to 65535.

AEPSFT-100003 Palette Error/Names of adapters of the same type must be unique.

Error CONFIG Specify a unique name for the adapter instance

AEPSFT-100004 Connection Retry Mechanism Warning/This adapter version does not support 

connection retry mechanism. The values configured in the Runtime Connection 

tab will be ignored

Warning CONFIG Indicates normal adapter operation. No action 

necessary.

AEPSFT-100005 Application Messaging Publisher/This adapter version %1 does not support 

Application Messaging, but an Application Messaging Publisher was found.

Warning CONFIG Indicates normal adapter operation. No action 

necessary.

AEPSFT-100006 JMS Service Configured/This adapter version %1 does not support JMS services, 

but one was found.

Warning CONFIG Indicates normal adapter operation. No action 

necessary.

AEPSFT-100007 XML Wire Format found/This adapter version %1 does not support XML Wire 

Format

Warning CONFIG XML wire format is supported by versions 5.x and 

above. In order to use it change version to 5.0 or 5.1

AEPSFT-100008 Mandatory Field Missing/The field [%1] is a mandatory field.

error CONFIG Please specify a value for the field.

AEPSFT-100009 Palette error/The field [%1] must have only numeric values.

Error CONFIG Specify a valid numeric value for the field.
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AEPSFT-100010 Palette Error/Could not bind to PeopleSoft Application Server.The entered 

machine name %1'inthe'%2'fielddoesnotexist.'

Error CONFIG Please enter a valid value for the field.

AEPSFT-100011 Invalid Service name:/Service name can only contain alphanumeric characters 

with no embedded spaces and cannot exceed maximum length of 80 characters.

Error CONFIG Please type in a valid name. Adapter Configuration 

names can only have alphanumeric characters and 

can be up to 80 characters long.

AEPSFT-100012 Invalid Subject/The subject specified is invalid.

error CONFIG Specify a valid subject name for the service.

AEPSFT-100013 Palette Error/Selected Reference does not refer an EndPoint.Please select a valid 

EndPoint Reference.

Error CONFIG Select a valid endpoint reference.

AEPSFT-100014 Missing configuration data/No message has been selected.

Error CONFIG Please select a Message using Fetch Message... 

AEPSFT-100015 Missing configuration data/No Component Interface has been selected.

Error CONFIG Please select a Component Interface using Fetch 

Interface... 

AEPSFT-100016 Get Schema failed/The schema was not fetched for the service.Please ensure that 

the aeschema file is writable.

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the Instance.aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

AEPSFT-100017 Cannot Delete/The resource could not be deleted.Please ensure that the aeschema 

file is writable.

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the Instance.aeschema and 

businessObjects.aeschema files for this instance are checked 

out.
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AEPSFT-100018 Cannot Paste Service/The service could not be pasted.Please ensure that the 

aeschema file is writable.

Error CONFIG Ensure that the Schema folders for this instance in 

which this service is present are writable. Ensure that 

the Instance.aeschema and businessObjects.aeschema files 

for this instance are checked out.

AEPSFT-100019 Cannot Rename/The adapter configuration could not be renamed.Please ensure 

that the aeschema file is writable.

error CONFIG Please select a Component Interface using Fetch 

Interface... 

AEPSFT-100020 Global Variables File Read-Only

Error CONFIG Check out the Global variables file.

AEPSFT-100021 Global Variable files needs to be checked out in order to successfully create the 

adapter.

Error CONFIG Check out the Global variables file.

AEPSFT-100022 Error During Rename: Read-Only File

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the Instance.aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

AEPSFT-100023 The resource %1 could not be renamed. Rename requires the "%2" must be 

checked out. Please checkout the resource and try renaming again. You can select 

the resource to be checked out by clicking the "Go To Resource" button.

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the Instance.aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

AEPSFT-100024 Error During Delete: Read-Only File

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the Instance.aeschema and 

businessObjects.aeschema files for this instance are checked 

out.
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AEPSFT-100025 The resource "%1" could not be deleted. Delete requires that "%2" must be 

checked out. Please checkout the resource and try deleting again. You can select 

the resource to be checked out by clicking the "Go To Resource" button.

error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the Instance.aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

AEPSFT-100026 Error: Read-Only File

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the Instance.aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

AEPSFT-100027 The operation on Resource " %1 " could not be completed.The operation requires 

that " %2 " must be checked out.Please ensure that the file is checked out.You can 

select the resource to be checked out by clicking the "Go To Resource"  button

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the Instance.aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

AEPSFT-100028 Warning: Add File to RCS

Warning CONFIG Ensure that the resources that are created on this 

operation are checked into the RCS.

AEPSFT-100029 Warning: "%1" was created during schema generation.

Warning CONFIG Ensure that the resources that are created on this 

operation are checked into the RCS.

AEPSFT-100030 Error During Move: Read-Only File

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the Instance.aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

Message Category Resolution
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AEPSFT-100031 The resource %1 could not be moved. Move requires that " %2 " must be checked 

out. Please checkout the resource and try moving again. You can select the 

resource to be checked out by clicking the "Go To Resource" button.

error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the Instance.aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

AEPSFT-100032 Invalid Value/Please specify a valid integer as value for the [ %1 ] field.

Error CONFIG Specify a valid integer as  a value for the field.

AEPSFT-100034 Could not bind to the PeopleSoft Application Server.The entered machine name in 

the "adpsft8.connection.appserver" global variable does not exist.\n The value 

entered will get reset to the original value only on save.

Warning CONFIG Save the repository.

AEPSFT-110001 DTA Connection Failure/The Design Time Connection has failed.

Error DTA Verify if the Design-time adapter is up and running

AEPSFT-110002 Class Not Found/Could not find the Class.Error: %1. Error during connection to 

DTA.

Error DTA Ensure that the psjoa.jar is in the path and is 

compatible with the PeopleTools version being used.

AEPSFT-110003 DTA Connection Successful/The Design-Time Adapter Connection is successful.

Information DTA Indicates normal adapter operation. No action 

necessary.

AEPSFT-110004 Connection Successful/Connection parameters are valid.A test connection is 

successful.

Information DTA Indicates normal adapter operation. No action 

necessary.

AEPSFT-110005 Palette Error/Connection to Design-Time Adapter is not established.

Warning DTA Ensure that the palette-DTA connection is 

established.

Message Category Resolution
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AEPSFT-110006 Save Failed/Publication Service : %1 could not be saved into PeopleSoft 

System.Error: %2.

error DTA Ensure that the DTA and application server are up 

and running and that the user has full permissions on 

the CI's included with the Project.

AEPSFT-110007 Palette Error/Unable to initialize DTA client.DTA client instance could not be 

initialized with repository file.Error: %1.

Error DTA Ensure that the palette dat is in the lib/palettes directory.

AEPSFT-110008 Palette error/DTA client request has timed out.Please check whether DTA server 

is running.

Error DTA Check whether the design-time adapter is running.

AEPSFT-110009 DTA DisConnection Failure/The Design Time disconnect has failed with the 

parameters: \nApplication Server: %1, User Id: %2, Port: %3.

Error DTA Ensure that the parameters passed for the connection 

are valid.

AEPSFT-120001 Duplicate Service/There cannot be two services configured for the same Message 

[%1] in a PeopleSoftAdapterConfiguration resource.

Error SRVC Configure the message under a different instance or 

configure a different message in this instance.

AEPSFT-120002 Duplicate Service/There cannot be two services configured for the same 

Component Interface [%1] in a PeopleSoftAdapterConfiguration resource.

Error SRVC Configure the CI under a different instance or 

configure a different CI in this instance.

AEPSFT-120003 Palette Error/Get Schema Failed.%1.

Error SRVC Ensure that the design-time adapter is running.

AEPSFT-120004 Invalid Service Name/The Message Name cannot be blank. Please select a valid 

Message by using Fetch Message.

error SRVC Please select a valid message by using Fetch 

Message.

Message Category Resolution
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AEPSFT-120005 Invalid Service name/For a given Adapter Configuration, only one Service can be 

created for a particular Message and the Message cannot be Blank

Error SRVC Ensure that for a given Adapter Configuration, only 

one Service is created for a particular Message and 

the Message field is not blank.

AEPSFT-120006 Invalid Message/The Message %1' does not exist in the PeopleSoft System. Please 

select Message by using Fetch Message.'

Error SRVC Select a valid message by using the Fetch Message 

button.

AEPSFT-120007 Invalid Message/Failed to Verify Message in PeopleSoft System. Please Check the 

Connection to the PeopleSoft System.

Error SRVC Check the connection to PeopleSoft System. Ensure 

that the design-time adapter is up and running.

AEPSFT-120008 Invalid Service Name/The Component Interface Name cannot be blank. Please 

select a valid Component Interface by using Fetch Interface.

Error SRVC Select a valid CI by using the Fetch Interfaces button.

AEPSFT-120009 Invalid Service name/For a given Adapter Configuration, only one Service can be 

created for a particular Component Interface and the Component Interface 

cannot be Blank

Error SRVC Ensure that for a given adapter configuration, only 

one Service is created for a particular CI and the CI 

field is not blank.

AEPSFT-120010 Invalid Component Interface / The CI %1' does not exist in the PeopleSoft 

System. Please select CI by using' Fetch Interface.''

Error SRVC Please select a CI using the Fetch Interface button.

AEPSFT-120011 Invalid Component Interface/Failed to Verify Component Interface in PeopleSoft 

System. Please Check Connection to PeopleSoft System.

error SRVC Check the connection to the PeopleSoft System. 

Ensure that the design-time adapter is up and running.

Message Category Resolution
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AEPS8-4003050 AEPS8_PUB_JMS_SERVER_UNAVAILABLE. Processing for the event %1 

failed due to unavailability of JMS session.

Information Adapter Bring up the JMS server and restart the adapter.

AEPSFT-100001 Palette error/Adapter Configuration names must have only alphanumeric 

characters with no embedded spaces and can be up to 80 characters long.

Error CONFIG Please type in a valid name.Adapter Configuration 

names can only have alphanumeric characters and 

can be up to 80 characters long.

AEPSFT-100002 Palette error/The [%1] must be greater than [%2], and less than [%3].

Error CONFIG The value specified must be greater than or equal to 

0, and less than or equal to 65535.

AEPSFT-100003 Palette Error/Names of adapters of the same type must be unique.

Error CONFIG Specify a unique name for the adapter instance

AEPSFT-100004 Connection Retry Mechanism Warning/This adapter version does not support 

connection retry mechanism. The values configured in the Runtime Connection 

tab will be ignored

Warning CONFIG Indicates normal adapter operation. No action 

necessary.

AEPSFT-100005 Application Messaging Publisher/This adapter version %1 does not support 

Application Messaging, but an Application Messaging Publisher was found.

Warning CONFIG Indicates normal adapter operation. No action 

necessary.

AEPSFT-100006 JMS Service Configured/This adapter version %1 does not support JMS services, 

but one was found.

Warning CONFIG Indicates normal adapter operation. No action 

necessary.

AEPSFT-100007 XML Wire Format found/This adapter version %1 does not support XML Wire 

Format

Warning CONFIG XML wire format is supported by versions 5.x and 

above. In order to use it change version to 5.0 or 5.1

Message Category Resolution
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AEPSFT-100008 Mandatory Field Missing/The field [%1] is a mandatory field.

Error CONFIG Please specify a value for the field.

AEPSFT-100009 Palette error/The field [%1] must have only numeric values.

Error CONFIG Specify a valid numeric value for the field.

AEPSFT-100010 Palette Error/Could not bind to PeopleSoft Application Server. The entered 

machine name %1'in the'%2'field does not exist.'

Error CONFIG Please enter a valid value for the field.

AEPSFT-100011 Invalid Service name:/Service name can only contain alphanumeric characters 

with no embedded spaces and cannot exceed maximum length of 80 characters.

Error CONFIG Please type in a valid name.Adapter Configuration 

names can only have alphanumeric characters and 

can be up to 80 characters long.

AEPSFT-100012 Invalid Subject/The subject specified is invalid.

Error CONFIG Specify a valid subject name for the service.

AEPSFT-100013 Palette Error/Selected Reference does not refer an EndPoint. Please select a valid 

EndPoint Reference.

Error CONFIG Select a valid endpoint reference.

AEPSFT-100014 Missing configuration data/No message has been selected.

Error CONFIG Please select a Message using Fetch Message... 

AEPSFT-100015 Missing configuration data/No Component Interface has been selected.

Error CONFIG Please select a Component Interface using Fetch 

Interface...

AEPSFT-100016 Get Schema failed/The schema was not fetched for the service. Please ensure that 

the aeschema file is writable.

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the instance .aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

Message Category Resolution
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AEPSFT-100017 Cannot Delete/The resource could not be deleted. Please ensure that the aeschema 

file is writable.

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the instance .aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

AEPSFT-100018 Cannot Paste Service/The service could not be pasted. Please ensure that the 

aeschema file is writable.

Error CONFIG Ensure that the Schema folders for this instance in 

which the service is present, are writable. Ensure that 

the instance .aeschema and businessObjects.aeschema files for 

this instance are checked out.

AEPSFT-100019 Cannot Rename/The adapter configuration could not be renamed. Please ensure 

that the aeschema file is writable.

Error CONFIG Please select a Component Interface using Fetch 

Interface... 

AEPSFT-100020 Global Variables File Read-Only

Error CONFIG Check out the Global variables file.

AEPSFT-100021 Global Variable files needs to be checked out in order to successfully create the 

adapter.

Error CONFIG Check out the Global variables file.

AEPSFT-100022 Error During Rename: Read-Only File

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the instance .aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

Message Category Resolution
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AEPSFT-100023 The resource %1 could not be renamed. Rename requires the "%2" must be 

checked out. Please checkout the resource and try renaming again. You can select 

the resource to be checked out by clicking the "Go To Resource" button.

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the instance .aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

AEPSFT-100024 Error During Delete:Read-Only File

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the instance .aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

AEPSFT-100025 The resource "%1" could not be deleted. Delete requires that "%2" must be 

checked out. Please checkout the resource and try deleting again. You can select 

the resource to be checked out by clicking the "Go To Resource" button.

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the instance .aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

AEPSFT-100026 Error: Read-Only File

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the instance .aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

AEPSFT-100027 The operation on Resource " %1 " could not be completed.The operation requires 

that " %2 " must be checked out.Please ensure that the file is checked out.You can 

select the resource to be checked out by clicking the "Go To Resource"  button

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the instance .aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

Message Category Resolution



TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

250 | Appendix B  Trace Messages

AEPSFT-100028 Warning: Add File to RCS

Warning CONFIG Ensure that the resources that are created on this 

operation are checked into the RCS.

AEPSFT-100029 Warning: "%1" was created during schema generation.

Warning CONFIG Ensure that the resources that are created on this 

operation are checked into the RCS.

AEPSFT-100030 Error During Move: Read-Only File

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the instance .aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

AEPSFT-100031 The resource %1 could not be moved. Move requires that " %2 " must be checked 

out. Please checkout the resource and try moving again. You can select the 

resource to be checked out by clicking the "Go To Resource" button.

Error CONFIG Ensure that the Schema folders for this instance are 

writable. Ensure that the instance .aeschema and 

businessObjects.aeschema files for this instance are checked 

out.

AEPSFT-110001 DTA Connection Failure/The Design Time Connection has failed.

Error DTA Verify if the Design-time adapter is up and running

AEPSFT-110002 Class Not Found/Could not find the Class.Error: %1. Error during connection to 

DTA.

Error DTA Ensure that the psjoa.jar is in the path and is 

compatible with the PeopleTools version being used.

AEPSFT-110003 DTA Connection Successful/The Design-Time Adapter Connection is successful.

Information DTA Indicates normal adapter operation. No action 

necessary.

Message Category Resolution
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AEPSFT-110004 Connection Successful/Connection parameters are valid. A test connection is 

successful.

Information DTA Indicates normal adapter operation. No action 

necessary.

AEPSFT-110005 Palette Error/Connection to Design-Time Adapter is not established.

Warning DTA Ensure that the palette-DTA connection is 

established.

AEPSFT-110006 Save Failed/Publication Service : %1 could not be saved into PeopleSoft 

System.Error: %2.

Error DTA Ensure that the DTA and application server are up 

and running and that the user has full permissions on 

the CI's included with the Project.

AEPSFT-110007 Palette Error/Unable to initialize DTA client. DTA client instance could not be 

initialized with repository file.Error: %1.

Error DTA Ensure that the palette dat is in the lib/palettes 

directory.

AEPSFT-120001 Duplicate Service/There cannot be two services configured for the same Message 

[%1] in a PeopleSoftAdapterConfiguration resource.

Error SRVC Configure the Message under a different instance or 

configure a different message in this instance.

AEPSFT-120002 Duplicate Service/There cannot be two services configured for the same 

Component Interface [%1] in a PeopleSoftAdapterConfiguration resource.

Error SRVC Configure the CI under a different instance or 

configure a different CI in this instance.

AEPSFT-120003 Palette Error/Get Schema Failed.%1.

Error SRVC Please ensure that the DTA is up and running.

AEPSFT-120004 Invalid Service Name/The Message Name cannot be blank. Please select a valid 

Message by using Fetch Message.

Error SRVC Please select a valid Message by using Fetch 

Message.

Message Category Resolution



TIBCO ActiveMatrix Adapter for PeopleSoft Configuration and Deployment

252 | Appendix B  Trace Messages

AEPSFT-120005 Invalid Service name/For a given Adapter Configuration, only one Service can be 

created for a particular Message and the Message cannot be Blank

Error SRVC Please ensure that for a given adapter configuration, 

only one Service is created for a particular Message 

and the Message field is not blank.

AEPSFT-120006 Invalid Message/The Message %1' does not exist in the PeopleSoft System. Please 

select Message by using Fetch Message.'

Error SRVC Please select a valid message by using the Fetch 

Message button.

AEPSFT-120007 Invalid Message/Failed to Verify Message in PeopleSoft System. Please Check the 

Connection to the PeopleSoft System.

Error SRVC Check the connection to the PeopleSoft System. 

Ensure that the DTA is up and running.

AEPSFT-120008 Invalid Service Name/The Component Interface Name cannot be blank. Please 

select a valid Component Interface by using Fetch Interface.

Error SRVC Select a valid CI by using the Fetch Interface button.

AEPSFT-120009 Invalid Service name/For a given Adapter Configuration, only one Service can be 

created for a particular Component Interface and the Component Interface 

cannot be Blank

Error SRVC Ensure that for a given Adapter Configuration, only 

one Service is created for a particular CI and the CI 

field is not blank.

AEPSFT-120010 Invalid Component Interface/The CI %1'does not exist in the PeopleSoft System. 

Please select CI by using 'FetchInterface.’'

Error SRVC Please select a CI using the Fetch Interface button.

AEPSFT-120011 Invalid Component Interface/Failed to Verify Component Interface in PeopleSoft 

System. Please Check Connection to PeopleSoft System.

Error SRVC Check the Connection to the PeopleSoft System. 

Ensure that the DTA is up and running.

Message Category Resolution
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AEPS8-4001087 Startup Warning. Password decryption was unsuccessful.

Warning Adapter Password could not be decrypted and hence will be 

used as-is. This is a warning. No action required.

AEPS8-4003050 AEPS8_PUB_JMS_SERVER_UNAVAILABLE. Processing for the event %1 

failed due to unavailability of JMS session.

Information Adapter Bring up the JMS server and restart the adapter.

AEPS8_620001 Activated Worker Threads for PeopleSoft IB Message processing.

Information Adapter If any of the IB Services are configured, the Worker 

thread for processing IB message should be started.

AEPS8_620002 Error while building PeopleSoft IB message.

Information Adapter Verify that Schema for the configured message is 

right.

AEPS8_620003 Java JNDI Naming Error for Message Subscriber.

Information Adapter Verify that the JNDI URL specified for Message 

Subscriber is correct. 

AEPS8_620004 Unable to send Message over JMS.

Information Adapter Verify that the respective Topic or Queue is present in 

the JMS Server. 

AEPS8_620005 Invalid HTTP Url please configure valid URL of PeopleSoft IB Subscriber.

Information Adapter Configure the valid HTTP URL for Message 

Subscriber.

AEPS8_620006 Invalid HTTP Network please check whether IB Server is up and running.

Information Adapter Check whether the IB Server is up and running.

AEPS8_620007 Error while reading and writing to the IO Stream.

Information Adapter The Subscriber must have been configured with a 

wrong HTTP URL. Provide the right URL and restart 

the adapter.

Message Category Resolution
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AEPS8_620008 Error Parsing HTTP Response XML.

Information Adapter The Subscriber must have been configured with a 

wrong HTTP URL. Provide the right URL and restart 

the adapter.

AEPS8_620009 %1 Service not interested in the message %2.

Information Adapter The message sent by IB is different from the one 

configured for Subscription. Send a message similar 

to the one configured.

AEPS8_620010 %1 Event Added on the worker queue.

Information Adapter The Event received from PeopleSoft IB is added on 

the Queue for further processing. 

AEPS8_620101 Registering %1 as RPC Client...

Information Adapter If RPC Client is configured, the log should show that 

the Request-Response Invocation Service has been 

registered.

AEPS8_620102 Unhandled Exception while processing rpcclient.

Information Adapter Could not handle the exception. Restart the adapter.

AEPS8_620103 Thread interrupted while putting the job on the Queue.

Information Adapter Indicates normal adapter operation. No Action 

required.

AEPS8_620104 Ping executed with error for rpcclient.

Information Adapter Could not confirm the Data Event. Restart the 

adapter.

AEPS8_620105 rpcclient timeout error.

Information Adapter Change the timeout property in the SubscriberOptions 

tab, and check whether the RPC-Client process is up 

and running.

Message Category Resolution
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AEPS8_620106 Error while processing XML message for rpcclient.

Information Adapter Verify that the right message structure has been sent 

to the RPC-Client Service. Monitor the message in 

PeopleSoft for more information.

AEPS8_620107 Error while sending reply for rpcclient.

Information Adapter Verify whether the JMS Server is running.

AEPS8_620108 Error while getting PeopleSoft IB Message for RPCClient.

Information Adapter Verify that the right message structure has been sent 

to the RPC-Client Service. Monitor the message in 

PeopleSoft for more information.

AEPS8_620152 Started processing for rpcclient.

Information Adapter Indicates normal adapter operation. No action 

required.

AEPS8_620153 Ended processing for rpcclient successfully.

Information Adapter Indicates normal adapter operation. No action 

required.

AEPS8_620154 Job added on the Queue for rpcclient.

Information Adapter Indicates normal adapter operation. No action 

required.

AEPS8_620301 Error sending IB Request xml data to PeopleSoft IB for messagesubscriber.

Information Adapter Could not confirm the Data Event. Verify that the 

JMS Server is running, and restart the adapter.

AEPS8_620302 UnHandled Exception while processing message subscriber.

Information Adapter Could not handle the exception. Restart the adapter.

AEPS8_620351 Started processing for message subscriber.

Information Adapter Indicates normal adapter operation. No action 

required.

Message Category Resolution
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AEPS8_620352 Ended processing for message subscriber successfully.

Information Adapter Indicates normal adapter operation. No action 

required.

AEPS8_620501 UnHandled Exception while processing message publisher.

Information Adapter Could not handle the exception. Restart the adapter.

AEPS8_620551 Started processing for message publisher.

Information Adapter Indicates normal adapter operation. No action 

required.

AEPS8_620552 Ended processing for message publisher successfully.

Information Adapter Indicates normal adapter operation. No action 

required.

Message Category Resolution
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Appendix C Troubleshooting

This appendix lists troubleshooting information.

Topics

• Running adpsft8.exe failed, page 262

• Clicking on the Fetch Interface button returns an MTimeoutException, page 267

• When the adapter is running there is a registration collision, page 268

• The adapter prints a stacktrace at each polling interval, page 269

• The adapter is not publishing data that has been entered, page 270

• The adapter printed an error message immediately after receiving a business event, 

page 271

• While processing, the adapter failed to set a value in the date field, page 272

• Data processing caused a GetComponent() API message error, page 273

• Data successfully received and processed is not reflected in the table, page 274

• A successfully processed record has extra rows in the database, page 276

• The palette cannot connect to the DTA, page 277

• Connection to PeopleSoft failed, page 278

• ’Method not found’ error displayed by the Adapter, page 280 
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Running adpsft8.exe failed

Symptom 1

When I run adpsft8.exe from a command prompt it returned an error stating "connection <n>.dat 

failed" as follows:
com.tibco.sdk.MException: Operation error: connection myRepo.dat

failed.

at com.tibco.sdk.properties.MRepoPropertiesRegistry.<init>

(MRepoPropertiesRegistry.java:100)

at com.tibco.sdk.properties.MRepoPropertiesRegistry.<init>

(MRepoPropertiesRegistry.java:51)

at com.tibco.sdk.MApp.connectToRepo(MApp.java:363)

at com.tibco.sdk.MDefaultApp.start(MDefaultApp.java:242)

at com.tibco.sdk.MApp.start(MApp.java:191)

at com.tibco.adapter.ps.PS8Adapter.main(PS8Adapter.java:37)

Caught MException in PS8Adapter::main().

Probable Cause

The connection to the specified repository failed because the adapter could not locate the 

repository.

Solution

If you specified a remote repository for the tibco.repourl property in the .tra file make sure the 

applicable repository server is up. If you specified a local repository file in the 

<repositoryInstance> parameter, make sure the path is correct and the file is not 

corrupted.

Symptom 2

When I run adpsft8.exe from a command prompt it returned an error stating "transport is 

null" as follows:
2001 Sep 20 17:16:23:922 ps8Adapter.inst Error [Adapter] AEPS8-4001028 Stack Trace  

java.lang.IllegalArgumentException:  transport is null

at com.tibco.tibrv.TibrvListener.init(TibrvListener.java:67)

at om.tibco.tibrv.TibrvListener.<init>(TibrvListener.java:58)

at com.tibco.tibrv.TibrvCmListener.<init>

(TibrvCmListener.java:37)

at com.tibco.sdk.events.pubsub.MRvcmSubscriber.listen

(MRvcmSubscriber.java:173)

at com.tibco.sdk.events.pubsub.MRvSubscriber.activate

(MRvSubscriber.java:125)

at com.tibco.sdk.events.MSubscriber.activate

(MSubscriber.java:239)

at com.tibco.sdk.internal.MStartup.activateComponent

(MStartup.java:148)

at com.tibco.sdk.MDefaultApp.activateComponents
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(MDefaultApp.java:557)

at com.tibco.sdk.MDefaultApp.start(MDefaultApp.java:366)

at com.tibco.sdk.MApp.start(MApp.java:191)

at com.tibco.adapter.ps.PS8Adapter.main(PS8Adapter.java:37)

Probable Cause

The adapter failed during initialization when it was trying to set up the RVCM transport. 

The failure occurred because the adapter was not able to create a ledger. This happens 

when another adapter configuration is running and has already locked a ledger file with 

the same name.

Solution

If you did not intend to have more than one adapter configuration running concurrently:

1. Start TIBCO Designer.

2. Open up the repository you have saved.

3. In the project tree panel, select the adapter configuration you are trying to start.

4. Change the ledger file name found under Advanced/Sessions.

If you do want to have more than one adapter configuration running concurrently, run the 

adapter configuration in another directory. For example, create a subdirectory under 

TIBCO_HOME\adapter\adpsft8\version_number\bin and call it myInstance. Copy adpsft8.exe and adpsft8.tra 

files. Modify the property application .args to reflect the correct path of the .tra file.

adpsft8.bat to TIBCO_HOME\adapter\adpsft8\version_number\bin\myInstance and run the adapter from 

that location.

Symptom 3

When I run adpsft8.exe from a command prompt it returned an error stating "Failed to Connect to 

Appserver with Following Parameters" as follows:
2001 Sep 20 17:48:33:571 ps8Adapter.inst Info [Application] AEPS8-4003002 Connecting to Application Server..

Jolt Session Pool cannot provide a connection to the appsever.  This appears to be because there is no available 

application server domain.

Jolt Session Pool cannot provide a connection to the appsever.  This appears to be because there is no available 

application server domain.

[Thu Sep 20 17:48:36 PDT 2001] bea.jolt.ServiceException: Invalid Session

Application Server last connected

2001 Sep 20 17:48:36:856 ps8Adapter.inst Error [Adapter] AEPS8-4001028 Stack Trace  com.tibco.sdk.MException: 

Failed to Connect to Appserver with Following Parameters stan-dt:9050, OprID VP1

at com.tibco.adapter.ps.AdapterException.<init>

(AdapterException.java:24)

at com.tibco.adapter.ps.ComponentInterfaceAgent.<init>

(ComponentInterfaceAgent.java:121)

at com.tibco.adapter.ps.ComponentInterfaceAgent.getCIA

(ComponentInterfaceAgent.java:69)

at com.tibco.adapter.ps.JAdapterCore.onInitialization
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(JAdapterCore.java:105)

at com.tibco.sdk.MDefaultApp.onInitialization

(MDefaultApp.java:528)

at com.tibco.sdk.MDefaultApp.start(MDefaultApp.java:346)

at com.tibco.sdk.MApp.start(MApp.java:191)

at com.tibco.adapter.ps.PS8Adapter.main(PS8Adapter.java:37)

2001 Sep 20 17:48:36:936 ps8Adapter.inst Error [Application] AEPS8-4001036 Caught MException in 

PS8Adapter::main().

Probable Cause

The system is unable to locate a PeopleSoft Application Server domain. Either the 

application server is down or the TIBCO Repository stored an invalid application server 

host name and/or port number.

Solution

Double-check all the connection parameters (operator ID, password, application server 

name, and port number) in the repository. Verify that the database is up by login 2 tier 

using a PeopleSoft client. Verify that the application server is up and that the JSL process 

is alive and the JSL port matches the one stored in the repository.

Symptom 4

When I run adpsft8.exe from a command prompt it returned an error stating "Failed to Connect to 

Appserver with Following Parameters" as follows:
2001 Sep 20 17:58:00:346 ps8Adapter.inst Error [Adapter] AEPS8-4001028 Stack Trace  com.tibco.sdk.MException: 

Failed to Connect to Appserver with Following Parameters stan-dt:9050, OprID VP2

at com.tibco.adapter.ps.AdapterException.<init>

(AdapterException.ja va:24)

at com.tibco.adapter.ps.ComponentInterfaceAgent.<init>

(ComponentInterfaceAgent.java:121)

at com.tibco.adapter.ps.ComponentInterfaceAgent.getCIA

(ComponentInterfaceAgent.java:69)

at com.tibco.adapter.ps.JAdapterCore.onInitialization

(JAdapterCore.java:105)

at com.tibco.sdk.MDefaultApp.onInitialization

(MDefaultApp.java:528)

at com.tibco.sdk.MDefaultApp.start(MDefaultApp.java:346)

at com.tibco.sdk.MApp.start(MApp.java:191)

at com.tibco.adapter.ps.PS8Adapter.main(PS8Adapter.java:37)

2001 Sep 20 17:58:00:346 ps8Adapter.inst Error [Application] AEPS8-4001036 Caught MException in 

PS8Adapter::main().

Probable Cause

The operator ID or password is invalid. A second possible cause is that the database is 

down but the PeopleSoft Application Server is up. A third possible cause is the wrong 

version of the PSJOA.JAR file is used. The PSJOA.JAR should belong to the same version of 

PeopleTools as the file being used by the BEA Tuxedo application server.
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Solution

Double-check all the connection parameters (operator ID, password, application server 

name, and port number) in the repository. Verify that the database is up by login 2 tier 

using a PeopleSoft client. Verify that the application server is up and that the JSL process 

is alive and the JSL port matches the one stored in the repository.

Verify that the versions of the PeopleTools libraries being used by the adapter and the 

application server are the same.

Symptom 5

When I run adpsft8.exe from a command prompt it returned an error stating 

"NoClassDefFoundError: com/tibco/tibrv/*" as follows:
Exception in thread "main" java.lang.NoClassDefFoundError: com/tibco/tibrv/TibrvException

at com.tibco.sdk.MApp.<init>(MApp.java:88)

at com.tibco.adapter.ps.JAdapterCore.<init>

(JAdapterCore.java:72)

at com.tibco.adapter.ps.PS8Adapter.main(PS8Adapter.java:35)

Probable Cause

The tibrvj.jar file is not correctly identified.

Solution

Add the path to tibrvj.jar to the environment variable CLASSPATH. By default this file is 

found in TIBCO_HOME\tra\version_number.

Symptom 6

When I run adpsft8.exe from a command prompt it returned an error stating "Substitution variable 

… does not exist" as follows:
Processing /tibco/private/adapter/PeopleSoft/inst/ps8Adapter ...

com.tibco.sdk.MException: Invalid assoc key: startup.Substitution variable HawkEnabled does not exist

at com.tibco.sdk.properties.MRepoProperties.get

(MRepoProperties.java:242)

at com.tibco.sdk.properties.MRepoProperties.get

(MRepoProperties.java:232)

at com.tibco.sdk.serializer.MPropertyBasedDeserializer.internalRead

(MPropertyBasedDeserializer.java:147)

at com.tibco.sdk.serializer.MPropertyBasedDeserializer.readOptional

(MPropertyBasedDeserializer.java:235)

at com.tibco.sdk.serializer.MPropertyBasedDeserializer.readOptional

(MPropertyBasedDeserializer.java:226)

at com.tibco.sdk.serializer.MConfigDeserializer.readConfig

(MConfigDeserializer.java:49)

at com.tibco.sdk.serializer.MConfigDeserializer.readAnySupportedType

(MConfigDeserializer.java:33)

at com.tibco.sdk.serializer.MPropertyBasedDeserializer.readAny
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(MPropertyBasedDeserializer.java:202)

at com.tibco.sdk.serializer.MPropertyBasedDeserializer.deserialize

(MPropertyBasedDeserializer.java:33)

at com.tibco.sdk.MDefaultApp.start(MDefaultApp.java:281)

at com.tibco.sdk.MApp.start(MApp.java:191)

Caught MException in PS8Adapter::main().

Probable Cause

The repository is missing a Hawk Enable global variable.

Solution

Start TIBCO Designer, then open the affected repository and add the missing global 

variable.
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Clicking on the Fetch Interface button returns an MTimeoutException

Symptom

While configuring an adapter service, I clicked Fetch Interface … and encountered 

following error:

Probable Cause

Either the TIBCO design-time adapter has not been started, or you have not granted 

permission to use TIB_CI_COMPINTFC.

Solution

1. Start the design-time adapter.

2. Log into PeopleSoft, go to the Maintain Security screen, and add TIB_CI_COMPINTFC to 

the list of Component Interfaces your operator class can use. Make sure full access is 

granted.
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When the adapter is running there is a registration collision

Symptom

The following message appears on the adapter console:
{ADV_CLASS="ERROR" ADV_SOURCE="RVCM" ADV_NAME="REGISTRATION.COLLISION.PS8CM" 

name="PS8CM" confl_inbox="_INBOX.0A606495.1

FD3BAA860E776030.1" confl_addr=10.96.100.149}

Probable Cause

Another TIBCO product is using the same RVCM name. As indicated in the message 

above, PS8CM is an RVCM name already being used on 10.96.100.149. An RVCM 

collision could cause thrashing (see TIBCO Rendezvous documentation) and compromise 

the quality of service.

Solution

Rename the RVCM session that the adapter configuration is using.
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The adapter prints a stacktrace at each polling interval 

Symptom

The following message repeats at each polling interval:
bea.jolt.ApplicationException: TPESVCFAIL - application level service failure

at bea.jolt.JoltRemoteService.decodeCALL(JoltRemoteService.java:405)

at bea.jolt.JoltRemoteService.call(JoltRemoteService.java:323)

at psft.pt8.net.NetReqRepSvc.sendRequest(NetReqRepSvc.java:376)

at psft.pt8.net.NetService.requestService(NetService.java:144)

at psft.pt8.joa.JOAService.joaRequestService(JOAService.java:49)

at psft.pt8.joa.CISessionSvc.getComponent(CISessionSvc.java:31)

at psft.pt8.joa.CI.getComponent(CI.java:29)

at psft.pt8.joa.Session.getComponent(Session.java:46)

at com.tibco.adapter.ps.PublisherEventHandler.getEventsfromQueue

(PublisherEventHandler.java:102)

at com.tibco.adapter.ps.PublisherEventHandler.onEvent

(PublisherEventHandler.java:72)

at com.tibco.sdk.events.EventHandoff.run(MEventSource.java:141)

at java.lang.Thread.run(Unknown Source)

Cannot trace non MException or MRuntimeException class

2001 Sep 21 00:15:13:676 ps8Adapter.inst Info [Application] AEPS8-4003052 "Re-Established connection to app 

server with

parameters - server : shsu-lt:9050,oprId : VP1 for Publisher."

Probable Cause

The adapter uses the TIB_MQUEUE_DATA_CI and TIB_MQUEUE_SRCH_CI Component Interface 

to poll the TIB_CI_MQUEUE table. If the login account has not been granted permission to 

use this Component Interface, then you will get this error. These objects can be found by 

using a PeopleSoft client and opening up the TIB_PS8_ADAPTER project.

Solution

1. Login to PeopleSoft. 

2. Open the Maintain Security screen. 

3. Select the operator class corresponding to the operator ID the adapter is using. 

4. Add TIB_MQUEUE_DATA_CI and TIB_MQUEUE_SRCH_CI to the list of Component 

Interfaces.

5. Make sure full permission is granted, then save the changed list.
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The adapter is not publishing data that has been entered

Symptom

After completing the configuration for an adapter configuration with a CI Publication 

Service, the configuration is saved to a repository instance. But when a PeopleSoft client 

is used to enter data, no entry is added to the TIB_CI_MQUEUE table. Thus the adapter 

configuration does not publish any data.

Probable Cause

While using TIBCO Designer to save the adapter configuration containing the CI 

Publication Service, it throws a error. When you save the configuration information to a 

TIBCO repository instance, a set of code checks to see if data needs to be saved to the 

PeopleSoft database. Saving data to the PeopleSoft database will need to be done if there 

is a CI PUBLICATION SERVICE configured. If the data is not saved to a PeopleSoft 

database, the publisher will not work correctly.

Solution

1. Check to see if permission has been granted to use the Component Interface you have 

configured, TIB_PUB_COMPINTFC (used by saveOperation() to save data to the 

PeopleSoft database), TIB_MQUEUE_DATA_CI (used by the publisher to retrieve queue 

records), TIB_MQUEUE_SRCH_CI (used by the publisher to retrieve queue records), and 

TIB_CI_COMPINTFC (used to read Component Interface definitions). Make sure the 

correct operator class is chosen and full access is granted.

2. Use TIBCO Designer and modify any parameter to cause the entire configuration to 

be "dirty". 

3. Save the "dirty" configuration to the TIBCO Repository. If the data is correctly saved 

to PeopleSoft database you will see the following log message:
2001 Sep 21 00:43:17:607 psoftDesignTimeAdapter.psdta Info [Metadata] AEPS8-3400

105 SaveOperation successfully saved ACCOUNT_TYPE publication service to People Soft database

4. Make sure the TIB_CI_ADAPTER_WRK shadow work page has been inserted into the 

component the adapter will publish data in.
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The adapter printed an error message immediately after receiving a 

business event

Symptom

As soon as the adapter receives a data message it prints out the following error message:

2001 Sep 21 01:09:09:131 ps8Adapter.sub Info [Adapter] AEPS8-4003005 Received an Event.

com.tibco.sdk.MException: Incoming Message has its  BusinessEvent Name as NULL.

at com.tibco.adapter.ps.AdapterException.<init>

(AdapterException.java:22)

at com.tibco.adapter.ps.SubscriberEventHandler.onEvent

(SubscriberEventHandler.java:115)

at com.tibco.sdk.events.pubsub.MRvDataReceiver.dispatch

(MRvDataReceiver.java:292)

at com.tibco.sdk.events.pubsub.MRvDataReceiver.onData

(MRvDataReceiver.java:156)

at com.tibco.sdk.events.pubsub.MBaseRvDataReceiver.onMsg

(MBaseRvDataReceiver.java:81)

at com.tibco.tibrv.TibrvEvent.invoke(TibrvEvent.java:160)

at com.tibco.tibrv.TibrvImplQGroupC.natDispatch(Native Method)

at com.tibco.tibrv.TibrvImplQGroupC.dispatch

(TibrvImplQGroupC.java:67)

at com.tibco.tibrv.TibrvQueueGroup.dispatch

(TibrvQueueGroup.java:163)

at com.tibco.sdk.MDefaultDispatcher.run(MDefaultDispatcher.java:26)

at java.lang.Thread.run(Unknown Source)

Probable Cause

The name of the business event was left blank.

Solution

Fill in the business event name with the name of the Component Interface. If you do not 

use the Component Interface name as the business event name, the adapter will assume 

that your business event is not configured. Case matters: enter in the Component Interface 

name exactly as it appears in your schema or in PeopleSoft.
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While processing, the adapter failed to set a value in the date field

Symptom

While the adapter was processing a message, no value was set in the date field, resulting in 

the following error message:
2001 Sep 21 01:16:37:216 ps8Adapter.sub Info [Adapter] AEPS8-4003013 Calling Set Data for EFFDT and value is 

1900/01/01

2001 Sep 21 01:16:37:446 ps8Adapter.sub Info [Application] AEPS8-4003033 Caught Base Error TPESVCFAIL - 

application level service failure

com.tibco.sdk.MException: setEffdt operation Failed on PeopleSoft.Generated.CompIntfc.ProductProductTbl

at com.tibco.adapter.ps.AdapterException.<init>

(AdapterException.java:24)

at com.tibco.adapter.ps.ComponentInterfaceAgent.setProperty

(ComponentInterfaceAgent.java:245)

at com.tibco.adapter.ps.PSEventProcessor.setProperties

(PSEventProcessor.java:424)

at com.tibco.adapter.ps.PSEventProcessor.setProperties

(PSEventProcessor.java:561)

at com.tibco.adapter.ps.PSEventProcessor.processMessage

(PSEventProcessor.java:251)

at com.tibco.adapter.ps.SubscriberEventHandler.onEvent

(SubscriberEventHandler.java:159)

at com.tibco.sdk.events.pubsub.MRvDataReceiver.dispatch

(MRvDataReceiver.java:292)

at com.tibco.sdk.events.pubsub.MRvDataReceiver.onData

(MRvDataReceiver.java:156)

at com.tibco.sdk.events.pubsub.MBaseRvDataReceiver.onMsg

(MBaseRvDataReceiver.java:81)

at com.tibco.tibrv.TibrvEvent.invoke(TibrvEvent.java:160)

at com.tibco.tibrv.TibrvImplQGroupC.natDispatch(Native Method)

at com.tibco.tibrv.TibrvImplQGroupC.dispatch

(TibrvImplQGroupC.java:67)

at com.tibco.tibrv.TibrvQueueGroup.dispatch(TibrvQueueGroup.java:163)

at com.tibco.sdk.MDefaultDispatcher.run(MDefaultDispatcher.java:26)

at java.lang.Thread.run(Unknown Source)

Probable Cause

The message has the wrong date format.

Solution

The correct date format is MM/dd/YYYY.
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Data processing caused a GetComponent() API message error

Symptom

While a message was being processed by the adapter, the following error message 

occurred:
2001 Sep 20 18:36:37:889 ps8Adapter.inst Info [Application] AEPS8-4003033 Caught Base Error TPESVCFAIL - 

application level service failure

com.tibco.sdk.MException: An Error has Occured while invoking API GetComponent() on CI PRODUCT

at com.tibco.adapter.ps.AdapterException.<init>

(AdapterException.java:24)

at com.tibco.adapter.ps.ComponentInterfaceAgent.getCIObject

(ComponentInterfaceAgent.java:201)

at com.tibco.adapter.ps.PSEventProcessor.processMessage

(PSEventProcessor.java:840)

Probable Cause

Most likely permission has not been granted for the adapter to use the required 

Component Interface. Another probable cause is that the Component Interface does not 

exist in the database.

Solution

Use the PeopleTools Maintain Security function to grant the operator class the permission 

to use the Component Interface, in this case PRODUCT. Make sure full access is granted. 

The operator class should be the one the operator ID belongs to. For example, the operator 

class for VP1 is ALLPNLS.
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Data successfully received and processed is not reflected in the table

Symptom

The adapter prints out an INFO message saying it has finished processing the event. Use a 

PeopleSoft client to check the new data, but it does not reflect what was sent in through 

the adapter.

Probable Cause

The record you are inserting the data into has a related language record and instead of the 

data going into the expected record it went into the related language record.

Solution

Check how the related language record is formatted and how it relates to the actual record. 

Open the actual record in PeopleSoft, then select File > Object Properties. Select the Use 

tab and blank out the related language record from the record definition, then save this 

change. For more important information about this solution, see your PeopleSoft 

documentation.

Check the applicable PeopleSoft documentation to understand how related language 

records are used. If you are certain that the related language record is not needed:

1. Login to PeopleSoft.

2. Select File > Open then open the record. 

3. Select File > Object Properties, then select the Use tab.

4. Blank out the entry for the related language record.

5. Save the change.

If the audit options are turned ON, follow the steps mentioned below:

Open the actual record in PeopleSoft, then select File > Object Properties. Select the Use 

tab and blank out the related language record from the record definition, then save this 

change. For more important information about this solution, see your PeopleSoft 

documentation.

Check the applicable PeopleSoft documentation to understand how audit options are used. 

If you are certain that the audit records are not required follow the steps mentioned below:

1. Login to PeopleSoft.

2. Select File > Open then open the record 

3. Select File > Object Properties, then select the Use tab.
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4. Blank out the entry for Add, Change and Delete in Audit Options.

5. Save the change.
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A successfully processed record has extra rows in the database

Symptom

The adapter successfully processes a message. The data appears correctly in the database. 

However, there is an extra row at the child level.

Probable Cause

The adapter does not trim the extra rows at the child level. Therefore, if a record has two 

rows at the child level but the incoming data has one row, then one row will be updated (as 

long as the keys match). When the user logs into PeopleSoft the user will still see two 

rows. The following example illustrates this situation:

Example Suppose a particular PRODUCT has two rows, one is effective dated with 

01/01/1900, the other is effective dated with 09/24/2001. The incoming data specifies the 

same PRODUCT with only one child row effective dated with 09/24/2001. The data 

processes successfully and in the database you will see that PRODUCT with two effective 

dated rows.

Solution

If you want the remaining rows to be deleted, you need to issue a delete command with the 

keys for that row. Applying this requirement to the example above, you would specify 

EFFDT='01/01/1900' and set OPRN_CODE='D'.
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The palette cannot connect to the DTA

Symptom

The palette cannot connect to the DTA after giving the various connection parameters and 

clicking Connect.

Probable Cause

The DTA is not up.

Or

The connection parameters given in the palette are incorrect.

Solution

In order to connect to the DTA, please ensure the following:

1. Ensure that the application server is running.

2. If the design-time adapter has been started successfully. the following would be 

displayed: 

2002 Jun 25 10:27:47:995 GMT -8 psoftDesignTimeAdapter.psdta Info [Metadata] AEPS8-3400100 PSDTA 

ready to serve requests from Designer.... 2002 Jun 25 10:27:48:015 GMT -8 psoftDesignTimeAdapter.psdta Info 

[Metadata] AEPS8-3400102 Sending discovery message to find other running instances of PSDTA on subject 

metadata.server.ps, service 12345. 2002 Jun 25 10:28:07:844 GMT -8 psoftDesignTimeAdapter.psdta Info 

[Metadata] AEPS8-3400103 Assuming master status.

3. Check the Design -Time Connection parameters specified. Specify correct values for 

the following: 

— PeopleSoft operator ID

— Password

— PeopleSoft application server name

— JOLT listener port number
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Connection to PeopleSoft failed

Symptom

The adapter displays the following message and exits:

Processing /tibco/private/adapter/PeopleSoft/pub/ps8Adapter ...

com.tibco.sdk.MException: Invalid url: /startup/startComponent.

        at com.tibco.sdk.properties.MRepoProperties.getCount(MRepoProperties.jav

a:283)

        at com.tibco.sdk.serializer.MPropertyBasedDeserializer.readAllOfFrom(MPr

opertyBasedDeserializer.java:179)

        at com.tibco.sdk.serializer.MPropertyBasedDeserializer.readAllOfFrom(MPr

opertyBasedDeserializer.java:171)

        at com.tibco.sdk.serializer.MPropertyBasedDeserializer.readAllOf(MProper

tyBasedDeserializer.java:165)

        at com.tibco.sdk.serializer.config.MStartUpDeserializer.readStartup(MSta

rtUpDeserializer.java:45)

        at com.tibco.sdk.serializer.config.MStartUpDeserializer.readAnySupported

Type(MStartUpDeserializer.java:25)

        at com.tibco.sdk.serializer.MPropertyBasedDeserializer.readAny(MProperty

BasedDeserializer.java:201)

        at com.tibco.sdk.serializer.MPropertyBasedDeserializer.deserialize(MProp

ertyBasedDeserializer.java:32)

        at com.tibco.sdk.serializer.MPropertyBasedDeserializer.readAny(MProperty

BasedDeserializer.java:198)

        at com.tibco.sdk.serializer.MPropertyBasedDeserializer.internalRead(MPro

pertyBasedDeserializer.java:157)

        at com.tibco.sdk.serializer.MPropertyBasedDeserializer.readOptional(MPro

pertyBasedDeserializer.java:234)

        at com.tibco.sdk.serializer.MPropertyBasedDeserializer.readOptional(MPro

pertyBasedDeserializer.java:225)

        at com.tibco.sdk.serializer.MConfigDeserializer.readConfig(MConfigDeseri

alizer.java:49)

        at com.tibco.sdk.serializer.MConfigDeserializer.readAnySupportedType(MCo

nfigDeserializer.java:33)

        at com.tibco.sdk.serializer.MPropertyBasedDeserializer.readAny(MProperty

BasedDeserializer.java:201)

        at com.tibco.sdk.serializer.MPropertyBasedDeserializer.deserialize(MProp

ertyBasedDeserializer.java:32)

        at com.tibco.sdk.MDefaultApp.start(MDefaultApp.java:284)

        at com.tibco.sdk.MApp.start(MApp.java:184)

        at com.tibco.adapter.ps.PS8Adapter.main(PS8Adapter.java:43)

Caught MException in PS8Adapter::main().

Probable Cause

The PeopleSoft connection password has not been specified in the adpsft8.tra file.
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Solution

Remove the comment the following line in the adpsft8.tra file:

#tibco.clientVar.adpsft8.connection.password <password>

and specify the PeopleSoft connection password in place of <password>.
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’Method not found’ error displayed by the Adapter

Symptom

The adapter displays the message Method not found

Probable Cause

The PeopleTools version mentioned in the adapter configuration is different from the 

PeopleTools version to which the adapter connects to. 

Solution

Check if the version of Peopletools used, corresponds with the PeopleTools specified in 

the Configuration tab while configuring the adapter.
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Appendix D Migrating PeopleSoft Data for Adapter 

Configuration

This appendix describes the procedure to migrate PeopleSoft data for an adapter 

configuration, from one database to another. Database migration scripts are provided with 

the installation to carry out the migration. 

Topics

• Migrating PeopleSoft Data for Adapter Configuration, page 282
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Migrating PeopleSoft Data for Adapter Configuration

Database migration scripts are provided to allow you to migrate PeopleSoft data for your 

adapter configuration, from one database to another. This utility allows you to maintain 

your configuration data in one repository and extract to other databases as required. For 

instance, you can migrate data from a development environment to a production 

environment instead of repeating the process of preparing PeopleSoft Component 

Interfaces and other adapter specific components in the production environment. The 

scripts provided migrate the following data:

• Component Interfaces

• Access Rights for the Component Interfaces

• PanelGroup Information (where Publisher Work Panel is attached)

• Access Rights for attached Work Panel

• TIB table entries for Publisher Services

The migration process broadly involves the following steps. An export script and an 

import script are provided along with the installation. Run the export script on the source 

database to extract data for a specified Operation Class Id and Component Interface(s). 

The output is generated in a .dat file, which is placed in a specified location. Login to the 

target database, and run the import script. The migration process is complete.

Script File Location

The following database migration scripts and a sample export script are available in the 

TIB_ADPSFT8_HOME\scripts directory:

tibexport.dms (Export Script)

tibimport.dms (Import Script)

tibexport_sample.dms (Sample Export Script)

Adapter Configuration Migration

The migration procedure can be divided into the following three parts: 

Exporting Adapter Configuration Data

Use the following steps to carry out the export procedure:

No migration is required for Application Messaging as there is no information persisted in 

the database.
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1. Go to the TIB_ADPSFT8_HOME\scripts directory and open the tibexport.dms script using a 

text editor like notepad.

2. Globally replace the following with appropriate values, enclosed in single quotes:

— %CLASSID% 

This is the Operation Class Id. For example, replace %CLASSID% with 

'ALLPNLS'

— %CI_NAME%

This is the name of the Component Interface(s). For example replace 

%CI_NAME% with 'ACTIVITY','COUNTRY','PRODUCT_TBL'

3. Set the name and location of the output .dat file generated by the tibexport.dms file in 

either of the following ways:

• Modify the SET OUTPUT parameter in the tibexport.dms file

The default output file name is tibmigration.dat. 

The default location is PS_HOME\data directory.

• Use PeopleTools 8 Configuration Manager. To do this: 

a. Open Configuration Manager, then click the Profile tab. 

b. In the Profile tab, select the client configuration being used (usually named 

"default") then click the Edit button.

c. In the Edit Profile window select the Common tab. In the Data Mover Directories block 

specify the path for the output directory and the log file.

You can see the sample export script tibexport_sample.dms located in the scripts directory.

The values specified in the tibexport.dms script must be enclosed in single quotes. If data for 

multiple Component Interfaces is to be extracted use comma separators. Do not include 

spaces after the comma.

If the SET OUTPUT parameter has been modified in the tibexport.dms file. This setting will 

override the location specified in Configuration Manager. You can use Configuration 

Manager only to specify locations and not file names.
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4. Modify the name and location of the log file, if required. You can do this in either of 

the following ways:

— Modify the SET LOG parameter in the tibexport.dms file.

The default name is tibmigration_export.log. 

The default location is TIB_ADPSFT8_HOME\scripts.

— Use PeopleTools 8 Configuration Manager to specify the location of the log file. 

For details see step 3.

5. Save the modified tibexport.dms script file with a new name. For example, 

tibexport_new.dms.

6. Launch PeopleSoft Data Mover and log into the source database.

7. Run the modified export script file, for example, tibexport_new.dms in PeopleSoft Data 

Mover.

8. A .dat file, tibmigration.dat containing the adapter configuration data is generated in the 

location specified in step 3.

Importing Adapter Configuration Data

Use the following steps to carry out the import procedure:

1. Set the name and location of the .dat file to be imported by the tibimport.dms file in either 

of the following ways:

— Modify the SET INPUT parameter in the tibimport.dms file.

The default output file name is tibmigration.dat.

The default location is PS_HOME\data directory.

— Use PeopleTools 8 Configuration Manager. To do this: 

a. Open Configuration Manager, then select the Profile tab. 

b. In the Profile tab, select the client configuration being used (usually named 

"default") then click the Edit button. 

c. In the Edit Profile screen select the Common tab. In the Data Mover Directories block 

specify the path for the input directory and the log file.

2. Modify the name and location of the log file, if required. You can do this in either of 

the following ways:

— Modify the SET LOG parameter in the tibimport.dms file.

The default name is tibmigration_import.log. 

The default location is TIB_ADPSFT8_HOME\scripts.
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3. Use PeopleTools 8 Configuration Manager to specify the location of the log file. 

4. Set the name and location of the log file if required. You can do this in either of the 

following ways:

— Modify the SET LOG parameter.

The default name is tibmigration_import.log. 

The default location is TIBCO_HOME\adapter\adpsft8\version_number\scripts.

— Use PeopleTools 8 Configuration Manager. 

5. Go to the TIB_ADPSFT8_HOME\scripts directory and run the tibimport.dms script. The 

migration procedure is complete.

Verification

To verify that the migration has been successful do the following:

— Ensure that a .dat file, tibmigration.dat has been generated in the specified directory.

— Check the log files for errors. The default log files, tibmigration_export.log and 

tibmigration_import.log are located in the TIB_ADPSFT8_HOME\scripts directory by 

default, unless you have specified otherwise.

If the SET INPUT parameter has been modified in the tibimport.dms file. This setting will 

override the location specified in Configuration Manager. You can use Configuration 

Manager only to specify locations and not file names.
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